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1 QlikView at a glance

QlikView makes it easy to understand the overall picture, find connections, and make
insights, even when working with large and complex data sets. You can integrate
information from different sources and the information can quickly be made available
throughout your network, ensuring that the right information gets to the right person.
The associative data model technology on which QlikView is based allows you to
create a unique interface for interactive presentation and analysis of any kind of
information.

QlikView manages information in a way that resembles the human brain. Just like the human brain, it
gradually makes associative connections in the information being processed. You - not the
database - decide which questions to ask. Just click on the item you want to know more about.

Retrieving data in conventional systems is often a complex task requiring extensive knowledge of
the structure of the databases and of the syntax of the query language. The user is frequently
limited to predefined search routines. QlikView revolutionizes this by making it possible to select
freely from data displayed on the screen with a click of the mouse. Conventional information search
systems often require a top-down approach, while QlikView allows you to get started with any
piece of data regardless of its location in the data structure.

QlikView helps you acquire a unified and coherent overview of the data in different databases -
your own or someone else's, central or local. QlikView can be used with virtually any database.

With QlikView you can:

« Create a flexible end user interface to an information warehouse.
» Get snapshots of data relations.

« Make presentations based on your data.

» Create dynamic graphical charts and tables.

» Perform statistical analysis.

 Link descriptions and multimedia to your data.

< Build your own expert systems.

« Create new tables, merging information from several sources.

» Build your own business intelligence system.
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2 QlikView Desktop

This section gives information on how to install QlikView Desktop. Here you also find information on
how to upgrade and update your QlikView Desktop, manage and troubleshoot the License Enabler
(LEF) File, and information on QlikView Personal Edition.

2.1  System Requirements for QlikView Desktop

This section lists the requirements that must be fulfilled by the target system in order to
successfully install and run QlikView.

Desktop system requirements
¢ Microsoft Windows 10 x64
* Microsoft Windows 11 x64
Platforms * » Microsoft Windows Server 2016
¢ Microsoft Windows Server 2019
¢ Microsoft Windows Server 2022

Processors (CPUs) Multi-core x64 compatible processors
4 GB minimum.
Memory Depending on data volumes, more may be required. QlikView is an in-

memory analysis technology; memory requirements for QlikView
products are directly related to the quantity of data being analyzed.

Disk space 900 MB total required to install

* Microsoft Active Directory (NTLM or Kerberos)
e Local Windows user accounts (NTLM)

Security
» Third-party security (requires QlikView Server Enterprise

Edition)

* Provided there is Standard manufacturer support for the platform.

Qlik NPrinting compatibility

Seethe i Release Notes on Qlik Community for QlikView and Qlik NPrinting compatibility details.

QlikView Desktop is required for QlikView connection with Qlik NPrinting and must be installed on
each Qlik NPrinting Engine computer.

If using server or cluster connections, QlikView Server and QlikView Desktop must be on the same
version.

For more information, see Connecting Qlik NPrinting with QlikView.
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2.2 Installing QlikView Desktop

When you purchase QlikView, you receive an email with the information about the
license agreement. There will also be information about your serial numbers and
control numbers.

QlikView Installation Packages

You can select between a number of different QlikView installation packages. The QlikView
Desktop, QlikView Server, and QlikView WorkBench installations are only available in a 64-bit
version.

The QlikView Desktop installation package includes the following components:

e The QlikView application
e The QlikView plugin

* QlikView themes

¢ QlikView examples

You can select Custom during the installation progress to reduce the number of installed
components.

Download the QlikView Desktop installation file from§» Product Downloads. For more
information, see Downloading installation files.

Running the QlikView Desktop installation program

Do the following:

1. Double-click the Setup.exe file to start the installation.

2. When the installation program starts, select the desired installation language from the drop
down list, and click OK.

3. Wait while the installation is prepared, according to the dialogs displayed.

4. When the Welcome dialog opens, read the information and click Next.

5. The software license agreement opens. Read it, and click | accept the license agreement (if
thisis the case), then click Next.

6. Inthe Customer Information dialog you can specify for whom the installation will be
personalized. Click Next to continue.

7. If you prefer another destination folder than the default one for the program installation,
specify this by clicking Change in the Destination Folder dialog. Then click Next.

8. The Setup Type dialog appears. If Complete is chosen, the following features will be
installed to the path specified in the previous dialog: The QlikView program, the QlikView
Plug-In, and examples of QlikView functionality and features. If Custom is chosen, a dialog
where you can specify which features to install will appear when you click Next. Make the
selections and click Next.
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9. The installation is now ready to start. Click Install to start it.
10. In the last dialog, click Finish to complete the installation process.

By default, QlikView performs a license check on a 30 day interval.

Logging the Installation

When setup.exe is run, alog file is written to the temp folder of the user. The log file is called
Qlikviewx64.wil. Each time the installation is run a new file is generated, over writing the old log file.

QlikView Settings File
All settings for QlikView are saved in a file (instead of being written to the registry). The file,

Settings.ini, islocated in c:\Users\username\AppData\Roaming\QlikTech\Qlikview.

The settings for QlikView OCX are found in the same file.

Serialization

If you get your QlikView license from a QlikView Server or if you have a Personal Edition of QlikView
no serialization is necessary. It is however possible to acquire a serial number for this product and
enter it in User Preferences: License page. A registered QlikView will allow you to work offline
without any contact with a QlikView Server for longer periods (periods longer than 30 days).
Contact your QlikView vendor for details.

The serialization process requires network access or optionally phone activation!

Once you have installed and, optionally, serialized your copy of QlikView, you can start using the
program.

Network Distribution of QlikView

This type of installation is useful if you have many licenses and want to make sure that all users run
the same version of QlikView. Each user still needs a separate license number.

To distribute a QlikView installation, you need the executable installation file. Serial numbers and
control numbers are not necessary until you start your first QlikView session on the client computer.

QlikView uses the Microsoft Windows Installer technique (MSI packaging).

To find out more about how to install an MSI-package, please see Microsoft documentation about

Windows installer.
¢ msdn.microsoft.com

License Enabler File Editor

You can also update your license and review the License Enabler File by selecting License Update
from the Help menu. This requires no network access.
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In the License Enabler File Editor dialog the user can review or edit the License Enabler File.

Current License Key

The Current License Key of the QlikView license that is normally entered when the original
program is installed. It may also be entered or edited at a later time via the User Preferences:
License page. It is also possible to run QlikView without a bought license key. In this case, a license
lease from a QlikView Server - a Named CAL - or a Personal Edition of QlikView is needed.

Current License Enabler File

A text file containing information relevant to the installed license that is required in order to activate
(enable) the license key.

Contact License Enabler Server

Click this button if the text edit box Current License Enabler File above is empty in order to
contact the License Enabler Server.

Troubleshooting the License Enabler File

A License Enabler File (LEF file) is required in order to verify the validity of a QlikView license key.
During the initialization of the license key the Qlik LEF Server is contacted via the Internet. Provided
that the license information given checks out, a LEF file is automatically transferred to your
computer. Under normal circumstances the LEF procedure is barely noticeable as it is done in the
background. There are however instances when the procedure fails, either because you are unable
to contact the LEF server or because a firewall prevents the transfer of the LEF file. When this
happens the License Failure dialog will be displayed to inform you about the problem.

Should you be unable to obtain a valid LEF file through the normal procedure and you feel that you
are entitled to one, you might instead obtain it directly from Qlik Support. When you copy the text
file directly into the LEF editor you must make sure that there are no trailing empty spaces in the
text.

Silent installation

When running a silent installation, QlikView Desktop is installed with a limited set of or no dialogs at
all. This means all features, properties, and user selections have to be known when creating the
silent installation package. There are also some standard properties in Windows Installer Service
that may be required.

A silent installation can be run with different interface levels:

Interface levels

Command Type
/qn Completely silent.
/qb Basic user interface.

The following silent installation command line is recommended for QlikView Desktop:
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QlikViewDesktop_x64Setup.exe /s /v'/qn"
The command line above installs all features completely silently.

Add a + sign at end of the interface levels command to get a modal dialog at the end of the
installation saying “Finished” and if it was successful or not.

After completing a silent installation, perform a system reboot or log out and log back in
to ensure the software functions correctly.

Silent uninstallation

The following silent uninstallation command line is recommended for QlikView Desktop:
QlikViewDesktop_x64Setup.exe /x /s /v"/gn"

The command line above removes all features completely silently.

Add a + sign at end of the interface levels command to get a modal dialog at the end of the
installation saying “Finished” and if it was successful or not.

2.3 QlikView Personal Edition

Qlik offers a free version of QlikView for personal use. QlikView Personal Edition is the
full QlikView Desktop product and uses the same installation package. The only
difference is that QlikView Personal Edition runs without a license key.

QlikView Personal Edition is limited to customers who have access tothe{» Product Downloads
site. Contact support if you do not have access. You can upgrade QlikView Personal Edition to a
newer version at any time through the {2 Product Downloads site and continue working with the
documents you have created.

There are no functional limitations in QlikView Personal Edition, however there are a few aspects to
observe regarding the handling of QlikView documents. In QlikView Personal Edition, every
document is saved with a user key that binds that file to the computer it is created on. This implies:

» QlikView Personal Edition can only open files created using that copy of QlikView. This
means, with QlikView Personal Edition you cannot use your QlikView documents on different
computers, you cannot share your QlikView documents with another unregistered user or
open a QlikView document from another user (exempted are documents specially prepared
for personal use by Qlik). However, documents created in QlikView Personal Edition can be
used with a licensed copy of QlikView Desktop and they can also be published on a QlikView
Server.

» You cannot import an entire document layout (sheets/objects/security settings, etc. in XML
format, without the data) into QlikView Personal Edition.
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Should you change computers, you will not be able to open your previously created documents with
QlikView Personal Edition. In this case, you can choose to recover your files. Recovering files means
a new user key is generated, assigned to the old document and used for all subsequent files, not
only for that particular file. After recovering a file, you can no longer use it on the computer that you
createditin.

QlikView will accept 4 user key changes in a document. After that, you will get the error message
“Key length has reached its maximum” and the document will not open any more. The only
possibility is to recreate it from scratch.

Therefore, you should not recover QlikView documents that you did not create (from a forum or
from a colleague, etc.). Doing so will use one of your remaining recovery attempts.

If you have exhausted your recovery attempts, downloading a new version or
downloading the same version again will not reset the counter.

Users of QlikView Personal Edition do not qualify for telephone or e-mail support from Qlik, but they
can gain excellent QlikView support through 2 Qlik Community. All content is accessible to our
members, but you must register to post questions in the forum, download files or sign up for
training.

One of the best ways to learn about the capabilities of QlikView is through the QlikView Tutorial,
which provides helpful hints like expression examples, code blocks and design advice. The Tutorial
and the corresponding files can be downloaded from Tutorials. These documents are also adapted
for QlikView Personal Edition.

If you are interested in the most powerful modern analytics solution Qlik has to offer, we highly
recommend our free Qlik Sense trial, see{» Launch your free trial of Qlik Sense. QlikView
customers can take advantage of our Analytics Modernization Program, which provides the easiest
and most cost-effective way to adopt Qlik Sense. For more information, see {2 Accelerate Your
Modernization.

2.4  Supported languages

When you run the QlikView Desktop Install Wizard, you must select an interface
language for your installation.

You can choose any of the following supported languages:

» Brazilian Portuguese
» Chinese (simplified)

* Chinese (traditional)
e Dutch

« English

e French

e German
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 ltalian

e Japanese
e Korean

e Polish

¢ Russian

e Spanish

e Swedish
e Turkish

Changing the interface language after installation

Once QlikView is installed, you can change the interface language from within the program at any
time.

Do the following:

1. In the menu bar at the top of the screen, click on the Settings drop-down.
2. Click User Preferences.... A dialogue box will open.

3. Onthe General tab, click the Change User Interface Language... button.
Another dialogue box will open.

4. Choose your desired language, and click OK.
5. Restart QlikView to make the changes effective.

A change in the interface language affects how the language of the program and the online help are
displayed.

You can change the language settings also by modifying the Settings.inifile, found in
C:\Users\username|AppData|Roaming\Qlik Tech|QlikView. Edit the setting InterfaceLanguage and
set it to a supported language.

To learn more about QlikView Desktop interface settings, see User Preferences: General (page 63).

Changing AJAX and WebView language settings

QlikView WebView uses the language set in User Preferences.... AJAX uses English as the default
for both AccessPoint and QlikView documents. You can change the language settings in QlikView
AccessPoint to another language. See: Setting your preferred language in AccessPoint (page 1642)
for details.

2.5 Upgrading and updating QlikView Desktop

To upgrade or update QlikView Desktop, follow the procedures you find in the following sections.

Requirements

If you use Qlik NPrinting, your Qlik NPrinting version must be equal to or higher than your QlikView
version. If you are upgrading to QlikView May 2023 IR, you must upgrade in parallel to Qlik NPrinting
May 2023 IR or later. For more information, see Upgrading Qlik NPrinting.
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Upgrade QlikView Desktop

To upgrade QlikView Desktop, download the newer version you want to install from ¢ Product
Downloads, and follow the installation wizard.

For more information, see Downloading installation files.

Best practices before upgrading
For a successful upgrade of QlikView Desktop, take the following basic practices into account:
» Ensure that you have a valid maintenance contract before upgrading QlikView Desktop.

Attempting to upgrade without a valid maintenance contract will result in limited functionality
of QlikView Desktop. See: Maintenance contract on upgrade.

« If you are using a custom connector or an extension in your QlikView Desktop installation(s),
verify that such feature is supported in the newer version before upgrading. You can check
the supported features in the Download section at glik.com.

Update QlikView Desktop

In the Help menu in QlikView, you find the option QlikView Update.... Choosing this will open the
QlikView update site on the Internet where you will be presented with possible updates for your
QlikView version. What updates are available are based on information from your QlikView license
and your operating system.
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3  Starting QlikView

Start QlikView from the Start menu, Programs or double-clicking on a QlikView document.

You can also start QlikView from the command line, using the parameters described in the following
section.

3.1 Command Line Syntax
The QlikView command line invocation can be described by the following syntax:

[ path JQv.exe[ { switch } documentfile ]

[ path Jis the path to the file, either absolute or relative to the current directory.

documentfile::= [ path ] documentfilename
documentfilename is the name of the document file.

Switches

You can use switches to start QlikView with different options.

The switches /r, /rp, /I, /lp and /nodata are mutually exclusive. You can only use one of
them in a command.

QlikView start switches

Switch Description

Ir Open the document, perform a reload and close QlikView.

Jigo) Open the document, perform a partial reload and close QlikView.
/l Open the document and perform a reload.

/lp Open the document and perform a partial reload.

/nodata Open the document without field and table data.

/v Assign a value to a variable before script execution starts.

Syntax is: /vvariableName=Assignedvalue

Example: /vMyvariable=12

It is not possible to use /v together with /nodata. The value defined
with /v will not be assigned.
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Switch

/NoSecurity

Example:

Description

Override QlikView security measures against hostile macros and scripts
embedded in QlikView documents. Warning dialogs prompting the user to
accept potentially harmful code will not be shown.

We recommend that you use this switch with caution, and only with
well-known documents.

qv.exe [r/vMyvar=123 abc.qvw

In order to avoid error messages appearing when executing scripts in batch mode, set
the script variable errormode to O in the script.

3.2

Start page

The start page contains several sections listed in the table below.

» Examples: A set of examples that you can explore in order to learn how to use QlikView in
various ways.

» Recent: Contains a list of recently opened documents and web pages. Just click on one of
them to re-open. Right-click on a document to gain access to a menu with the following

useful

commands:

Open "document" Without Data:

Opens the document but skips table and field data. A layout with all sheets and sheet
objects in place but empty is opened. This feature can be useful e.g. for opening
corrupted documents or for avoiding long waits when opening very large documents
for a small change in the layout (of course the script needs to be re-run to re-populate
the document after the changes). This is done with the command line switch nodata
as well.

Open "document” and Reload Data

Opens the document and performs an immediate reload.

Browse Documents in Folder

Opens the folder containing the document in the list.

Add "document" to Favorites

Adds the document or web page to the Favorites list.

Remove "document" From This List

Removes the document from the list of recently used documents. The actual
document file remains unchanged where it resides.
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» Favorites: Contains a list of the documents and web pages previously added to the favorites
list. Unlike the list of recently used documents the favorites list remains unchanged until
explicitly adding or deleteing entries. Just click on a favorite document or page to re-open.
Right-click on a document to gain access to a menu with the following useful commands:

* Open "document" Without Data
Opens the document but skips variables and table and field data. A layout with all
sheets and sheet objects in place but empty is opened. This feature can be useful e.g.
for opening corrupted documents or for avoiding long waits when opening very large
documents for a small change in the layout (of course the script needs to be re-run to
re-populate the document after the changes). This can also be accomplished with the
command line switch nodata.

+ Open "document" and Reload Data
Opens the document and performs an immediate reload.

» Browse Documents in Folder
Opens the folder containing the document in the list.

« Remove "document" From Favorites
Removes the document from the Favorites list. The actual document file remains
unchanged where it resides.

» Additional learning: Contains guides and other resorces for learning more about QlikView,
such as tutorials, online training and QlikView Community.

Click the New document button if you want to create a new document.

QlikView will remember which tab was last used and open the start page on that tab the next time
that QlikView starts. Deselect the Show Start Page When Launching QlikView check box, if the
start page are not to appear when the program starts.

The Start page can be left open and will then be found as Start Page on the Windows menu. If the
start page is closed, it can be reopened at any time by choosing Show Start Page from the Help
menu.

3.3 Connectto Server

The Connect to Server dialog is used for opening QlikView documents remotely on a
QlikView Server.

Note that when opening documents as a client to QlikView Server there will be restriction in what is
possible to do with the document compared to when opening local documents. As a client it might
not be possible to add or delete sheet objects, depending on whether the document supports
collaboration. Sheets cannot be added or deleted. Furthermore, most properties dialogs and the
script cannot be accessed, macros cannot be changed and the document cannot be saved.

Enter the computer name or the URL to a computer running QlikView Server under Server. Then
click on Connect. Recently visited servers can be retrieved from the drop-down list. A URL may
contain additional connection data.

Connection pseudo-URLs (page 38)
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Once connected, the central pane of the dialog displays the document folders available on the
QlikView Server. Click on a folder and the available documents will be shown under Name at the
bottom of the dialog. Double-click a document or select it and click on Open in order to open the
document.

Connection settings

The following settings allow you to configure your connection and server authentication settings:

Clear List

The button clears the list of Recent Servers on the Start Page.

Authentication

Select how to identify yourself to the QlikView Server. The following three authentication methods
are available:

» Use NT Identity: Uses authenticated NT identity. This only works if the computer is
connected to the same Windows NT domain as the QlikView Server.

» Anonymous: Uses anonymous login. It is only possible to connect if the QlikView Server is
set to allow anonymous users and it is only possible to see documents with file permissions
for the QlikView Server anonymous account. The connection pseudo-URL under Server will
be complemented by a @ before the server name.

» Alternate Identity: Uses a specific NT user name known on the QlikView Server's domain.
The user name is typed in the User ID edit box. It will prompt for the corresponding user
password when pressing the Connect button. The connection pseudo-URL under Server will
be complemented by username@ before the server name.

Flat Mode

With this setting enabled, the bottom pane of the dialog will display the contents of all subfolders
simultaneously rather than using the tree-view approach.

Connection pseudo-URLs

When connecting to QlikView Server from desktop clients, either via the Open in Server dialog or
via link files, a pseudo-URL is used as document address.

The syntax is:
qvp://[[username][@]]hostname( :port/;protocol]/docname
where:

* usernameis a Windows user ID. The parameter is optional.
* hostnameis the name of the host. The parameter is obligatory.

» documentname is the name of the QlikView document (excluding the qvf or qvw
extension). The parameter is optional.

» port(e.g. 4749) can be used for specifying a specific port used by the server
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» protocol (e.g. http) can be used for specifying a tunneling protocol. The parameter is
optional.

@ without username denotes anonymous identity.

If user identity is omitted altogether, the logged in Windows identity is assumed.

QVP links can only be opened in QlikView Desktop.

3.4 Batch Execution

If the QlikView document should be updated regularly, e.g. every night, this is best done with
QlikView Server or QlikView Publisher.

QlikView Server

QlikView Server provides a platform for hosting, and sharing QlikView information over the
Internet/Intranet. QlikView Server is tightly integrated with QlikView to deliver a seamless suite of
data analysis technology to end users. The server component of QlikView Server is the centerpiece
of this technology, supplying a robust, centrally managed, QlikView document community,
connecting multiple users, client types, documents, and objects within a secure and safe
environment.

QlikView Publisher

QlikView Publisher is a member of the QlikView product family that manages content and access.
By presenting the end-users with up-to-date information and letting you manage the QlikView
documents in a powerful way, QlikView Publisher is a valuable addition to the QlikView suite.

QlikView Publisher distributes data stored in QlikView documents to users within and outside the
organization. By reducing data, each user can be presented with the information that concerns
him/her. The QlikView Publisher service and user interface are now fully integrated into QlikView
Server and the QlikView Management Console (QMC).

If there is no access to QlikView Server or QlikView Publisher, it is possible to reload QlikView
documents on the stand-alone application. Then use command line switches.

Scheduling Programs

Windows has a Task Scheduler service. The services are controlled from the Administrative Tools.
Make sure that Status is set to Started (and Startup to Automatic for the service to automatically
start after a reboot) for the relevant service.

The easiest way to submit a batch job is usually to create a batch file with the relevant commands.
The file, named e.g. myBatch.cmd, could e.g. contain the following commands:

c:\qlikview\qv.exe /r C:\glikview\example\file.qvw
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The Schedule Service

The schedule service normally runs under the system account and thus has some limitations. If
access to network resources is needed, reconfigure the service to run under a different account.
Since the QlikView license is stored in the account-specific folder, make sure that it is correctly
registered for the account to be used. To do this submit an interactive job.

Please refer to the documentation of your operating system for more specific information on how to
schedule a task.

Section Access

To reexecute a QlikView file containing a section access, make sure that the license serial number
that is installed on the machine doing the batch execution is allowed to run the script without
entering a user name or a password. See the example below.

Example
Serial User Password Access
CREATOR - - Admin
4600 9999 9999 9999 Joe ppp789 Admin
* Joe qqqq456 User
* User rer123 User

ODBC

If ODBC is used, please make sure that the DSN definition is available from the account doing the
reexecution. The easiest way to assure this is probably to define the DSN as a System DSN in the
ODBC Control Panel.

3.5 OLEDBand ODBC
OLE DB

QlikView supports the OLE DB interface for connection to external data sources. A great number of
external databases can be accessed via the Microsoft OLE DB Provider for ODBC Drivers.

Is the Correct OLE DB Provider Installed?

When you select File, Edit Script, Connect to OLE DB you will arrive at the Data Link Properties
page, if the OLE DB provider is correctly installed. Otherwise you will receive an error message
indicating that a connection cannot be made, in which case you will need to install it.

When Is the ODBC Interface Needed?

To access a general database, it is necessary to have the ODBC (Open DataBase Connectivity)
interface installed. The alternative is to export data from the database into a file that is readable to
QlikView.
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Normally some ODBC drivers are installed with the operating system. Additional drivers can be
bought from software retailers, found on the Internet or delivered from the DBMS manufacturer.
Some drivers are redistributed freely.

The ODBC interface described here is the interface on the client computer. If the planis to use
ODBC to access a multi-user relational database on a network server, additional DBMS software
that allows a client to access the database on the server might be needed. Contact the DBMS
supplier for more information on the software needed.

QlikView works with 32-bit and 64-bit ODBC drivers.

Is the Correct ODBC Driver Installed?

On a 64-bit platform it is possible to use both 32-bit and 64-bit applications. It is also possible to
run both 32-bit and 64-bit ODBC drivers.

When using the 64-bit versions of ODBC and QlikView, the ODBC Data Source Administrator is
found in the Control Panel, Administrative Tools.

When using the 32-bit versions of ODBC and QlikView, you must start the 32-bit administrator via
the executable file, odbcad32.exe that is located in the SysWOWG64 folder, usually
c:\windows\SysWOW®64.

According to Microsoft, in the 64-bit versions of the operating systems, the system32 folder,
usually c:\windows\system32, contains only 64-bit files. If there is also a 32-bit version of the filg, it
resides in the syswow®64 folder. See http://technet.microsoft.com for more information.

On a 32-bit operating system the configuration is very straightforward since all files and drivers are
32-bit.

There should be an ODBC Data Source Administrator installed on the system. (For 32-bit ODBC
on a 64-bit operating system start odbcad32.exe).

Go to the ODBC Drivers tab to find out what drivers are installed.

If the driver needed is not found on the ODBC Drivers tab, contact the software supplier to obtain
the correct driver.

Creating ODBC Data Sources

An ODBC data source must be created for the database you wish to access. This can be done
during the ODBC installation or at a later stage.

Before the start of creating data sources, a decision must be made whether they should be user or
system data sources. User data sources cannot be reached unless the correct user id was used
when logging on. To share the data sources with other users, system data sources must be
created.

1. Open the ODBC Data Source Administrator dialog again.

2. Gotothe tab User DSN to create user data sources, or to the tab System DSN to create
system data sources.
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3. Click the Add button. The Add Data Source dialog should appear, showing a list of the ODBC
drivers installed.

4. If the correct ODBC driver is listed, select it and click the OK button. A dialog specific to the
selected database driver will appear. Name the data source and set the necessary
parameters. Click the OK button when ready.
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A QlikView document is a file containing everything needed to analyze the data:
» the dataitself
 the script needed to update the QlikView file with new data from the data source
 layout information, including all the sheets, list boxes, charts, etc.
» document alerts, document bookmarks and document reports
» access restriction information
¢ macro module

Itis thus very easy to distribute information using QlikView files. The analysis can be made
independently of the location of the original data or network conditions. QlikView documents are a
way to share information with users that do not have access to the original data source.

4.1 QlikView Project Files

Itis possible to save a QlikView document into several files that can be used for versioning. Each file
defines a property of the document, a sheet, an object, the script etc.

Each time the document is opened and an object or a setting is changed, these changes are saved
to the different files, making it easy to follow the changes made in the document. This way it is also
possible to see who made a change and to which part of the document.

To create these project files it is necessary to create a folder next to the qvw or gvf file with the
same name as the QlikView document and add -prj, e.g. the project folder for a document called
Finance.qvf should be Finance-prj.

Files in the prj folder are updated when the corresponding QVW file saves in QlikView
Desktop. Reloading a document from the QlikView Management Console updates the
document with new data, but does not affect the project files.

If you want to copy a QVW file, use Save As...... in QlikView Desktop to save a copy. This
updates the corresponding prj files for the copy. Do not copy prj folder files between
folders.

No data from the document will be saved in the project files. This means that a reload of
the document without changes to the load script does not affect the project files.

Files in the Project Folder

The file QlikviewProject.xml contains a list of all the objects part of the QlikView document.

The different sheets and objects in the list are named after their object ID. The project files are:

Working with QlikView - QlikView, May 2024 43



4 QlikView file

* Qlikviewproject.xml - contains a list of all the files included in the project

e AllProperties.xml

e DocProperties.xml

e DocInternals.xml

e TopLayout.xml

e Loadscript.txt - contains the document load script
* Module.txt - contains the document macro code, if any exists

» Module.txt - a single file is created for every sheet. In addition the files contain references to

all the sheet objects on the sheet.
» Separate files are also created for every sheet object:

LB<id>.
SB<id>.
MB<id>.
TB<id>.
CH<id>.
IB<id>.
CS<id>.
BU<id>.
TX<id>.
LA<id>.
SL<id>.
So<id>.
BM<id>.
CT<id>.

RP<id>.

xm1
xm1
xm1
xm1
xm1
xm1
xm1
xm1
xm1
xm1
xm1
xm1
xm1
xm1

xm1

The files bocProperties.xml, Al1Properties.xml, DocInternals.xml and TopLayout.xm] all contain
property settings for the different parts of the document. bocginary.dat contains user sensitive

data, such as passwords.

4.2 Source Control

It is possible to connect QlikView Desktop to a source control system; the ‘QvMsscciProvider.exe’
and ‘QvSvnProvider.exe’ are the providers used for this, giving you source control function to both

Microsoft Team Foundation Server and Subversion.

Once connected to a source control system, QlikView developers can add projects to source

control. During the Add process the:

e QlikView document is saved
» Project folder is created
» Project files are exported into the project folder
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» Project files are added to source control
» Project settings file is created

The project settings file is stored in the local project folder and contains the settings necessary to
access the source control information for the project. The project settings file is not included in the
files managed by the source control system. The existence of the project settings file tells QlikView
that a given document is managed by a source control system. In addition, QlikView has to be able
to find and load the needed Provider DLL, in order to treat the document as attached to source
control. This check is performed every time a document is opened in QlikView and a settings file
appears in the project folder with information about the Source Control Provider, i.e.
SourceControlSettings.ini.

If the document is attached to source control, the status bar will contain an indication of the
document’s status.

QlikView integration with source control only affects document layout. No actual data loaded into
QlikView is placed into nor fetched from, source control. The operation, Get Project from Source
Control will load a document that contains everything except data. A Reload must be executed to
populate the document with data.

After a QlikView document is connected to source control, saving the document will automatically
check out the files that have changes. QlikView does not provide any other way of checking out the
project files. If Source Control system is not available while performing document Save, QlikView
will try to work "offline", i.e. remove read only flags from the modified files and save the latest
version. On the next document save, when Source Control system is available, QlikView will perform
check out for all locally modified files.

On document save, project files are not checked in. To check in document updates to source
control, the Check In Pending Changes menu item must be used. A single QlikView check in
operation can generate several changesets when using Microsoft TFS and only one when using
Subversion. As a result, rollback between randomly selected changesets in Microsoft TFS does not
guarantee that the document will be in a stable state.

4.3 Internal files

File References in the QlikView Layout

There are a number of places in the QlikView layout where external files can be referenced as info
or background images. External files are referenced by a local path or URL.

Internal Files in QlikView Documents

In certain cases it may be preferable to include the files in the QlikView document.

The info prefix to Load and Select statements in the script can be preceded (or replaced) by the
bundle prefix. The external files will then be read and embedded in the QlikView document. The
external files will no longer be necessary for referencing the file contents, thereby making the
QlikView document portable.
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Show info and the info function will automatically use the embedded files when available. The
syntax for explicit reference of embedded files is:

« gmem://fieldname/fieldvalue |
» gmem://fieldname<index>

where index is the internal index of a value within a field.
Examples:

'gmem://Country/Austria’
'gmem://MyField/34"'

Internal Files in the QlikView Program File

A small set of standard image files are embedded in the QlikView program itself and may be used in
any document without any special preparations.

A set of image files and sound files are already embedded in the QlikView program file. These may
be referenced directly from the layout, without the need for any special preparations. The syntax
for reference is:

* gmem://<builtin>/filename
where filename is one of the filenames listed below (including extension).

Examples:

‘qmem: //<builtin>/Arrow_N_G.png'
="gmem://<builtin>/smiley'&if(sum(Result)<0,1,3)&'_Y.png'

Arrow Images

The arrows set permits you to display arrows in eight directions and four colors. Filenames are
coded as follows: The word Arrow followed by a map direction (_N, _NE, _E, _SE, _S, _SW, _Wor _
NW). This may be followed by _G for green, _Rfor red and _Y for yellow. If no color is stated in the
filename, a gray arrow is referenced.

Other Images

A number of other images are also included in the set. These are usually available in several colors.
Below is a list of the available images.

e Check.png

e Check_G.png
» Cross.png

e Cross_R.png
e Minus.png

e Minus_R.png
¢ Plus.png

e Plus_G.png
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Smileyl1.png
Smiley1_G.png
Smiley1_Y.png
Smiley2.png
Smiley2_B.png
Smiley2_Y.png
Smiley3.png
Smiley3_R.png
Smiley3_Y.png
Thumb1.png
Thumb2.png
Question.png
Question_G.png
Question_R.png
Question_Y.png
Exclamation.png
Exclamation_G.png
Exclamation_R.png
Exclamation_Y.png

Sounds

A number of sound files (.wav) are also included as bundled resources within QlikView. Files can be

found in gmem;,//<bundled>/sounds. The following sounds are available:

qv_bttn.wav
gv_can.wav
qgv_clear.wav
qv_load.wav
qv_lock.wav
gv_menu.wav
qv_ok.wav
qv_redo.wav
qv_reex.wav
gv_save.wav
gv_scrpt.wav
qv_ulock.wav

qv_undo.wav

This list may change in future versions of QlikView.
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4.4  Getting Hold of a QlikView Document

Accessing QlikView Documents from the Outside

QlikView documents can be accessed from outside the QlikView program by means of the
Automation interface.

A direct way to access existing documents is to use GetObject.

Example:

This example does not work in VBScript.

Private Sub oOpenAndReload_cClick()
Set QvDoc = GetObject
("c:\windows\desktop\test.qvw")
QvDoc.Reload

End Sub

Accessing QV Documents from the Internal Macro Interpreter

When using the internal macro interpreter, the only reference available is the ActiveDocument
property of the class Application. All references must be made starting from that point.

Examples:

Sub Clr

Set QvDoc = ActiveDocument
QvDoc.ClearAll(false)

End sub

Sub EndqQv
ActiveDocument.Application.Quit()
End sub
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4 Getting Started Wizard

The Getting Started Wizard helps create a QlikView document by loading data and creating a chart
in a few steps.

4.5 Starting the Getting Started Wizard

The Getting Started Wizard is initiated when a new QlikView document starts.

On the first page of the wizard it is possible to control whether to show the wizard or not when
creating a new QlikView document. This setting can also be made in the User Preferences dialog
that is reached from the Settings menu.

4.6 Step1- Selectadatasource

The wizard can only handle Excel files. Browse to the file containing the data. Note that only the
first work sheet in an Excel file is loaded. If the data is in non-Excel format, use the Script Editor to
select the data.

Click Insert data if you want to borrow some data from us.

Click Next step to continue.

4.7 Step 2 - Data presentation

Verify the presentation of the data and select whether to use the first row in the Excel sheet as
headers or enter a new one. Column headers are also called field names.

To use predefined headers from the data source, select Use column headers from data file. To
create new column headers, select Add column headers. Each column will get a heading in the
format A, B, etcetera. To enter new headings, click the heading (for example A) and type the new
heading. Click Enter to leave the header.

Click Next step to continue.

4.8 Step 3 - Savefile

In the Save As dialog, browse to the folder where the QlikView file is to be saved and enter a file
name.

Click Save to close the dialog.
To enter or change the file path click the Save As... button to re-open the Save As dialog.

Click Next step to continue and create a chart.
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4.9 Step 4 - Choose a chart type

Select type of chart to be created by clicking the corresponding icon. The chart types available are
those most commonly used in QlikView. It is possible to go back to the chart and change it into any
other QlikView chart type via the Chart Properties dialog after finishing the wizard.

Click Next step to continue.

In this step the Back button is disabled.

410 Step 5 - Populate your chart

Dimension

Select a dimension in the drop-down box.

Dimensions define the values for which the chart expressions will be calculated. Dimensions are
typically found to the left in table charts and on the x-axis in for example bar charts.

Expression

Chart expressions define the calculated values in the chart. Expressions are typically found to the
right in table charts and on the y-axis in for example bar charts.

Expressions in QlikView can range from short and simple to long and complex calculations. This
step makes it possible to choose between three very common expressions.

+ Calculate the sum of:
Choose this option to see the numeric sum of a field, for example sum(Sales). Then choose
which field to sum up in the drop down list.

 Calculate the average for:
Choose this option to see the numeric average (mean) of a field, for example avg(Score).
Then choose a field for the calculation in the drop down list.

+ Count the number of:
Choose this option to see the number of values in a field, for example count(OrderID). Then
choose in which field to count the values in the drop down list.

Click Create a second chart if you want to create another chart. This will take you back to step 4.

Click Next step to continue.

411 Step 6 - Add object for making selections

Choose the type of object you want to use for making selections.
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Listboxes:
Select the fields you want to create listboxes for. You can select up to five fields in this wizard, but
it is possible to add more once you have created the document.

Table box:
This option will automatically include all the available fields and place them in a table.

Click Create to close the wizard and create the document.

After finishing this wizard it is possible to add or change more dimensions and expressions at any
time via the Chart Properties dialog. The chart properties dialog is reached by right-clicking on the
chart and selecting Properties....
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Navigate the user interface

In this section you will find information about navigating and interacting with QlikView.

5.1

Menu Commands

The menus described in this chapter are found in the menu bar at the top of the screen. Most
commands can also be configured as buttons in the toolbars.

File menu

The File menu is a drop-down menu at the top of the screen, and contains the following commands:

New: Opens a new QlikView window and allows to create a new QlikView file.

Open...: Opens a new QlikView window and allows to open a QlikView file or a Table file.
Opening a table file automatically opens the File Wizard. This command can also be invoked
by the following keyboard shortcut: Ctrl+O.

Open in Server...: Opens a dialog where it is possible to connect to a QlikView Server and
browse for a document to open in client mode.
This command can also be invoked by the following keyboard shortcut: Ctrl+Shift+0.

When opening documents as a client to QlikView Server the possibilities are
restricted on what is possible to do with the document compared to when
opening local documents. As a client it is not possible to add or delete sheet
objects, depending on whether the document supports collaboration. Sheets
cannot be added or deleted. Furthermore, not all properties dialogs can be
accessed, macros changed, the script accessed, data reloaded or the document
saved.

Refresh Document: This command is only available with documents opened on QlikView
Server and when there is a newer version of the document available on the server. When
invoking a refresh access is gained to the latest data, while maintaining the session including
selections and layout state.

Open URL...: Opens the Open URL dialog. In this dialog type a valid URL to any web page.
The web page will be opened in a separate window inside QlikView. This functionality may be
used for, for example, the QlikView Publisher Accesspoint or for pages displaying QlikView
Server documents via AJAX clients. Opened web pages can be accessed via the Windows
menu just as with standard QlikView document windows.

Open FTP...: Opens a new QlikView window, allows the opening of a QlikView file or table file
from an Ftp server. Opening a table file automatically opens the File Wizard.

Close: Closes the active QlikView file.

Favorites: This cascade menu controls a list of user-defined favorite documents, managed
independently of the Recent documents list (see below).

Save: Saves the present configuration in a QlikView file. Data, script and layout are saved.
This command can also be invoked by the following keyboard shortcut: Ctrl+S. If you want to
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share a QlikView document using AJAX clients, the file name must not contain hash (#)
characters.

» Save As...: Saves the present configuration in a new QlikView file under a new name. This
command can also be invoked by the following keyboard shortcut: F12. If you want to share a
QlikView document using AJAX clients, the file name must not contain hash (#) characters.

» Save Link...: Saves a link to a document opened on a QlikView Server as a text file on the
local machine. The file will have the qvw extension but will not contain any data or layout.
When opening such a link document QlikView will attempt to reconnect to the server and
open the document on the QlikView Server. This command is not available for local
documents.

« Mail as Attachment...: Only available when working with a local document. Creates a mail
with a copy of the current QlikView document attached. The mail recipient will be able to
open the QlikView document provided they have access to QlikView and access rights to the
document (if section access security is used). For this command to work a mail client has to
be configured on the computer.

« Mail with Bookmark as a Link...: Only available when working with a QlikView Server
document. Creates a mail with a URL link to the current server document. A temporary server
bookmark will be created (including layout state) and encoded in the URL. The mail recipient
will be able to use the URL link to open the server document and see what you see, obviously
provided that he or she has access rights to the document and data therein. A mail client has
to be configured on the computer for this command to work. The QlikView Server must be
configured to allow server bookmarks.

 Print...: Opens the standard Print dialog, allows to print the current sheet object. This
command is not available for list boxes. This command can also be invoked by the following
keyboard shortcut: Ctrl+P.

» Print as PDF...: Opens the Print dialog with the Microsoft Print to PDF printer pre-selected.
After pressing the Print button you will be prompted for a file name for the PDF output file.
This command is only available if a PDF printer is available on the system. This command can
also be invoked by the following keyboard shortcut: Ctrl+Shift+P.

» Print Possible...: Opens the standard Print dialog, allows to print the possible (selected and
optional) values of the current list box. This command is only available for list boxes.

» Print Possible as PDF...: This command must be used when printing list boxes and multi
boxes as PDF.

 Print Sheet...: Opens the Print dialog, allows to print an image of the current sheet.

* Print Preview...: Shows preview of printable sheet objects.

« Source Control:

» Settings: Set which MSSCCI (Microsoft Source Code Control Interface) provider dll to
use when adding a project or getting a project from source control.

« Add Project to Source Control: Saves the opened QlikView document and
automatically creates a project folder and project files. Invokes the source control
system to add the project to source control.

» Get Project from Source Control: Retrieves a project from source control and
rebuilds the QlikView document from the project files. QlikView data is not stored in
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source control. To fill the document with the data the command Reload has to be
executed on the rebuilt document.

» Get Latest Version: Retrieves the latest version of the document from the source
control system and rebuilds the QlikView document.

» Check In Pending Changes: Saves the QlikView document and performs a check in
operation to the source control system. This can include four different source control
operations with their own dialogs:

* Add newly created files.
» Undo the checked out files that need to be deleted from the source control.

» Remove the files that correspond to the removed sheets or sheet objects that
are part of the source control.
» Check in modified files.
If the document was not up to date before the Check In Pending Changes operation,
then reopen the document to load the project changes that could be introduced while
resolving the conflicts.

* Undo Pending Changes: Undoes the changes. If there are locally modified files that
are not checked out in the Source Control system, those files are checked out before
the undo checkout operation is performed. This operation will rebuild the QlikView
document by deleting files that were added and not checked in, and references to
pending delete files are restored.

* Export:

+ Export Contents...: This alternative is only available when an exportable sheet object
is active. It then performs the export operation found on the sheet object’s Object
menu.

« Export Sheet Image...: Opens a dialog for saving an image of the current sheet to file.

» Export Document Layout: Opens a dialog for saving the document layout as an XML
file. No data from the document are saved in the XML file.

« Edit Script...: Opens the Edit Script dialog. In this it is possible to write and execute scripts
that open and connect to databases.

« Reload: Executes the current load script and reloads data to the active QlikView document.
This needs to be done if the contents of the database have been changed since the last time
a reload was made. This command can also be invoked by the following keyboard shortcut:
Ctrl+R.

» Partial Reload: Executes the current load script, including all script commands, such as Drop
table, and reloads data to the active QlikView document. However, only those tables whose
load and select statements are preceded by the Replace or Add prefix are reloaded. Data
tables that are not affected by this kind of load or select statements will not be affected by
the partial reload. This command can also be invoked by the following keyboard shortcut:
Ctrl+Shift+R.

« Reduce Data: Opens a menu containing the following two commands:

» Keep Possible Values: Reduces the QlikView database by removing all excluded
values.
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« Remove All Values: Creates a template by removing all the values from the QlikView
database, but keeping the database structure and the layout.

» Table Viewer...: Opens the Table Viewer dialog where the structure of the loaded data can
be studied in a graphical view of tables, fields and associations. This command can also be
invoked by the following keyboard shortcut: Ctrl+T.

» Recent documents list: A listing of the last QlikView documents used. The nhumber of
documents shown can be set in the Settings: User Preferences dialog. Default number is 8.
Selecting one of these is equivalent to the Open command.

 Exit: Closes the open documents and exits QlikView.

Edit menu

The Edit menu is a drop-down menu at the top of the screen, and contains the following

commands:

Command

Undo Layout
Change

Redo Layout
Change

Cut

Copy

Paste

Format
Painter

Remove

Activate All

Edit menu commands
Description

Undoes the latest layout change, including moving, sizing and removing of sheet
objects as well as changes to sheet object properties. Removing sheets, editing
the sheet properties or document properties can also be undone. This command
can also be invoked by the following keyboard shortcut: Ctri+Z.

Redoes the latest undone layout action. This command can also be invoked by
the following keyboard shortcut: Ctrl+Y.

Moves the selected sheet object(s) to Clipboard for pasting elsewhere in the
QlikView document. If only one sheet object is active a bitmap image of the
object, which can be pasted into other programs, will also be put into Clipboard.
This command can also be invoked by the following keyboard shortcut: Ctrl+X.

Copies the selected sheet object(s) to Clipboard for pasting elsewhere in the
QlikView document. If only one sheet object is active a bitmap image of the
object, which can be pasted into other programs, will also be put into Clipboard.
This command can also be invoked by the following keyboard shortcut: Ctrl+C.

Pastes one or several sheet objects from Clipboard back to the QlikView
document. This command can also be invoked by the following keyboard
shortcut: Ctrl+V.

Makes it possible to copy formatting from one sheet object to another.

Deletes the selected sheet object(s). The user will be asked to confirm this
command before deleting.

Makes every sheet object on the sheet active. Another way of obtaining a similar
result is to click and drag a rectangle around those sheet objects that should be
activated, or to Shift-click them. This command can also be invoked by the
following keyboard shortcut: Ctrl+A.
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Command

Search

Fuzzy
Search

Advanced
Search

Copy mode

View menu

Description

Opens the Text search box, provided that a searchable sheet object (list box or
opened multi box) is active. This command can also be invoked by the following
keyboard shortcut: Ctrl+F.

Opens the Text search box in Fuzzy search, provided that a searchable sheet
object is active.

Opens the Advanced Search dialog, provided that a list box or opened multi box
is active. The dialog makes it possible to enter advanced search expressions.
This command can also be invoked by the following keyboard shortcut:
Ctrl+Shift+F.

Switches from logic mode to copy mode. Values clicked while in copy mode are
copied to Clipboard without changing the logical state of the QlikView run. When
copy mode is chosen, the Clipboard Copy List dialog opens. In this dialog the
copied fields are shown. The format of the copy list can also be set here.

The View menu is a drop-down menu at the top of the screen, and contains the following

commands:

» Sheets: Upon selection, a cascade menu displays a list of all sheets used in the document,
sorted as they appear from left to right.

» Toolbars: Upon selection, a cascade menu, where it is possible to enable any toolbar to be

displayed with the document, opens. The following toolbars can all be employed
independently of each other: Standard Toolbar, Navigation Toolbar, Design Toolbar,
Sheets Toolbar and Bookmarks Toolbar. The last entry in the list is Customize (Toolbars)...
that allows the configuration of the toolbar according to the user’'s own preferences.

The Standard, Navigation and Design toolbars have each been pre-defined with a suitable
selection of menu commands, as hinted by the names. The Sheet and Bookmark toolbars
are actually defined as drop-down lists, offering an optional means for navigation between
sheets and bookmarks, respectively. Note that the contents and functionality of any toolbar
can be configured in a number of ways via the Customize option.

To the far left in all toolbars and also in the menu bar, a symbol of vertical dots is
displayed. Clicking and dragging here un-docks or docks the bar in the standard
Windows fashion.

Statusbar: Toggles the status bar on or off.

Zoom: Permits zooming in 25% increments of the sheet area to better fit different screen
resolutions. Other Zoom factors can be specified in the Sheet Properties: General page.

Server Objects: Toggles the Server Objects pane on and off.

Resize Window: With this option the window size of the QlikView document can be set to
one of several common screen resolution.
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» Fit Zoom to Window: Alters the size of the displayed active sheet and everything on it so
that it fits the window size.

» Apply Zoom to all Sheets: The Zoom settings of the displayed active sheet will be
transferred to all sheets of the document.

» Design Grid: Toggles the design grid, sheet object placeholders for active object(s) and
snap-to-grid for sizing and moving objects in the layout on or off . This command can also be
invoked by the following keyboard shortcut: Ctrl+G.

e Turn on/off WebView mode: Toggles WebView mode, which uses the internal web browser
in QlikView to display the document in AJAX mode, on and off.

» Current Selections...: Opens the Current Selections dialog where selections are listed by
field name and field value. This command can also be invoked by the following keyboard
shortcut: Ctrl+0O.

Selections menu

The Selections menu is a drop-down menu at the top of the screen, and contains the following
commands:

e Back: Reverts to the preceding logical state. Applies to value selections and all the
commands in the Selections menu. QlikView maintains a list of the 100 latest states. Each
Back will take one step further back in the list. This command can also be invoked by the
following keyboard shortcut: Shift+Left arrow.

« Forward: Reverts to the logical state before a Back command. Toggle between two states by
alternating between the Back and Forward commands. This command can also be invoked
by the following keyboard shortcut: Shift + Right arrow.

» Lock: Locks all the current value selections. This command can also be invoked by the
following keyboard shortcut: Ctrl+Shift+L.

* Unlock: Unlocks all the currently locked value selections. This command can also be invoked
by the following keyboard shortcut: Ctrl+Shift+U.

« Clear: Applies the start selection of a QlikView document, which can be configured, see Set
Clear State below. This command can also be invoked by the following keyboard shortcut:
Ctrl+Shift+D.

« Clear All: Clears all the current selections except the ones that are locked.

« Unlock and Clear All: Clears all the current value selections.

» Set Clear State: Sets the current selection as Clear State. Variables with the Include in
Bookmark option are returned to their original value when the Set Clear State is executed.

* Reset Clear State: Resets Clear State.

Layout menu

The Layout menu is a drop-down menu at the top of the screen, and contains the following
commands:
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Layout menu options
Option Description
Add Sheet... Adds a tabbed sheet in which a new set of sheet objects can be displayed.

Itis possible to add a new sheet to the layout even when working with a
document on a QlikView Server.

Promote Sheet Moves the (tab of the) current sheet one step to the left (forwards).
Demote Sheet Moves the (tab of the) current sheet one step to the right (back).
Remove Sheet Deletes the active sheet and everything on it.

Select Fields... Opens the Fields property page of the Sheet Properties sheet. One or

several field names can be selected from a list. The selected fields will be
displayed in default configured list boxes on the active sheet. To set the
specific properties of a list box right click on it and select Properties from
the float menu (or from Object in the Main Menu). This command is not
available when working with documents on QlikView Server.

New Sheet Opens a cascade menu in which it is possible to choose to create one of the
Object different sheet objects. When created, the corresponding Properties dialog
will be presented, for configuring the new object.
Itis possible to add new sheet objects to the layout even if working with a
document on QlikView Server, provided that:
a) the license is valid,
b) the server document has been configured to allow server objects
c) the QlikView Server is configured to allow server objects.

Rearrange Sheet ~ Automatically arranges the sheet objects on the active sheet.
Objects

Adjust Off- Any sheet object outside the visible area of the QlikView window is
Screen Objects repositioned back inside the visible area.

Align/Distribute The alignment of sheet objects can be determined here accordingto a
number of alternatives e.g. Left Align, Center Horizontally.

Select Fields

The Sheet Properties: Fields page is opened by the command Select Fields... in the Layout menu
on the Main menu. Here you can select the fields to display on the currently active sheet.

» Available Fields: In this column the names of the data source fields are shown. Initially all
fields (excluding System fields) appear in this column. To include the system fields, check
Show System Fields.

 Fields Displayed in Listboxes: In this column the names of the fields selected from the
Available Fields list to be shown on the current sheet are shown. Initially no fields are in this
column.

» Add >: Moves selected fields in the Available Fields column into the Fields Displayed in
Listboxes column.
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Add All >>: Moves all fields in the Available Fields column into the Fields Displayed in
Listboxes column.

< Remove: Moves selected fields in the Fields Displayed in Listboxes column into the
Available Fields column.

Show Fields from Table: From here, you control what fields appear in the Available Fields
list. The drop-down list displays the alternative All Tables by default. The alternative All
Tables (Qualified) shows the fields qualified by the name of the table(s) they occurin. This
means that key (connecting) fields will be listed more than once. (This alternative is only
used for viewing purposes and has nothing to do with Qualify fields in the load script.) It is
also possible to view the fields of one table at a time.

Show System Fields: Makes system fields appear in the list of Available fields.

OK: Changes are put into effect.

Cancel: Cancels any changes and closes the dialog box.

Select the fields to be used/removed by clicking on them, and use the Add> or <Remove buttons to
move them to the desired column. All fields shown in the two columns are included in the logic of
QlikView, but only the ones to the right are displayed in the current sheet.

The field List Boxes in which the selected fields are shown are in the sheet default configuration.
To change the appearance of a list box, right-click on it and select Properties in the object float

menu.

It is not possible to select fields that are not listed. For this, a new script must be executed.

Settings menu

The Settings menu is a drop-down menu at the top of the screen, containing the following
commands:

User Preferences...: Contains settings that the user does not normally change when
switching to another document. This command can also be invoked by the following
keyboard shortcut: Ctrl+Alt+U.

Document Properties...: Contains settings for the entire document. Some common
properties for the sheet objects in the document can also be set in this dialog. This command
can also be invoked by the following keyboard shortcut: Ctrl+Alt+D.

Sheet Properties...: Contains settings for the current sheet. Some common properties for
the sheet objects on the sheet can also be set in this dialog. This command can also be
invoked by the following keyboard shortcut: Ctri+Alt+S. See the links at the bottom of this
page.

Variable Overview...: Shows all non-hidden variables and their values in a single list. This
command can also be invoked by the following keyboard shortcut: Ctrl+Alt+V.

Expression Overview...: Shows all document, sheet and sheet object expressions, and also
makes it possible to maintain them centrally in a single list. This command can also be
invoked by the following keyboard shortcut: Ctri+Alt+E.
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Bookmarks menu
The Bookmarks menu is a drop-down menu at the top of the screen, and contains the following
commands:

Bookmarks menu commands

Command Description

Document The first ten document bookmarks of the active document can be retrieved from
Bookmarks this list.

User The first ten personal bookmarks linked to the active document can be retrieved
Bookmarks from this list.

Add From this dialog, you can edit the bookmark name. This command can also be
Bookmark invoked by the following keyboard shortcut: Ctrl+B.

Replace The first ten document bookmarks are listed above the first ten personal
Bookmark bookmarks of the active document. The command replaces the selection state of

the selected bookmark with the current state.

Remove The first ten document bookmarks are listed above the first ten personal

Bookmark bookmarks of the active document. The command removes the selected
bookmark.

More... Opens the Bookmarks dialog, where all previously created bookmarks for the

document can be retrieved.

Import... After browsing for and selecting a previously saved bookmark (.gbm) file, the
Import Bookmarks dialog will open to make it possible to import bookmarks.

Export... From this dialog, you can export selected bookmarks to a QlikView bookmark
(.gbm) file.

Reports menu

The Reports menu at the top of the QlikView screen contains the command Edit Reports... that
opens the Report Editor dialog where new reports can be created or existing reports edited. From
this dialog it is also possible to delete and select reports, design their layout, add pages and
images, etcetera. The report editor lists all available reports for immediate selection. You can
search for reports by name or select them from the drop-down.

Reports may be Document Reports, stored with the document, or User Reports, stored separately
on the user’'s computer.

Tools menu

The Tools menu is a drop-down menu at the top of the screen, and contains the following
commands:
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Edit module...: Opens the Edit Module dialog used for creating macros.

Open QlikView AccessPoint: Opens the QlikView AccessPoint in a html window inside
QlikView Desktop. This command is only available if a URL for QlikView AccessPoint has
been configured on the User Preferences: Locations page.

Documents cannot be opened with the QlikView Plugin from the AccessPoint
inside QlikView Desktop.

Open QlikView Management Console: Opens the QlikView Management Console/QlikView
Enterprise Management Console in an html window inside QlikView Desktop. This command
is only available if a URL for QlikView Management Console/QlikView Enterprise Management
Console has been configured on the User Preferences: Locations page.

Quick Chart Wizard...: This wizard helps creating a simple chart in a quick and easy way,
without bothering about the great number of different settings and options available.

Time Chart Wizard...: This wizard helps with the common task of building charts where a
given measure (expression) should be qualified and often compared by different time
periods, e.g. current year, last year, year-to-date etcetera.

Statistics Chart Wizard...: This wizard provides guidance for those who want to apply
common statistical tests on data in QlikView.

Box Plot Wizard: This wizard creates a combo chart, often used for display of statistical
data.

Alerts...: Opens the Alerts dialog where alerts can be defined and edited.

Alert Wizard...: This wizard helps with the task of defining an alert.

Theme Maker Wizard: This wizard is used for creating a new theme or editing an existing
theme.

Window menu

The Window menu is a drop-down menu at the top of the screen, containing the following
commands:

Cascade: Will arrange windows so that they overlap.
Tile: Will arrange windows as non-overlapping tiles.
Arrange Icons: Will arrange icons at the bottom of the window.

Available Documents: Displays an expanded listing (beyond 10) of open QlikView
documents and providing additional document information. Selecting a document makes it
the active window.

Available Documents

The Available Documents dialog can be used for switching the active document when more than
ten documents are open at the same time. Select a document in the list and click on Select to make
that document the active window.

This dialog also contains a wealth of support information that should be reported whenever
problems are experienced with a specific QlikView document. The columns are:
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Field

Document

Connection

Client Build
Number

Server Build
Number

Client NT
Name

Savedin
Version

Help menu

Available documents fields

Description

The name of the QlikView document. If Show Full Document Paths at the
bottom of the dialog is checked, the document name will be given with its full file
path.

Local (document opened on local computer) or Remote (document opened on
QlikView Server).

The build number of the QlikView client.

The build number of QlikView Server for remote documents.

The Windows NT authenticated identity of client user when connection is made
with NT authentication.

Full information about the QlikView version that was used the last time the
document was saved (available for local documents only).

The Help menu is a drop-down menu at the top of the screen, containing the following commands:

+ Contents: Opens the QlikView help.

» Using Help: Gives some useful advice on how to use the QlikView help.

» Show Start Page: Shows the start page each time QlikView starts. If the start page should
not appear when the program starts, deselect the Show Start Page When Launching
QlikView check box.

» License Update...: Opens a dialog where you can review or edit the License Enabler File.

» Document Support Info...: Displays a list of support data pertaining to the active document.

» About QlikView...: Opens the About dialog which displays the QlikView version, serial
number and owner name.

License Enabler File Editor

Here you can review or edit the License Enabler File.

The Current License Key is the serial number of the QlikView license and is normally entered at the
time of the original program installation. It may also be entered or edited at a later time from the
User Preferences: License dialog. It is also possible to run QlikView without a license key. In this
case, you either have a license lease from a QlikView Server —a Named CAL —or you have a
Personal Edition of QlikView.

The Current License Enabler File is a text file containing information relevant to the installed
license and is required in order to activate (enable) the license key. If you have a license key but this
text edit box is empty, you should first ensure that your computer is connected to the Internet and
then click the button Contact License Enabler Server below.

Working with QlikView - QlikView, May 2024 62



5 Navigate the user interface

Troubleshooting the License Enabler File

A License Enabler File (LEF file) is required in order to verify the validity of a QlikView license key.
During initialization of the license key, the Qlik LEF server is contacted via the Internet and,
provided that the license information given checks out, a LEF file is automatically transferred to
your computer. Under normal circumstances the LEF procedure is barely noticeable as it is done in
the background. There are however instances when the procedure fails, either because you are
unable to contact the LEF server or because a firewall prevents the transfer of the LEF file. When
this happens, the License Failure dialog will be displayed, informing you about the problem.

Should you be unable to obtain a valid LEF file through the normal procedure and you feel that you
are entitled to one, you can instead obtain it directly from Qlik Support. When you copy the text file
directly into the LEF editor, you must make sure that there are no trailing empty spaces in the text.

QlikView Settings File
All settings for QlikView are saved in a file (instead of being written to the registry). The file,
Settings.ini, is located in C:\Users|username|AppDatalRoaming|Qlik Tech|QlikView.

In the same file you will find settings for QlikView OCX.

Document Support Information

This dialog displays a list of support data pertaining to the active document. For example when
source documents have been reduced and published as user documents you can see the task
name and the execution time. This information should be referenced whenever bugs or problems
that may be related to specific QlikView documents are reported. Note that some rows are only
relevant for local documents while others refer only to remote documents.

Via the Copy to Clipboard button it is possible to copy and paste the contents of this dialog into
e.g. a text document attachment or directly into the support e-mail at the users convenience.

5.2 User Preferences: General

User preferences are settings that concern the way the user works and that are stored on the
computer, not in the document file.

User Preferences: General
» Show System Fields: If selected, the System Fields will be included by default in all listings
of field names.

» Show System Variables: If selected, the System Variables will be included by default in all
listings of variables.

» Use Sounds: Enables the built in sound effects of QlikView.

+ Remove Unused Bitmaps: Bitmaps used in sheets and sheet objects are normally retained in
the document even if their use is turned off. Check this alternative to have them
automatically removed.

+ Scramble Connect User Credentials: Check this alternative if the connect statement wizard
should mask the connect statements by scrambling user ID and password.
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« Remember Login Credentials until QlikView exits: QlikView can cache the UserID and
password for QlikView documents requiring login that have been opened for the duration of a
QlikView-session. By deselecting Remember Login Credentials until QlikView exits, the
user will be prompted to login each time a document is reopened.

» Keep Progress Open after Reload: Checking this box will keep the Script Execution
Progress dialog open after the script has finished reloading.

» Horizontal Scroll bar: If this setting is on, a horizontal scroll bar will appear along the edge of
the sheet whenever the positioning or sizing of sheet objects cannot be fully accommodated
horizontally inside the application window.

» Vertical Scroll Bar: As the above setting, but pertaining to the vertical.

» Resize Window to Documents: With this alternative checked, the size of the QlikView
window is determined by the size of the document, i.e. the size of the QlikView window at the
time the document was saved.

» Keep Orphaned QVD Buffers: This setting overrules the normal procedure whereby any
automatically created QVD files are purged immediately after script execution, provided that
the document that created them is no longer available. This setting should normally be left
unchecked.

» Flush script log after each write: For performance reasons, the script log is normally not
written to disk after each individual statement. By selecting this script box it will be. This may
be useful if other programs are used to monitor the script execution via the log. However,
using this setting may significantly increase script execution time in cases where the script
contains large numbers of statements.

» Re-open Script Dialog After Script Execution from Dialog: If the script is executed from
within the Edit Script dialog and this check box is marked, the dialog will be re-opened after
script execution.

» Show Getting Started Wizard When Creating New Document: Opens the Getting Started
Wizard which guides through the steps of creating a new document based on a single Excel
sheet.

* Purge Orphaned QVD Buffers Now: Click this button to perform a manual purge of
orphaned QVD buffers that have been retained by the setting Keep Orphaned QVD buffers
above.

» Most Recently Used Files: This group is used for controlling the list of recently opened
QlikView files in the File menu and on the Start Page.

o Under In Menu the number of recently used files listed in the File menu can be
changed. The default is 8.

° Under On Startpage the number of recently used files listed on the Start Page can be
changed. The defaultis 64.

These changes take effect after restart.

o |f the alternative Show Full Path in Menu is checked, the File menu will be widened as
necessary to show full paths in the list of recently used files.

° Clicking the Remove URLs button will remove any URLs from the list of most recently
used files.
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 Lodgfile Encoding: In this group it is possible to set the character set for the log file. The
default setting is ANSI, but it is possible to check the option Unicode instead.

» Selection Appearance:

o Preferred Selection Style
Sets the default selection style. QlikView supports a number of different ways of
presenting data and making selections in list boxes and multi boxes. The QlikView
Classic, Corner Tag, LED and Led Checkboxes styles all use color coding for
indication of selected, possible and excluded values. The Windows Checkboxes style
and the LED Checkboxes style mimic the standard Windows interface with a check
box at each value. This default can be overridden for a specific document by means of
a corresponding setting under Document Properties: General). There are limitations
as to the behavior of certain macro triggers when working with documents on
QlikView Server.

o Preferred Selection Color Scheme
Sets the default selection color scheme. When using the selection styles based on
color, there are a number of different color schemes available. The color scheme
(green for selected, blue for locked etc.) cannot be changed, but variations of tone
and intensity are possible. This default can be overridden for a specific document by
means of a corresponding setting under Document Properties: General).

« Change Interface Language: Press the button to open the Select Interface Language
dialog. In this dialog all language versions of QlikView that are available on the computer will
be listed (Various language versions are included as .dll files at the time of installation). For a
full list of the supported languages, see Supported languages (page 32). After selecting a
new language, QlikView must be restarted to effect the change. The change affects both the
language of the program user interface and the language of the online help, provided that the
appropriate help files are also available on the computer.

The interface language can also be set by modifying the settings.ini file, foundin
C:\Users\username\AppData\Roaming\QlikTech\QlikView. Edit the setting
InterfaceLanguage and set it to a supported language.

» Bookmark Popup Timeout (s): Check this alternative and enter a time delay to have
bookmark pop-up windows automatically close after a set number of seconds.

» Use WebView in Layout: Toggles WebView mode, which uses the internal web browser in
QlikView to display the document layout as an AJAX page, on and off.

» Search Settings: In this group settings are made for default search mode.

° Include Excluded Values in Search
There are two ways to interpret text search: it is possible to search either among
optional values, or among all values, i.e. include the excluded values in the search.
Enable this option to do the latter. This default value can be overridden on sheet
object level.
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o Preferred Search Mode
The default search mode for text search in list boxes, multi boxes etc. can be set in
this drop-down box. The default only applies when the user starts typing directly and
do not use any of the menu choices or keyboard shortcuts for starting the search. Itis
possible to override this setting by selecting a different setting on sheet object level.

° Use Previous
The search mode of the last completed search will be used.

° Use Wildcard Search
The initial search string will be two wildcards with the cursor between them to
facilitate a wildcard search.

o Use Normal Search
No additional characters will be added to the search string. Without wildcards, a
Normal Search will be made.

» Max Values in Current Selections: Specify the maximum number of distinct selected values
here to be shown in the current selections dialog and in the selection stamps in printouts.
When more values are selected they will only be specified as ‘x values of y’ for the respective
field.

» Working set limits %: This control sets the minimum and maximum of the physical amount of
RAM that can be used by an application. This way it is possible to control if an application can
be swapped out of physical memory or not. However, there are no guarantees that the
operating system can serve the process with the amount of memory set here.

Using too high settings will degrade the performance of other processes on the computer,
this may however be desirable if the computer is dedicated for QlikView.
Do not change these settings unless you are well acquainted with Windows Virtual Memory
Manager! Read more about working sets in the Microsoft Windows documentation.
The settings are:
° Low
Sets the minimum amount of memory, in percentage, to be allocated to the
application/process.
° High
Sets the maximum amount of memory, in percentage, to be allocated to the
application/process.

User Preferences: Save
This dialog tab contains settings for how QlikView documents should be saved.
+ Preferred Save Format: Here a default save format can be set for all new files. To make

changes that affect the current document only, select a Save Format under Document
Properties: General instead.
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Compression: This drop-down specifies the save compression mode for new documents. By
using compression, the size of the file will be reduced by typically 60-80% (actual results will
vary with the document). When using compression, document save times will be slightly
increased.

o With Medium compression all parts of the document except table data (which is
already stored quite compressed inside QlikView) will undergo compression.

o With High compression (default) also table data will undergo compression, saving
some space but further increasing save and load times.

° By choosing None all data are saved without compression.

Save Before Reload: Check this alternative to have the document automatically saved
before the script is executed.

Save Autorecover Info: Here rules for creating a backup of the current QlikView file can be
specified. This autosave functionality can be very helpful in case of a system crash. It is
possible to independently set the auto recover save to occur at regular intervals (Every _
Minutes) and each time the script is run (After Reload).

No AutoRecover files will be saved for a new document until it has been saved by
the user under a document name.

Use Backup: Here it is possible to specify rules for keeping earlier copies that have been
created by the autosave functionality. With Use Backup checked, it is possible to specify
how many backup versions will be retained (Keep Last _ Instances) and the program may
also retain a selection of preferred older versions (Keep Selected Older Instances).

User Preferences: Editor

In this dialog it is possible to determine the personal preferences for text in the QlikView editors.
These include the editors in the Edit Scriptdialog, the Edit Expression dialog and the macro editor
in the Edit Module dialog. Here it is possible to set different preferences in font, font size, font style
and font color for a number of different Text Types that can be highlighted in the text box.

Script and Expressions

Normal Text: Text that does not belong to any of the categories described below.
Keywords: The keywords used in the script, e.g. load, select, directory, semantic, etc.
Comments: Comments typed in the script or chart.

Error: The errors that QlikView detects in the script or chart expression.

Highlighted Text: When approaching a parenthesis with the cursor in the script, the
parenthesis, as well as the commas enclosed by it, will be highlighted. Missing parentheses
or commas will thus be easily detectable.

Field Names: The names of the fields to be loaded and used in charts.

Literals: Text to be loaded literally, i.e. as a text string (usually enclosed by single quotation
marks).

Functions: The functions used in the script, e.g. div, left, if, num, etc. and charts.
File Names: The name of the file from which the fields are to be retrieved.
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Script Macro: The variables used in the script.

Aggregation Functions: The aggregations functions used in the expression, e.g. sum, min,
max, etc.

Operators: The operators used in the script, e.g. +, like, etc. and in expressions.
Table Labels: The labels assigned to specific tables.
Set Analysis: The set analysis identifiers, modifiers and operators used in the expression.

Module

Normal Text: Text that does not belong to any of the categories described below.
Keywords: Visual Basic Script reserved keywords.

Highlighted Text: When approaching a parenthesis with the cursor in the script, the
parenthesis, as well as the commas enclosed by it, will be highlighted. Missing parentheses
or commas will thus be easily detectable.

Expression in Chart

Normal Text: Text that does not belong to any of the categories described below.
Comments: Comments typed in the chart expression.
Error: The errors that QlikView detects in the expression, e.g. a missing parenthesis.

Highlighted Text: When approaching a parenthesis with the cursor in the expression, the
parenthesis, as well as the commas enclosed by it, will be highlighted. Missing parentheses
or commas will thus easily be detected.

Field Names: The names of the fields used.
Functions: QlikView standard function names for chart expressions.
File Name: The name of the file from which the fields are to be retrieved.

Aggregation Functions: The aggregations functions used in the expression, e.g. sum, min,
max, etc.

Operators: The operators used in the expression, e. g. +, like, etc.
Set Analysis: The set analysis identifiers, modifiers and operators used in the expression.

Base Font for All Types
The font and the font size selected in this group will be applied to all the text types. Properties such
as bold, italic and underline can be set individually using the check boxes.

Clicking on the Foreground Color button brings up a color palette where it is possible to pick a
predefined color or define a custom foreground color.

To reset values, click the Defaults button.

The following features may also be used in editors:

Function Popup Help: Check this alternative to have a small pop-up window appear when
typing in a function.
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Remember Cursor Position: Check this alternative to have the editors for script and macro
remember the position of the cursor when leaving the editor. If this feature is not used the
cursor will be positioned at the start of the macro module and at the end of the script.

Copy as RTF: Check this alternative to have text copied from the editor windows stored in
the Clipboard not only as pure text but also as RTF. This makes it possible to paste the text
with full formatting into applications supporting RTF import.

User Preferences: Design

In the Script and Macro Shortcuts group it is possible to customize keyboard shortcuts for certain
actions in the script debug dialog.

Generate a list of all available keyboard shortcuts in the script by typing Ctrl+QS in the script.

Edit: Select a command from the list and click the Change button to customize the keyboard
shortcut for the command.

There are two optional Key Bindings:

Visual Basic: Sets the keyboard shortcuts to defaults familiar to the Visual Basic debugging
environment.

Visual C++: Sets the keyboard shortcuts to defaults familiar to the Visual C++ debugging
environment.

Other options:

Always Use Logfiles for New Documents: A log file (.log) will be generated when the script
is executed. The file will contain a timestamp for start and finish, the executed script lines,
number of rows generated by the script lines and, if the script execution was unsuccessful,
an error message.

File Wizard Sample Size: Specifies the number of records read into the table file wizard in
order to analyze a table being read.

Default Scripting Engine: Choose between VBScript and JScript.
Design Grid Settings:
° Snap Step (mm)
Sets the distance between the snap points when the design grid is displayed.

° Line Distance (mm)
Sets the distance between the grid lines when the design grid is displayed.

Default Margin Unit: Here it is possible to select whether the default unit for margins in the
Print: Layout page should be cm or inch.
Default Styling Mode: Choose one of the available modes for the object style of all the sheet
objects. The mode chosen will be used as default for all new documents.
Default Sheet Object Style: Choose one of the available styles for the sheet object style in
this drop-down. The style selected will be used for all sheet objects in the document.
Default Theme: Here it is possible to select a QlikView theme which will be set as the default
theme in newly created documents. The selected theme must be accessible from disc at all
times in order to be used. Itis also important that the theme used is defined for all types of
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objects that may occur in a QlikView document.

At the bottom of the drop-down list there is a Browse... command in case the theme file
resides in another location than in the default QlikView theme catalog. If no default theme is
specified, new documents will be created without default theme.

» Always Show Design Menu Items: If this checkbox is marked all design menu options will be
available on the context menu at all times.
If unchecked some design menu options will only be available when the Design Grid
command of the View menu is turned on.

User Preferences: Objects

Here you can determine a number of default settings for sheet objects.

« Enable all confirmation messages: When QlikView is first installed on a computer a number
of warning dialogs are enabled. Each of these will prompt for confirmation before performing
certain actions, such as deleting sheets and sheet objects or sending e-mail. Every warning
dialog includes a checkbox stating: "Do not show this message again". By checking the box
that particular warning dialog is permanently suspended. To turn all previously disabled
warning dialogs back on, click the Enable button in this group.

+ Table Defaults:

o Show Selection Indicators
Select this option if column selection indicator (beacons) should be enabled as default
for new table boxes, pivot tables and straight tables.

° Show Sort Indicator
Select this option if an icon indicating the primary sort column should be default for
new table boxes and straight tables.

° Field drop-down Select
Select this option if a drop-down selection icons should be displayed in field columns
for new table boxes, pivot tables and straight tables.

» Default Label for Others: In a number of chart types it is possible to limit the number of
plotted data points by setting a Max value. All data points that fall outside this limit are
collectively grouped as "Others". It is possible to edit the default label for Others here.

» Default Label for Total: The totals that may be displayed in bar charts, pivot tables and
straight tables is given the default label "Total". It is possible to edit the default label for Total
here.

« Caption Icon Defaults: In the group it is possible to set defaults for selected captionicons.

° Include Search Icon in New List Box Captions
When this check box is marked, all new list boxes will have the Search caption icon
enabled at creation. This is recommended for better usability and especially if the
document is to be published for the QlikView AJAX client.

° Include Print and XL Icons in New Table and Chart Captions
When this check box is marked, all new tables and charts will have the Print and Send
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to Excel caption icons enabled at creation. This is recommended for better usability
and especially if the document is to be published for the QlikView AJAX client.

Preserve Scroll Position: With this setting enabled, QlikView will try to preserve the scroll
position of tables and charts with a scroll bar when a selection is made in another object. The
setting must be enabled on the objects’ Layout page as well. The scroll position is not
preserved when you close the document.
Max Symbols in Charts: It is possible to specify an upper limit to how many data points that
will be displayed with symbols. The default number is 100. This feature is only useful in line
charts and combo charts, for expressions with both Line and Symbol checked.
Click in Chart background Clears Selection: If this option is checked, clicking in the
background of a chart's plot area will cause all selections in the chart's dimension fields to be
cleared.
Calculation Progress Information: In this group it is possible to determine the level of
information to be displayed when the calculation of sheet objects require more than one
second to complete.

o Off

No progress information is displayed.

° Normal
A progress bar is displayed.

° Verbose
A progress bar and additional text information is displayed.

User Preferences: Export

The Copying to Clipboard section covers the preferences for copying sheet objects to the
Clipboard.

In the Include Caption and Border group it is possible to enter the preferences separately for each
of the following sheet object types: List Box, Statistics box, Multi box, Table box, Input box, Current
Selections box and Chart for whether to include these layout features or not in the copy process.

Itis possible to set a preference for copying tables under Copy Table Format. From the command
Copy to Clipboard in the object menu of any QlikView table it is possible to make additional choices
regarding what information should be included at export.

Full Table: If this option is checked, a formatted table complete with its selection status will
be copied. This setting is preferable when copying for presentation purposes.

Data Area Only: If this option is checked, nothing but the raw data will be copied. This is the
preferred setting for quickly moving data between documents etc.

Show Options in Menu: If this option is checked, both alternatives will always be available as
a drop-down list from the Copy to Clipboard command.
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In the Replace Image as Default group it is possible to specify what is placed in Clipboard when
the Cut and Copy commands (Edit menu) are used. Normally only the bitmap image of a sheet
object is copied, but for a number of sheet objects further options are available:

» Table for Tables: Check this option to have tables (table boxes, straight tables and pivot
tables) copied in table format rather than as an image.

» Values for Charts: Check this option to have charts copied as underlying table values rather
than as animage.

» Possible Values for List Boxes: Check this option to have list boxes copied as possible
values rather than as an image.

» Text for Buttons: Check this option to have buttons copied as text rather than as an image.
» Text for Text Objects: Check this option to have text objects copied as text rather than as
an image.

» Selections for Current Selections Box: Check this option to have current selections boxes
copied as text selection stamp rather than as an image.

The Clipboard Zoom setting, which is independent of the current zoom setting of the sheet,
determines the size of the copied image. Larger pictures give better picture quality at the cost of
increasing size.

In the Selection Stamps in Exports group it is possible to determine whether selection stamps
should be included when exporting to the file types specified.

* On HTML Exports: Check to include selection stamps when exporting to HTML files.
» On BIFF Exports: Check to include selection stamps when exporting to BIFF (Excel) files.

In the Default Export Options group it is possible to set defaults for export formatting.

* Number Formatting: The number formatting of numeric data in QlikView may not always be
compatible with other programs due to user defined settings etc. The drop-down offers
three choices in Number Formatting of numeric data that is to be exported.

o Full Formatting: Exports numeric data with its full number format, just as it is shown in
the sheet objects of the document.
° No Thousand Separator: Removes any thousand separator from numeric data.

° No Formatting: Removes all number formatting from the data and exports the raw
numbers. The decimal separator will be as defined in the system settings (Control
Panel).

» Encoding: It is possible to set the default character set for export in new documents. Choose
one of these option: ANSI, Unicode or UTF-8.

» Use regional settings for HTML export: With this option the regional settings of the
operating system are used for the decimal separator when exporting to HTML. By
deselecting this option, a decimal point will be used, regardless of the regional settings.
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In the Send to Excel options group it is possible to set defaults for formatting used by the Send to
Excel menu command.

» Adjust Excel Palette to Colors in Export: If unchecked, the standard colors of the Excel
palette will replace the colors chosen in QlikView. The original colors will be replaced by
those that correspond the best to the colors in the standard palette.

User Preferences: Printing

In the Chart Colors group, it is possible to specify an override setting for all output from charts. Itis
possible to select one of three alternative settings:

« Use Chart Settings: The intrinsic chart settings regarding color or b/w will always be used.

» Force Color: All bitmap charts will be printed in color, irrespective of their Colors settings in
the document.

» Force Charts to Print in Black and White: All bitmap charts will be printed in b/w,
irrespective of their Colors settings in the document.

Other Options
» Set Print Defaults for New Objects: This button opens the Page Setup dialog where the
page margins and page orientation can be set.

» Bypass Postscript for Printing (slow): Due to the interaction between Microsoft graphics
libraries and certain printer Postscript drivers, the sharpness of printouts from Print Sheet
may occasionally be less than expected. This can be avoided by checking this alternative. It
may however result in significantly longer printing times (up to several minutes).

User Preferences: Mail

Here you can make settings for sending e-mail from QlikView. In order to use this functionality,
access to an SMTP server is required .

In the Sender group it is possible to specify the Name and e-mail Address that will appear as
sender on e-mail sent by QlikView.

Under Encoding it is possible to change the character code page used for sending e-mail, if there
are problems with the current setting.

Checking Send MIME encoded in order to encode e-mail can also be helpful.

In the Server group it is possible to specify settings for the SMTP server to be used for outgoing e-
mail from QlikView.

QlikView supports unencrypted communication with the SMTP server.

¢ Address: The address (URL or IP number) used for the SMTP server.
¢ Port: The port used by the SMTP server.
» Authentication method: Select if NTLM authentication is required by the SMTP server.
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User Preferences: Locations

Here you can determine default folder locations for certain files created when working with
QlikView. It can also be used to define shortcuts to document file folders for QlikView Server and
QlikView Publisher, as well as to specify URLs to the control panels of QlikView Server, QlikView
Publisher and QlikView AccessPoint. The tab contains a list of resource locations that can be

modified.

The pane at the top of the dialog contains a list of folder locations that can be modified:

* Resource: The following resource locations can be modified:

o

QVD Buffers
The default storage location of QVD files generated via the buffered prefix to load and
select statements in the script.

Themes
The default storage location for user defined layout themes.

User Files

The default root folder location where the folders containing user bookmarks, user
reports and user alerts are stored. Note that by changing this location without moving
the folder contents the existing user bookmarks, user reports and user alerts will be
lost.

Server Documents

Here it is possible to specify the location of the QlikView Server document folder,
when applicable.

Publisher Documents

Here it is possible to specify the location of the QlikView Publisher source document
folder, when applicable.

QlikView Management Console (URL)

Here itis possible to specify a URL pointing at the QlikView Management Console,
QMC, or QlikView Enterprise Management Console, QEMC, when applicable.
QlikView Server AccessPoint (URL)

Here itis possible to specify a URL pointing at the QlikView AccessPoint, when
applicable.

QlikView SDK (URL)

Here it is possible to specify a URL pointing at the QlikView SDK, when applicable.

Default License Lease Server (URL)

Here it is possible to specify a URL pointing to the QlikView License Lease Server,
when applicable.

Publisher Authorization Table (URL)

Here it is possible to specify a URL pointing to the section access authorization tables
created in QlikView Publisher. Section Access Management is configured in the
QlikView Management Console (QMC). For more information, see the QMC help.

» Location: The path to the respective folder location.
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Reset: This button resets the location of the selected folder to the QlikView default. The path
shown in the list will be preceded by the text <default>.

Modify...: When a folder resource is modified, this button opens the Browse for Folder
dialog where it is possible to browse to the location that is preferred for the selected folder.
When a URL resource is modified, this button opens a dialog where it is possible to enter a
URL.

User Preferences: Security

In this tab it is possible to choose to override one or more parts of the QlikView security measures
against hostile macros and scripts embedded in QlikView document. No warning dialogs prompting
the user to accept potentially harmful code will be shown. Use these options with caution and only
when working with well-known documents.

Module (Allow CreateObject and File Access): Mark this box to disable QlikView checks for
macros containing CreateObject calls or accessing external files.

Script (Allow database write and execute statements): Mark this box to disable QlikView
checks for scripts containing the execute command and mode is write qualifier in select
statements.

Launch (Start programs and documents from button, script, module): Mark this box to
disable QlikView checks for starting external programs from QlikView script, module or
buttons.

File (Save doc and export data to file): Mark this box to disable QlikView checks for saving
or exporting to files with suspect file extensions.

Confirm Launch from Macro: Unless this alternative is deselected, the user will be
prompted to confirm the launch of other applications from a macro.

User Preferences: License

QlikView License

This dialog shows the present registration information of the QlikView installation.

Change...: To enter a new serial number and a new control number for the license click this
button. Changes take effect only after restarting QlikView.

Clear License Information: If this button is clicked, the license number will be erased the
next time the application is started.

View License Agreement: Clicking this button will show the license agreement.

OEM Product IDs

This option is only available with an OEM Partner License.

Use OEM Product IDs for new documents: Enable this option if the question to use OEM
Product ID should be asked for new documents.

OEM Product IDs: Lists all available OEM Product IDs.
Edit...: Click this button to edit the Alias for the OEM Product ID.
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5.3 Toolbars and Status Bar

Toolbars

QlikView has five standard toolbars and one menubar. The standard toolbar normally contains
buttons for tasks performed while using QlikView documents, whereas the design toolbar normally
contains buttons for tasks performed when creating or changing the layout of a document. The
navigation toolbar contains the most frequently used commands for logical operations in a
document. The sheet toolbar offers an alternative method for navigating different sheets whereas
the bookmark toolbar offers an alternative way of accessing bookmarks.

Each of the toolbars can be individually enabled and disabled. All toolbars are completely
customizable and may contain any of the available command buttons.

All toolbars can be moved around by pointing at them on the dotted line to their far left. Hold down
the left mouse button and drag to any position. The toolbars can be docked to any side of the
QlikView application window.

Standard Toolbar
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The QlikView standard toolbar contains buttons for the most frequently needed functions. To
toggle the standard toolbar on or off choose Standard Toolbar under Toolbars on the View menu.
The figure above and the text below refer to the default contents of the standard toolbar.

» New File: Opens a new QlikView window and allows to create a new QlikView file. This
command can also be invoked by the following keyboard shortcut: Ctrl+N.

» Open File: Allows the opening of a QlikView file or table file in a new QlikView window.
Opening a table file automatically opens the file wizard. This command can also be invoked
by the following keyboard shortcut: Ctrl+0.

» Refresh: This command is only available with documents opened on QlikView Server and
when there is a newer version of the document available on the server. When invoking a
refresh access is gained to the latest data, while maintaining the session including selections
and layout state.

+ Save: Saves the active document as a file. The default file format is set in User Preferences.

 Print...: Clicking the print tool immediately effects the printout of the selected sheet object
according to default printer settings, bypassing the general print property page. The tool will
be grayed if no printable object is selected. This command can also be invoked by the
following keyboard shortcut: Ctrl+P.

« Print as PDF: Opens the Print dialog with the Microsoft Print to PDF printer pre-selected.
After pressing the Print button you will be prompted for a file name for the PDF output file.
This command is only available if a PDF printer is available on the system.

« Edit Script: Opens the Edit Script dialog, making it possible to write and execute script that
open databases and retrieve data into QlikView. This command can also be invoked by the
following keyboard shortcut: Ctrl+E.
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¢ Reload: Re-executes the current script, updating the associative QlikView database to
include changes made in source data since the previous execution. The time of the latest
reload is shown as a timestamp in the status bar.

* Undo Layout Change: Undoes the latest layout change, including moving, sizing and
removing of sheet objects as well as changes to sheet object properties. Removing sheets,
editing the sheet properties or document properties can also be undone. QlikView maintains
a list of the latest layout changes. Each Undo Layout Change command makes it take one
step backward in the list. Certain operations, e.g. Reload and Reduce Data will empty the
Undo/Redo buffer. This command can also be invoked by the following keyboard shortcut:
Ctrl+Z.

* Redo Layout Change: Redoes the latest undone layout action. Each Redo Layout Change
command makes it take one step forward in the list, as long as there are undone actions to
redo. Certain operations, e.g. Reload and Reduce Data will empty the Undo/Redo buffer.
This command can also be invoked by the following keyboard shortcut: Ctri+Y.

» Search: Opens the Search box for the active object. This command can also be invoked by
the following keyboard shortcut: Ctrl+F.

» Current Selections: Opens the Current Selections dialog in which it is possible to see the
selections that are active. This command can also be invoked by the following keyboard
shortcut: Ctrl+O.

* Quick Chart Wizard: Opens the Quick Chart Wizard where you can create a chart in a quick
and easy way, without bothering about the great number of different settings and options
available.

+ Add Bookmark: Opens the Add Bookmark dialog, where the bookmark hame can be edited.
This command can also be invoked by the following keyboard shortcut: Ctrl+Shift+B.

» Show/Hide Notes: Shows or hide user-created notes attached to sheet objects.

» Help Topics: Opens the QlikView help.

» Context Help: Displays specific help concerning the chosen object, e.g. a menu command.
After clicking this button, simply move the question mark to the object on which help is
needed.

Navigation Toolbar
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The QlikView navigation toolbar contains buttons for the most frequently needed functions when
using QlikView for analyzing data. To toggle the navigation toolbar on or off choose Navigation
Toolbar under Toolbars on the View menu. The text below refers to the default contents of the
Navigation Toolbar.

» Clear: Clicking on this button applies the start selection of a QlikView document, which can
be configured, see Set Clear State below. The drop-down menu offers the following options.

o Clear: The start selection of a QlikView document. This command can also be invoked
by the following keyboard shortcut: Ctrl+Shift+D.

o Clear All: Clears all selections, excluding locked ones.
° Unlock and Clear all: Unlocks and clears all selections.
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o Clear Specific State: Clears the selections of a specific state.
o Set Clear State: Sets the current selection as Clear State.
o Reset Clear State: Resets Clear State to no selections.

» Back: Reverts to the preceding logical (selection) state. Applies to value selections and all
the commands in the Edit menu except Copy and Copy Mode. QlikView maintains a list of
the 100 latest states. Each Back command will take one step further back in the list.

» Forward: Reverts to the logical state before a Back command. It is possible to toggle
between two states by alternating between the Back and Forward commands.

* Lock (Selections): Locks all the current value selections in the entire document.

» Unlock (Selections): Unlocks all the currently locked value selections in the entire
document.

In the QlikView Plugin, there is an additional Qlik button in the toolbar. Clicking this returns you to
AccessPoint.

Button to return to AccessPoint

Q)

Design Toolbar
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The QlikView design toolbar (see above) contains buttons for tasks to perform when creating or
changing the layout of a document. By default, this toolbar is not displayed. To toggle the design
toolbar on or off choose Design Toolbar under Toolbars on the View menu. The figure above and

the text below refer to the default contents of the design toolbar.

Design Toolbar buttons and options

Option Description

Add Sheet Adds a new sheet to the document.

Promote Sheet Moves the active sheet one step further to the left.
Demote Sheet Moves the active sheet one step further to the right.

Sheet Properties  Opens the Sheet Properties dialog, from which it is possible to modify the
active sheet.

Create List Box Creates a list box to display the field of choice from the database table.

Create Statistics  Creates a statistics box, which calculates statistical entities based on the
Box possible values of a field.

Create Table Box Creates a table box, suitable for showing record-oriented information.

Create MultiBox  Creates a multi box, suitable for showing different attributes.
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Option
Create Chart

Create Input Box

Create Current
Selections Box

Create Button

Create Text
Object

Create
Line/Arrow
Object

Create
Slider/Calendar
Object

Create Bookmark
Object

Create Search
Object

Create Container

Create Custom
Object

Create Time
Chart

Format Painter

Description

Creates a chart that can be made to display fields and calculated
dimensions.

Creates an input box, suitable for displaying and entering data into QlikView
variables.

Creates a current selections box, suitable for displaying the current
selections directly in the layout.

Creates a button object that performs actions in QlikView, e.g. shortcut,
export etc.

Creates an object for displaying text information or images.

Creates a line/arrow object, suitable for drawing a line or an arrow in the
layout.

Creates a new slider/calendar object.

Creates a new bookmark object.

Creates a new search object.

Creates a new container.

Creates a new custom object.

The time chart wizard helps to build charts where a given measure
(expression) should be qualified and often compared by different time
periods, e.g. current year, last year, year-to-date etc.

This button makes it possible to copy formatting from one sheet objects to
one or many other sheet objects. In order to copy formatting to a single
object, first click on the source object, then single-click on the format
painter button and then click on the target object. In order to copy
formatting to multiple objects, first click on the source object, then double-
click on the format painter button and then click on each of the target
objects. Stop the copying by clicking the button again or pressing Esc.

When copying formatting between sheet objects of different types or when
the user click on the caption of the target object(s), only border/caption
properties will be copied. When copying between sheet objects of the same
type, additional object type specific properties will be copied.
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Option
Design Grid
Align Left

Center
Horizontally

Align Right

Align Bottom
Center Vertically
Align Top

Space
Horizontally
Space Vertically
Adjust Left

Adjust Top

Document
Properties

User Preferences

Edit Module

Table Viewer

WebView Mode

Description
Toggles the design grid for object allignment.
Aligns the active sheet objects along their left border.

Aligns the active sheet objects along their center on the horizontal axis.

Aligns the active sheet objects along their right border.

Aligns the active sheet objects along their bottom border.

Aligns the active sheet objects along their center on the vertical axis.
Aligns the active sheet objects along their top border.

Distributes the active sheet objects on the horizontal axis with equal spaces
between them.

Distributes the active sheet objects on the vertical axis with equal spaces
between them.

Arranges the active sheet objects from the vertical edge of the left-most
object and to the right with minimal spaces between them.

Arranges the active sheet objects from the horizontal top edge of the
topmost object and downwards with minimal spaces between them.

Opens the Document Properties dialog, from which it is possible to modify
the settings of the current document.

Opens the User Preferences dialog, where it is possible to modify settings
concerning the way the user works.

Opens the Edit Module dialog where macros and custom defined functions
can be written in VBScript or JScript.

Opens the Table Viewer dialog where the data table structure is displayed.

Toggles WebView mode, which uses the internal web browser in QlikView to
display the document layout as an AJAX page.

Sheet Toolbar
: Sheets Geography - H
The sheet toolbar contains a drop-down list of all sheets in the document and offers an alternative
way of changing sheets. The name of the active sheet is always shown in the drop-down box. To
toggle the Sheet toolbar on or off choose Sheet Toolbar under Toolbars on the View menu.

Bookmarks Toolbar

- | v s

{ Bookmarks 2010-07-05 - 1
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The bookmarks toolbar contains a drop-down list of all bookmarks in the document and offers an
alternative way of changing bookmarks. You can search for bookmarks by name or select them
from the drop-down. After selecting a bookmark, the name of the bookmark will be shown in the
drop-down box until selections or variable values are changed.

Bookmarks toolbar buttons

Add Bookmark Saves the current selection as a bookmark.

Remove Bookmark Removes the bookmark selected in the drop-down menu.

Customize (Toolbars)

The Customize dialog allows users to configure toolbars according to their own preferences.
(While this is generally a very practical functionality, there are situations where the document
designer may wish to enforce a standard setting to be applied for all users of the document.

There are actually two types of customizable toolbars; the ones which are already defined (i.e.
named) in QlikView, and the ones which can be completely custom defined as needed.

The Customize dialog consists of the three tabs, Toolbars, Commands and Options described
below:

Toolbars

This page contains a list of all available toolbars and the menu bar. Activate/deactivate toolbars by
ticking the relevant check box in the list.

* New: Creates a new toolbar.

» Rename: Renames the highlighted toolbar. This command is not available for the five default
toolbars.

» Delete: Deletes the highlighted toolbar. This command is not available for the five default
toolbars.

» Reset: Resets the configuration of the highlighted toolbar to default settings.

Commands

As the instruction in the Commands tab states, adding to or deducting from the contents of any
toolbar is simply a matter of dragging any menu command from the Commands pane to the desired
toolbar or vice versa. First the toolbar being modified must of course be set to display mode in the
Toolbars tab. By means of the Categories pane it is possible to limit the listed commands to the
contents of a single QlikView menu at a time.

Options
The Options tab contains additional settings for customization:

In the Personalized Menus and Toolbars section it is possible to set if shorter menus with only the
most common commands should be used.
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» Always show full menus: Disable this option to use shorter menus with only the most
common commands.

« Show full menus after a short delay: When short menus are used, enable this setting
to have the full menu appear after hovering over the menu.

* Reset menu and toolbar usage data: This command deletes the records of the commands
used in an application and restores the default set of visible commands to the menus and
toolbars. It does not undo any explicit customizations.

The following display options have been grouped under Other:

« Large icons: This setting draws the toolbar icons at double size, improving visibility if
needed.

» Show Screen Tips on toolbars: This option toggles the tool-tips on or off.

» Show shortcut keys in Screen Tips: This option adds to the information displayed in the
tool-tips pop-up.

« Menu animations: This setting applies to the way menus (and cascade menus) open. In
addition to the System Default setting, a number of custom animations are available in a
drop-down list.

Customizing QlikView toolbars in large deployments

Enabling and Disabling Interactive Toolbar Customization

Toolbars and menus in QlikView are fully customizable. The interactive customization can be turned
on and off by means of the two settings in Settings.ini.

The inifile is found in C:|Users\username|\AppDatalRoaming|Qlik Tech\productname.
AllowCustomizeToolbars

and

AllowCustomizeMenubar

Setting the value to 1 enables interactive customization whereas the value 0 preventsiit.
Before changing these settings, make sure the application is closed.

Enforcing toolbar settings on large numbers of computers

To duplicate the toolbar settings between computers:

1. Customize the toolbars on one computer.

2. Copy the file Settings.ini.

The QlikView versions of the source and target computers should be the same in order
to guarantee 100% functionality.
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Status Bar

Below the sheet, the status bar is found. Choose View and Status bar to toggle it on or off. Some
interesting information is displayed here:

On the left side of the status bar, several things can be shown: the text Ready may be shown when
QlikView is ready for selections; if the cursor is moved over a graphical chart, the coordinates are
shown.

Itis also possible to obtain help to the left on the status bar. When clicking a command or a button
without releasing the mouse button, help is displayed. If the mouse cursor is moved outside the
command or the button before the mouse button is released, the command will not be executed.

In the middle of the status bar a time stamp is displayed. It shows when the last reload of data was
performed.

An AND-indicator is shown if the active object is in and mode.

On the right side of the status bar, the number of distinct optional (or selected) values over the total
number of distinct values in the active list box is presented, preceded by a D.

Further to the right, preceded by an F, the frequency of the active field is presented, showing the
number of records in the table where the field first occurs over the total number of records.

Finally a selection indicator is shown on the status bar. It will be green if selections are made that
cannot be seen on the current sheet.

5.4  Edit Script Dialog
The Edit Script dialog is opened from the File menu or by clicking on the Edit Script symbol £ in
the toolbar.

Here it is possible to enter and execute a script that connects the document to an ODBC data
source, or to data files of different types, and fetches the demanded information.

Scripts can be typed manually, or generated automatically. Complex script statements must, at
least partially, be entered manually.

The Edit Script dialog uses autocomplete, so when typing, the program predicts what is wanted to
type without having to type it completely. The predictions include words that are part of the script
syntax. The script is also color coded by syntax components. It may be customized by choosing
Tools and Editor Preferences.

At the top of the dialog a menu bar, with various script related commands, is found. The most
frequently used commands also appear in the toolbar. In the toolbar there is also a dropdown list for
the tabs of the script.
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Menus in the Edit Script Dialog

File Menu

Option
Reload

Debug...

Edit Hidden
Script...

Change
Hidden Script
Password...

Create
Hidden Script

Remove
Hidden Script

Save Entire
Document

Save Entire
Document
As...

Open
External
Script File

Save External
File

Export to
Script File...

File Menu options

Description

Executes the script, closes the dialog and opens the Fields page in the Sheet
Properties dialog. This command is also available on the Edit Script dialog
toolbar.

Starts the script execution in the debugger. The debugger is used for searching
for errors in the script. Every script statement can be monitored and the values

of the variables can be examined while the script is executed. This command is
also available on the Edit Script dialog toolbar.

Opens a script tab for hidden script. Here it is possible to define a hidden part of
the script, which is executed before the general script at each reload. Hidden
script tabs are always shown to the left of the open script tabs. A password is
required to create or access hidden script.

Opens the New Hidden Script Password dialog where a new password for
access to the hidden script can be set.

Opens the New Hidden Script Password dialog, where a password for the
hidden script must be set, and then opens a new script tab in the script window
called Hidden Script. Here it is possible to define a hidden part of the script,
which is executed before the general script at each reload. Hidden script tabs
are always shown to the left of the open script tabs.

Removes the hidden script from the Edit Script dialog.

Saves the active document in a file. Data, script and layout are saved. This
command can also be invoked by the following keyboard shortcut: Ctrl+S. This
command is also available on the Edit Script dialog toolbar.

Saves the active document in a new document file under a new name.

Makes it possible to browse for a file containing a script and opens itin a new
tab in the script pane, where it can be edited with the help of QlikView's color
coding.

Saves the external script file.

Saves the entire script in a text file to be specified in the Save script dialog that
appears. The file will have the extension .qvs.
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Option Description

Print Tab... Allows the printing of the active script tab on an optional printer. This command
can also be invoked by the following keyboard shortcut: Ctrl+P. This command
is also available on the Edit Script dialog toolbar.

Print All Allows the printing of the entire script on an optional printer. Hidden script will

Tabs... not be printed via this command.

Table Viewer  Opens the Table Viewer dialog where the structure of the loaded data can be
studied in a graphical view of tables, fields and associations. This command can

also be invoked by the following keyboard shortcut: Ctrl+T.

Edit Menu
Edit Menu options

Option Description

Undo Undoes the latest change (multiple step undo is possible). Equivalent to
pressing Ctri+Z.

Redo Redoes the latest Undo. Equivalent to pressing Ctrl+Y.

Cut Exports the selected text to the Clipboard. This command is is also available
on the Edit Script dialog toolbar. Equivalent to pressing Ctrl+X.

Copy Copies the selected text to the Clipboard. This command is also available on
the Edit Script dialog toolbar. Equivalent to pressing Ctrl+C.

Paste Pastes the contents of the Clipboard into the dialog at the position of the
cursor. This command is also available on the Edit Script dialog toolbar.
Equivalent to pressing Ctrl+V.

Delete Deletes the selected script text. Equivalent to pressing Del.

Clear Entire Clears the script, i.e. removes all the text except the initial autogenerated set

Script statements.

Select All Selects the entire script text. Equivalent to pressing Ctrl+A.

Find/Replace...

Opens a dialog which makes it possible to find and replace numbers or
characters in the script. This command is also available on the Edit Script
dialog toolbar. Equivalent to pressing Ctrl+F.

Goto... Opens a dialog which makes it possible to go to a specified line number in the
script. Equivalent to pressing Ctrl+G.

Upper Case Puts the selected script text in upper case.

Lower Case Puts the selected script text in lower case.

Invert Case Inverts the casing of the selected script text.

Capitalize Capitalizes the selected script text.
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Option
Comment
Uncomment
Indent

Outdent

Insert Menu

Option

Set Statement

Environment
Variables

Script File

Include
Statement

Domain SID

Test Script

Load
Statement

Section
Access

Connect
Statement

Disconnect
Statement

Tab Menu

Description

Transforms a text row in the script to a comment.
Transforms the text row back into original script text.
Indents the highlighted lines in the script.

Outdents the highlighted lines in the script.

Insert Menu options

Description

Opens the Set Statement Wizard where it is possible to enter a new set
statement and choose a predefined statement.

Inserts the number interpretation variables in the script based on the operating
system defaults.

Makes it possible to browse for a file containing a script or part of a script and
inserts its contents into the script at the position of the cursor.

Opens the Include Script Files dialog, where it is possible to browse for a script
file with one of the following formats: qvs (a previously saved QlikView script
file), txt or sql.

Retrieves the NT domain security ID for use in the script. The NTDOMAINSID is
employed in section access as one of the reserved fields that govern NT
security.

Inserts an autogenerated test script.

Inserts a load statement, either From File or Inline. Choosing Inline opens the
Inline Data Wizard with the help of which it is possible to create load inline
statements from a spreadsheet style control.

Inserts a section access statement either from a Publisher Authorization table
or Inline.

Choosing Publisher Authorization opens the File Wizard.

Choosing Inline opens the Access Restriction Table Wizard.

Inserts a connect statement in the script.

Inserts a disconnect statement in the script.

The Tab menu helps to organize the structure of the script.
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Option
Add Tab...

Insert Tab at
Cursor...

Rename...

Promote

Demote

Merge with
Previous...

Remove...

Tools Menu

Option

ODBC
Administrator
64 bit...

ODBC
Administrator
32 bit...

Editor
Preferences

Syntax Check

Help Menu

Tab Menu options

Description

Adds a new script tab. The script will be executed tab by tab in order from left to
right. If the current script tab is part of the hidden script, the new tab will also be
created within the hidden script.

Inserts a new tab after the active tab. Any text on the active tab positioned after
the cursor will be moved to the new tab.

Opens a dialog for renaming the active tab.

Moves the active tab one step to the left. Tabs cannot be promoted to the left of
the hidden script tab.

Moves the active tab one step to the right.

All text on the active tab is moved to the end of the preceding tab and the active
tab is deleted.

Removes the active tab. The last remaining script tab cannot be removed.

Tools Menu options

Description

Opens the ODBC Data Source Administrator for 64-bit ODBC drivers.

Opens the ODBC Data Source Administrator for 32-bit ODBC drivers.

Opens the User Preferences dialog where it is possible to set the font and
color of the different text types appearing in the script.

Checks the syntax of your script and stops at the first error.

Help opens the online help for QlikView.

Panes in the Edit Script Dialog

There are two panes in the Edit Script dialog: the script pane at the top, and the tool pane at the
bottom of the dialog.

Script Pane

The script pane contains the actual script. Each script line is numbered. The script may be divided
into several parts appearing on separate tabbed pages which are executed from left to right.
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If a hidden script is used, it may be viewed under a separate tab to the very left (provided that the
password has been given).

The script is color coded by syntax components. The color coding may be customized by choosing
Editor Preferences from the Tools menu.

Tool Pane

The tool pane consists of four tabbed pages containing functions for script generation.

Data Page
The Data page contains basic commands for getting data into QlikView:

The commands in the Database group are used to create a connection to and select fields from a
data source. If a commercial DBMS is used it is possible to use ODBC or OLE DB as an interface
between QlikView and the database. An ODBC or OLEDB driver that supports the DBMS must be
installed on the computer before it is possible to retrieve data over the ODBC/OLE DB interface.
Once the appropriate ODBC/OLE DB driver is installed, the database must be configured as an
ODBC data source.

Data Page commands

Command Description

OLE DB The connection to the data source is established using OLE DB.
ODBC The connection to the data source is established using ODBC.
QVSAdminDataProvider.dll This custom connector gives the possibility to connect to the

QlikView Server and load information from the DMS and
collaboration objects.

Custom... Any custom data source will also appear in the drop-down box
for selection. QlikView offers an open source plug-in interface,
providing possibility to program custom interfaces to various
types of data sources not covered from the traditional file, ODBC
or OLE DB interfaces. The typical case is data available via Web
Services. The plug-in should be programmed according to
specifications shown in a template code provided (on request) as
open source from Qlik and compiled as a dll. The dll is then
placed next to the QV.EXE file making the custom source
available to use.

Force 32 Bit Normally, QlikView uses 64-bit providers. In case a data source
with a 32-bit driver is to be used, check this option to force the
ODBC/OLEDB connect statement to a 32-bit provider.

Connect... Opens the Data Link Properties dialog in which a data source
can be selected, or the Connect to Data Source dialog where an
ODBC data source can be selected.

Select... Opens the Create Select Statement dialog.
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The Data from Files group is where data retrieval from other data sources can be made.

Data from Files options

Option Description
Relative If this setting is enabled, QlikView will use relative paths instead of absolute paths
Paths in the script. Relative paths are normally required when a document is to be moved

between different computers. This setting is also available in the User Preferences
dialog. If it is changed there, it will also be changed in the Edit Script and Edit
Hidden Script dialogs.

Use FTP Enable this setting to select files from an FTP server, when clicking Table Files,
QlikView Files or Include.

Table Opens the Open Local Files dialog listing table files. Selecting one or several files

files... and pressing OK will generate one or several load statements. When executed, the
script loads data from the corresponding files. If the Use FTP option is checked
(see above), select a server from the list (or enter the server to use, then click
Connect). When this is done, select a text file.

QlikView Opens the Open QlikView File dialog. When a file is selected a binary statement is
File... generated in the first line of the script. This statement loads the data from the
QlikView file but the layout settings will not be used.

Web Opens the File Wizard where it is possible to enter a URL as a source for the
Files... database table.

Field Data  Opens the File Wizard where it is possible to load the contents of an already
loaded field.

Variables Page
On the Variables page, the controls for pasting syntax relating to QlikView variables, are found.

Variable options

Option Description

Paste Pastes the selected function into the script.

Show System If this check box is marked, the list in the Variables drop down will include
Variables the system variables.

QlikView offers an open-source plug-in interface, providing possibility to program custom
interfaces to various types of data sources not covered from the traditional file, ODBC or OLEDB
interfaces. The typical case is data available via Web Services. The plug-in should be programmed
according to specifications shown in a template code provided (on request) as open-source from
Qlik and compiled as a dll. The dll is then placed next to the QV.EXE file making the custom source
available to use. It will then appear in the drop-down box for selection.

Functions Page
The Functions page contains tools for navigating and pasting QlikView standard functions.
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Option

Function
Category

Function
Name

Paste

Variables Page

Functions Page options

Description

Select a category in the drop-down list to see the corresponding functions in the
Function Name list below.

This drop-down list contains standard QlikView script functions.

Select a function in the Function Name list and paste it into the script at the
cursor position.

On the Variables page you will find controls for pasting syntax relating to QlikView variables.

Option
Paste

Show System
Variables

Settings Page

Variables Page options

Description
Pastes the selected variable into the script.

If this check box is marked, the list in the Variables drop down will include
the system variables.

The Settings page contains security settings for the QlikView script.

Settings Page options

Option Description

Script Open Databases in Read and Write Mode

Privileges If this option is selected the mode is write qualifier in select statements will be
enabled for use.
Can Execute External Programs
If this option is selected execute statements may be used in the script.

Settings Scramble Connect User Credentials
If this check box is marked, the USERID and PASSWORD in connect statements
will be scrambled in the script.

Set Statement Wizard

Current Set Statement

Variable Name

Either enter a name of a new variable or edit the predefined variable chosen below. The predefined
variable is inserted here when clicking Paste.

Working with QlikView - QlikView, May 2024 90



5 Navigate the user interface

Variable Value

If the name of a new variable is entered above, define the value here. If a predefined variable value
has been chosen below it is possible to edit it here.

Predefined Set Statements

Variable Groups
Choose what kind of variable to use.

Variables

Choose the variable to use.

Predefined Values

Choose between the predefined values in the variable.

Paste

Click the button to move the predefined values up to Current Set Statement for editing.

Find/Replace (Script)

The Find/Replace dialog is used for searching for specific text strings within the script and for
making multiple or bulk changes to it. It opens from the Edit menu in the Edit Script dialog.

Find/Replace fields
Field Description
Find What The text string to search for.

Replace The text to replace the search string with.
With

Find Next Moves selection to the next occurrence of the search string.
Replace Makes a replacement in the selected section.

Replace All  Makes replacements in all occurrences of the search string.

Case If this check box is marked, the text search will be case sensitive.

Sensitive

Word If this check box is marked QlikView will only find occurrences of the search string
Search forming a whole word (delimited by spaces or other non-letter characters).
Search All If this check box is marked, the find/replace operation will be made over all script
Tabs tabs.

Up Mark this radio button to search up through the script.

Down Mark this radio button to search down through the script.
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Commenting in the script

You can insert comments and remarks in the script code, or deactivate parts of the script code by
using comment marks. All text on a line that follows to the right of // (two forward slashes) will be
considered a comment and will not be executed when the script is run. Alternatively, you can
enclose a section of code with /* and */.

You can also insert comments to the script using the Rem statement.
Example:
Rem This is a comment ;

/* This is a comment
that spans two lines */

// This is a comment as well

Hidden Script

A hidden script is a special part of the script, which will be executed before the normal script at
each Reload. The hidden script is protected by a password.

When choosing Edit Hidden Script from the File menu in the Edit Script dialog you will be
prompted for a password, which will be required before giving access to the hidden script again. If it
is the first time accessing hidden script in a document (thereby creating one) the new password has
to be confirmed. After this the Hidden Script tab will appear to the left of all other script tabs and
remain there until the document is closed.

If a hidden script is used, the binary command cannot be used in the normal script.

The Progress dialog will not be updated during the execution of a hidden script, unless
Show Progress for Hidden Script is marked in Document Properties: Security page.
No entries, other than Trace statements, will be included in the script log file.

If the hidden script contains a section access, such a section will not be permitted in the
normal script or in a script starting with a binary load of the QlikView file containing the

hidden script.

Table Viewer

The Table Viewer dialog is opened when choosing Table Viewer from the File menu or pressing
Ctrl+T.
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This dialog is used to display the data table structure of the current QlikView document. Tables are
shown as boxes with a list of the fields they contain. Connector lines between the boxes show the
associations. Where more than two lines meet there are connector points in the form of small dots.

The tables, the connector points and also all points where the connectors bend can be moved by
means of mouse drag and drop (see below). When re-arranging the layout like this, the changes will
be saved with the document unless the dialog is exited with Cancel.

There are two views available, the layouts of which are stored separately. The two views are:

* The Internal Table View is the default view. It shows the data tables as QlikView stores
them. Composite synthetic keys are formed in tables that share more than one field.
Synthetic tables are used to link them. This view offers the best understanding of the
QlikView logic and also provides a very clean layout where each pair of tables has a
maximum of one connector between them.
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The Source Table View shows data tables as QlikView reads them. Here there are no
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When hovering with the cursor above one of the fields in a table, a tool tip pops up with information
about the content of this field:

Information density is the number of records that have values (i.e. not NULL) in this field as
compared to the total number of records in the table.

Subset ratio is the number of distinct values of this field found in this table as compared to
the total number of distinct values of this field (that is other tables as well).

Table comments are displayed in the tool tip.
Field comments are displayed in the tool tip.

Tags that are added in the script or in Document Properties: Tables page, including system
tags, are displayed in the tool tip.

The following actions can be performed in the table layouts:

Click on Table Caption: Highlights the table, all tables with direct logical associations with
that table and the connections between them.

Point at Table Caption and Drag: Moves the table in the layout.
Hover Over Table Caption: Shows pop-up info about table.

Click on Field in Table: Highlights the table, the field, all tables containing that field and the
connections between them.

Hover over Field in Table: Shows pop-up info about field.

Right-click in a Table: Click on Preview to see a dialog of sample records from the loaded
data.
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« Point at Connector Point or Connector Bend and Drag: Moves the connector point in the
layout.

« Right-click on Connector Point or Connector Bend: Moves the connector point back to
automatic positioning.

» Click on Layout Background: Cancels all highlighting of tables, fields and connectors.

The following commands are available in the dialog toolbar and buttons:

« Export Image: Opens a file browser dialog making it possible to save the current table view
as a bitmap or png image to a file on disc.

« Export Structure: By pressing this button it is possible to export the table structure of the
document to a set of text files.
These text files, one for the tables (filename.Tables.tab), one for the fields
(filename.Fields.tab) and one for mapping in between (filename.Mappings.tab) can easily
be read back into QlikView for further analysis with the full power of the QlikView logic. A
dialog will appear where the target folder for the export can be chosen. The default is to put
the files in the same folder as the QlikView document.

» Print Image: Opens the Print dialog from which it is possible to print the current table view.
Equivalent to pressing Ctrl+P.

« Copy Image: Copies the current table view as an image to clipboard. Equivalent to pressing
Ctrl+C.

e Auto Layout: Re-arranges the tables in the current view.
e Zoom: The zoom factor of the current view can be set in this drop-down box.
* View: Choose between Internal Table View and Source Table View (see above).

Data Link Properties

This dialog is used for creating a connection to an OLE DB data source, typically via ODBC. The
dialog is opened when clicking the Connect... button in the Data page of the Tool Pane in the Edit
Script dialog.

The first tab lists the names of the OLE DB providers. In order to create an ODBC data connection,
select OLE DB Provider for ODBC Drivers, then click Next>> to get to the Connection tab.

On the Connection tab under 1, specify the source of data, a previously configured data source is
chosen. There are two different types of ODBC data sources that may come into question.

Pre-Defined Data Sources

ODBC data sources which have been predefined can be accessed by selecting the radio button
Use data source name. The drop-down list contains all the data sources that are defined. Select
the data source to use.

If necessary specify User name and Password for the data source. The connection can also be
tested by pressing the Test Connection button.

Finally click the OK button. The connect statement is ready.
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Generic Data Sources

Generic data sources are used e.g. for database files. If a generic data source is to be used or a new
source should be created, select the Use Connection String radio button and click Build. This
opens the Select Data Source dialog.

There are two types of data sources available: File data sources and Machine data sources. The
latter data sources are specific to the local machine and user while file data sources are specific to
a file. Any of the two can be used. Each has a separate page in the Select Data Source dialog.

Generic data sources are used e.qg. for database files. If you want to use a generic data source or
create a new source, select the Use Connection String radio button and click Build. This opens the
Select Data Source dialog.

There are two types of data sources available: File data sources and Machine data sources. The
latter data sources are specific to the local machine and user while file data sources are specific to
afile. Use any of the two. Each has a separate page in the Select Data Source dialog.

Double-click a data source, then browse to the applicable database file in the dialog that opens.

For MS Access data sources you must click the Database button in an intermediate
dialog.
When hitting RETURN it returns to the second page of the Data Link Properties dialog.

Specify if necessary User name and Password for the data source. It is also possible to test the
connection by pressing the Test Connection button.

Finally click the OK button. The connect statement is ready.

Connect to Data Source

This dialog is used for creating a connection to an ODBC data source. The dialog is opened when
clicking the Connect button in the Data page of the Tool Pane in the Edit Script dialog if the
database option ODBC has been chosen.

On this page choose the data source. As default only the system DSNs are displayed. Check Show
User DSNs to view all DSNs.

It is possible if necessary to specify User name and Password for the data source. The connection
can also be tested by pressing the Test Connection button.

Finally click the OK button. The CONNECT statement is ready.

Create Select Statement

The Create Select Statement dialog is opened by clicking the Select button in the Data page of
the tool pane in the Edit Script dialog. It is used to define the tables and fields to be loaded from a
previously selected data source.

The dialog consists of three groups. The first group contains information about the data source.
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Data
Source

Database

Owner

Connect

Driver

Support

Name of the current ODBC/OLE DB data source.

Itis possible to choose between available databases via the drop-down list.

The database owner is shown here. It is possible to choose between available
owners via the drop-down list.

By clicking this button, the Connect to Data Source dialog opens.

Click this button to open the ODBC Driver Information or OLEDB Driver
Information dialog, containing information about supported functionality in the
driver currently used.

Opens a dialog with support information about the database. The information can
be used whenever contacting Qlik support and when reporting bugs or problems
in relation to QlikView documents.

The second group is used for selecting tables and fields.

Database
Tables

Fields

Show Icon
for Key
Fields

Tables
Views
Synonyms
System

Tables

Aliases

This list shows available database tables. Click on a table name to select it. The
types of tables that appear in the list can be controlled via the check boxes to the
left (see description below).

This list shows all available fields in the selected table. Choose one or more fields
from the list to be included in the select statement. Use " * " in order to select all
of the field names at once. The selection of fields will be reflected in the Script
page of the third group (see description below). Fields can be sorted in Original
Order from the database or in alphabetical Text Order by selection in the drop-
down control.

When this alternative is checked, any field that is defined as a key field in the
source database will be shown with a key icon in the Fields list.

This check box must be selected if regular database tables are to appear in the
Database Tables list.

This check box must be selected if database views are to appear in the Database
Tables list.

This check box must be selected if database table synonyms are to appear in the
Database Tables list.

This check box must be selected if database system tables are to appear in the
Database Tables list.

This check box must be selected if database table aliases are to appear in the
Database Tables list.

The third group shows the generated select statement and information about the selected table
and fields. The group contains the following pages:
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Script

The Script tab shows the script about to be generated for the select statement.

The three radio buttons to the right control the formatting of the select statement in the script.
Column Select this option to generate the select statement with each field name
appearing on a separate row in the script.

Row Select this option to generate the entire select statement appearing on a single
row in the script.

Structured Select this option to generate the select statement on structured rows in the

script.
Preceding If this option is marked, the select statement will be generated with a preceding
Load load statement using the select statement as input. All fields will be listed in the

load statement, even if * is used in the select statement.

Add Click this button to save the select statement generated so far. The generation
of a new select statement is initiated without leaving the dialog. The old
statement will be visible in the preview pane above a clear divider. This
procedure may be repeated any number of times.

Table
The Table tab shows detailed information about the selected database table.

More... opens a separate sizable dialog with an expanded view of the Table, Columns and Preview
pages.

Columns

The Columns tab shows detailed information about the selected columns (fields) of the current
table.

Preview

The Preview tab shows a preview of the first rows that will be generated by the current select
statement.

Blobs

The Blobs tab makes it possible to bundle so-called Blobs (Binary Large Objects), in a QlikView
document. It is usually a picture, a text file or similar, stored as a single entity in a database
management system. The iicon indicates that the field contains a blob. The blobs in the database
are listed together with size (in KB) and type in the Blob Viewer. The Blob is previewed next to the
listif it is an image. QlikView supports jpg, png, bmp, pdf and rtf blobs.

The Bundle... button opens the Bundle dialog.
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Key Field for the In the list select the blob that should be resized.
Blob data
Shrink Images Enable the option to resize the blob. Apply Pixel Width and Pixel Height

to resize the image to fit.

The setting does not handle aspect ratio.

It is only possible to bundle Blobs using ODBC.

Once the selections of table and fields has been made it is possible to click OK to insert the select
statement(s) generated at the cursor position in the QlikView script. Pressing Cancel will abandon
changes.

The ODBC driver can usually interpret far more complicated select statements than the ones which
can be produced by this dialog. An alternative way to generate a more complex select statement is
to use a query tool, e.g. Microsoft Query, and graphically make the select statement there. When
this is done, copy (Ctrl+C) the select statement and paste it (Ctrl+V) into the QlikView script. (In MS
Query, click the SQL button.)

Open Local Files
This dialog is opened by the Table files button in the Edit Script dialog.

In the Open Local Files dialog box it is possible to specify the table files that are to be loaded. For
multiple file selections, use Ctrl-click or Shift-click. When the OK button is pressed, the selected file
is interpreted in the File Wizard.

Open Internet Files or Open QlikView Document

This dialog appears when clicking on one of the buttons QlikView File... or Table Files... in the Data
page of the Tool Pane in the Edit Script dialog - provided that the Use FTP check box is marked.
Depending on which button was used to open it, the dialog is called Open QlikView Document or
Open Internet Files, but the functionality is the same. This dialog can also be used to open
QlikView documents. This is done by choosing Open FTP from the File menu.

Select the server containing the file(s) that should be opened in the drop-down list box. If the server
is not in the list (or if there is no list), enter a server name, then click Connect.

Open dialog
Field Description
FTP Server The first time connecting to the FTP server, the address has to be typed in here.
Address
User Name Unless Anonymous Logon is checked, the user name will be entered here.
Password Unless Anonymous Logon is checked, the password will be entered here.
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Field Description

Connect Click this button to connect to the selected server. Selecting a server directly
from the list, bypasses this procedure.

Passive To connect through a firewall, a passive FTP may have to be used.
Semantics

Anonymous Lets the user log on without stating a user name and password.
Logon

File Name The name(s) of the selected file(s) will appear here, when connected to the
server.

Files of Type  Specify the desired file type here.

Open Clicking this button generates a load statement that will enter into the load
script in the Edit Script dialog.

Inline Data Wizard

The Inline Data Wizard dialog is opened from the Insert menu, Load Statement, Load Inline. It is
used to create load inline statements in the script.

The dialog contains something looking like a spreadsheet and in fact works like one in most
respects. Note however that calculation formulas will not be evaluated in this spreadsheet as they
would e.g. in Microsoft Excel.

Each column represents a field to be loaded into QlikView by means of an inline table. Each row is a
record in the table. A data cell is selected by clicking it. A value may then be typed or pasted in from
clipboard. Press Enter or an arrow key to accept the value and move to another cell.

The top (label) row is reserved for field labels. Double-click in a label cell to edit it. If no values are
entered in the label row the field names F1, F2 etc will be used.

Edit Menu
The Edit menu contains some basic editing commands.
Edit menu commands
Command Description
Insert Column  Inserts a new blank column if one or more columns are selected.
Delete Column Deletes the selected column(s).
Insert Row Inserts a new blank row if one or more rows are selected.

Delete Row Deletes the selected rows.

Working with QlikView - QlikView, May 2024 100



5 Navigate the user interface

Tools Menu

The Tools menu contains the command Document Data that opens the Import Document Data
Wizard from which it is possible to paste field values from any existing field in the document. In the
dialog it is possible to see how many field values are present in any selected field. It is also possible
to choose to insert all values, selected values or excluded values into the inline wizard.

Click OK to close the dialog and generate a Load inline statement reflecting the contents of the
dialog's table grid.

Access Restriction Table Wizard

The Access Restriction Table Wizard dialog is opened from the Insert menu, Section Access,
Inline. It is used to generate a Load Inline statement for access control to the QlikView document.

The dialog contains the following commands:

Security fields
Field Details

Fields to Use The list contains all the possible security fields in a QlikView section access.
Mark the check box for those you wish to include.

Basic User Press this button to mark ACCESS, USERID and PASSWORD while unmarking
Access Table the other fields.

Basic NT Press this button to mark ACCESS, PASSWORD, NTNAME and NTDOMAINSID
Security while unmarking the other fields.

When closing the dialog with OK, the Inline Data Wizard will be opened with the selected fields as
column labels. After you press OK in this dialog, a Load Inline statement preceded by a Section
statement and succeeded by a Section Application statement will be created.

File Wizard

The File Wizard automatically appears when opening a file or an HTML table using the Table
Files... button in the Data page of the Tool Pane in the Edit Script dialog. The wizard also opens
when a non-QlikView document file is opened from the File menu.

File types that QlikView can recognize are delimited text files (e.g. csv files), fix record files, dif files,
Excel files, HTML files and XML files. These file types are referred to as Table Files.

Files can be loaded from the local network or directly from the Internet.

To load a file stored on a local network, use the Table Files button in the Edit Script dialog. If the
file has a file extension of a table file, .csv, .txt, .tab, .skv, .fix, .dif, .htm, .html, .shtml, .xhtml, .php or
.asp, the file will be shown in the Open Local Files dialog. It is possible to open the file even if it has
a different extension; just set Files of Type to All files (*.*) in the Open Local Files. The content
must however still be such that QlikView can interpret it. Whether or not QlikView can, is a different
matter from what extension the file has.
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To load a file directly from the Internet, paste the URL (previously copied from the web browser)
into the text box named File Name in the FTP browsing dialog and click Open.

Once a file has been selected, the file wizard opens. It contains five pages: Source, Type,
Transform, Options and Script. Since one very rarely needs to change anything on the Source
page, the wizard starts on the Type page. The <<Back and the Next>> buttons will take the user
from one page to another.

On the Type and Options pages there is a preview in which it is possible to see how QlikView has
interpreted the file. The Script page makes it possible to set how the script is presented in the Edit
Script dialog.

The Finish button will close the wizard and generate a load statement in the load script.

To load a file stored on a local network, use the Table Files button in the Edit Script dialog. If the
file has a table file extension, e.g. .csv, .txt, .tab, .skv, .fix, .dif, .htm, .html, .shtml, .xhtml, .php or
.asp, the file will be shown in the Open Local Files dialog. It is possible to open the file even if it has
a different extension; just set Files of Type to All files (*.*) in the Open Local Files dialog. The
content must however still be such that QlikView can interpret it. Whether or not QlikView can, is a
different matter from what extension the file has.

To load afile directly from the Internet, paste the URL (previously copied from your web browser)
into the text box named File Name in the FTP browsing dialog and click Open.

Once a file has been selected, the file wizard opens. It contains five pages: Source, Type,
Transform, Options and Script. Since one very rarely needs to change anything on the Source
page, the wizard starts on the Type page. The <<Back and the Next>> buttons will take you from
one page to another.

On the Type and Options pages there is a preview in which you can see how QlikView has
interpreted the file. The Script page lets you set how the script is presented in the Edit Script
dialog.

The Finish button will close the wizard and generate a load statement in the script.

File Wizard: Source

This page contains all the settings related to the source of the table. The source usually is well
defined as soon as a file is selected in the Open File dialog, but if one needs to make changes in the
source definition, which is often the case for e.g. tables fetched directly from Internet pages, this is
the place to make them. Pressing the <Back button on the Type page opens the Source page.

Source settings
Setting Description
Local File Enter the path to a local file or click Browse to find it through the explorer.

Internet Enter the path to the Internet file.
File

From Field  Opens the Document Data Source dialog where it is possible to choose table and
field
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Document Data Source

This dialog lists the tables of the active document and makes it possible to use a previously loaded
field as data source.

Document Data Source properties
Property Description

Field Value The selected value.

» Tables: A drop-down menu showing the tables that are loaded in the active
document.

« Fields: The fields of the selected table.
» Values: The values of the selected fields.

File Path The name of the selected table and field.

Value Type The type of the selected value.

e Text: If the value is text it is displayed here.
 Info: If information is connected to the field value it is displayed here.
» Blob: If a blob is connected to the value it is displayed here.

File Wizard: Type

This page contains the settings related to file type and table type. The settings vary according to
file type.

When opening a table file, the program tries to interpret the contents of the file. The initial values of
the parameters are set this way, but can of course be changed manually by the user.

File Type

The type of file is set here: Delimited, Fixed record, DIF, Excel Files (xls), Excel (xIsx), HTML, QVD,
XML, KML or QVX.

Preview Pane

The result of the chosen settings is displayed in the preview pane (the lower part of the dialog
page). When the settings are changed, the contents of the preview pane change accordingly. Itis
also possible to make some changes directly in the preview pane. First, it is possible to omit fields
by clicking the “cross” button to the right of the field name. The cross will then change into an
exclamation mark and the field will not be included in the load statement. To revoke this change,
just click the exclamation mark once more. To rename a field, click the field name, enter the new
name in this box and confirm by pressing RETURN. The as clauses in the load statement are then
created automatically. Finally, for fix record files (and some HTML tables) it is also possible to set
the column widths directly by clicking in the preview pane.

File Wizard: Type - Delimited
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Delimited settings
Setting Description

Delimiter Specify what type of delimiter is to be used. To use a delimiter other than the
predefined ones, choose Custom to find the correct delimiter. Custom opens the
delimiter selector dialog, where it is possible to choose among the delimiters
available on the computer.

Header Size The header part of the file is a specified number of lines or bytes (only for
delimited, fixed record and Excel files). The header may be omitted.

Character The character set of the table file is set here. If the desired character set is not

set available in the drop-down menu, it is possible to choose Custom. This opens the
Codepage selector dialog, where to choose among the character sets installed
on the computer.

Quoting Set the quotes scheme to be used. Choose between Standard, None and MSQ.

Comment In some files, comments are used between records. Often a comment line begins
with a special character or a set of characters, e. g. //. Here it is possible to
specify the character(s) that mark the beginning of a comment to enable QlikView
to recognize comments.

Labels If the field names (column headers) are stored in the first line of the table, this
control should be set to Embedded. The format also allows field names to be
explicitly specified, and if that is the case, this control should be set to Explicit. If
the table contains no field names, the None alternative should be used.

Ignore EOF  Sometimes a special character is used to mark the end of the file. In case this
character is found in the middle of a text file (for example enclosed by quotation
marks) you can enable this option to ignore it.

File Wizard: Type - Fixed Record
Fixed record settings
Setting Description

Header Size  Here it is possible to omit the header part of the file: a specified number of lines
or bytes (only for delimited, fixed record and Excel files).

Record Size  Specify the size of arecord to be a specified number of lines or a specified
number of bytes (only for fixed record files).

Char Set The character set of the table file is set here. If the desired character set is not
available in the drop-down menu, choose Custom. This opens the Codepage
selector dialog, where it is possible to choose among the character sets installed
on the computer.

Ignore EOF Sometimes a special character is used to mark the end of the file. In case this
character is found in the middle of a text file (for example enclosed by quotation
marks) you can enable this option to ignore it.
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Setting
Tab Size

Embedded
Labels...

Analyze Fix
Positions

Clear Fix
Positions

File Wizard:

Setting
Labels

Character
set

File Wizard:

Setting
Tables

Header
Size

Labels

Description
The length of a tab set in spaces.

Embeds the labels. Should be used if the field names are stored in the first line of
the table.

Analyzes and sets the columns widths for fix record files and for some HTML
tables. After the analysis, column breaks can be added or removed in the preview
pane.

Clears all column breaks (for fix record files and for some HTML tables).

Type - DIF
DIF settings
Description

If the field names (column headers) are stored in the first line of the table, this
control should be set to Embedded. The DIF format also allows field names to be
explicitly specified, and if that is the case, this control should be set to Explicit. If
the table contains no field names, the None alternative should be used.

The character set of the table file is set here. If the desired character set is not
available in the drop-down menu, choose Custom. This opens the Codepage
selector dialog, where it is possible to choose among the character sets installed
on the computer.

Type - Excel XLS
Excel XLS settings
Description

In the Tables group it is possible to choose a specific table when reading from a file
containing several tables, e.g. HTML or Excel files. In Excel, all sheets in a workbook
and all named areas (e.g. multiple cells with names) in the worksheets are identified
as possible tables. Note that the Excel sheet names must not contain the characters
&, >or<.

When defining a named area on a sheet, the selected Scope must be Workbook and
the Refers to field must keep its original value (the one assigned by default).
Otherwise, the named area might not be seen as a table.

Here it is possible to omit the header part of the file: a specified number of lines or
bytes (only for delimited, fixed record and Excel files).

If the field names (column headers) are stored in the first line of the table, this
control should be set to Embedded. The DIF format also allows field names to be
explicitly specified, and if that is the case, this control should be set to Explicit. If the
table contains no field names, the None alternative should be used.
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File Wizard:

Setting
Tables

Header
Size

Labels

File Wizard:

Setting
Tables

Labels

Char Set

Analyze Fix
Positions

Clear Fix
Positions

File Wizard:

Type - Excel XLSX
Excel XLSX settings
Description

In the Tables group it is possible to choose a specific table when reading from a file
containing several tables, e.g. HTML or Excel files. In Excel, all sheets in a workbook
and all named areas (e.g. multiple cells with names) in the worksheets are identified
as possible tables. Note that the Excel sheet names must not contain the characters
&, >or<.

When defining a named area on a sheet, the selected Scope must be Workbook and
the Refers to field must keep its original value (the one assigned by default).
Otherwise, the named area might not be seen as a table.

Here it is possible to omit the header part of the file: a specified number of lines or
bytes (only for delimited, fixed record and Excel files).

If the field names (column headers) are stored in the first line of the table, this
control should be set to Embedded. The DIF format also allows field names to be
explicitly specified, and if that is the case, this control should be set to Explicit. If the
table contains no field names, the None alternative should be used.

Type - HTML
HTML settings
Description

In the Tables group it is possible to choose a specific table when reading from a file
containing several tables, e.g. HTML or Excel files. In Excel, all sheets in a
workbook and all named areas (e.g. multiple cells with names) in the worksheets
are identified as possible tables.

If the field names (column headers) are stored in the first line of the table, this
control should be set to Embedded. The DIF format also allows field names to be
explicitly specified, and if that is the case, this control should be set to Explicit. If
the table contains no field names, the None alternative should be used.

The character set of the table file is set here. If the desired character set is not
available in the drop-down menu, choose Custom. This opens the Codepage
selector dialog, where it is possible to choose among the character sets installed
on the computer.

Analyzes and sets the columns widths for fix record files and for some HTML
tables. After the analysis, column breaks can be added or removed in the preview
pane.

Clears all column breaks (for fix record files and for some HTML tables).

Type - QVD

This file type has no configurable settings.
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File Wizard: Type - XML
XML settings
Setting Description
Tables The found tables are shown in this list. Each table is shown as a path that
corresponds where in the XML structure it was found. When a table is selected, its

fields will be shown in the Fields pane to the right. A Load statement will be
generated for each table in the list when the Finish button is clicked.

XML This sheet shows the interpreted XML structure.

Fields This sheet shows the fields of the selected table and the generated keys.

File Wizard: Type - KML

You can load map files that are stored in KML format, to use in map visualizations.
This file type has no configurable settings.

File Wizard: Type - QVX

A QVX formatted file contains metadata describing a table of data and the actual data. In contrast
to the QVD format, which is proprietary and optimized for minimum transformations inside QlikView,
the QVX format is public and requires a few transformations when exporting data from traditional
data base formats. QVX files are loaded in the script with the load statement.

This file type has no configurable settings.

File Wizard: Transform

In the Transform dialog it is possible to filter and make advanced transformations of a table. This is
particularly important for HTML table, since there is no commonly used standard for how to store
datain HTML. As a result, it is impossible to make QlikView capable of reading HTML tables as
easily as other more structured data formats.

In order to reach the Transform dialogs, enable the transformation step by clicking the Enable
Transformation Step button. The step is not enabled by default in order to save memory.

The Transform dialog provides a variety of filters that can be used to make tables more suitable for
QlikView. The dialog has six pages that are described below. The buttons to the bottom left-hand
corner of Transform Table dialog are however used for all pages:

Transform universal buttons

Button Description

Undo Undoes the last added change.
Redo Redoes the last Undo.
Reset Resets the table to its original status.
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Garbage

On the Garbage tab, rows and columns containing garbage can be removed from the table. In
HTML files it is not uncommon to have extra rows and columns that are there just for legibility and
these must of course be removed before loading the data into QlikView.

Columns and rows can both be removed explicitly in which case their indices are stored in the
script. Rows can also be removed using conditional criteria.

Garbage buttons

Button Description
Delete Marked Deletes the highlighted rows and columns.

Conditional Opens the Specify Row Condition dialog where the conditional criteria for
Delete... deletion of rows can be set.

Fill
With the Fill tab it is possible to replace cell values. In most cases certain cells that match a specific

description are replaced with another value from the same column. A common case is that cells are
empty and that the first non-empty cell above contains the relevant value.

Fill buttons

Button Description

Fill... Opens the Fill Cells dialog where it is possible to specify conditions and strategy.

Column

The Column dialog page is used for copying the contents of a column to a new column. The copy
may contain all the cells of the source column or just a selection of the cells. This feature can be
useful if a column contains different kinds of values. It can also be used to duplicate a column that
contains HTML links so that one column contains the link text, whereas the other column contains
its URL.

Column buttons
Button Description

New... Opens the Specify cells for new column dialog where it is possible to specify how
the new column should be created.

Label Sets the label for the column.

Context

In an HTML table more information than what is visible can be stored, e.g. in the case that the
content of a cell is clickable, the address to where the browser should jump must also be stored.
The Transform page will show the text of the cell, but is also able to show the additional
information belonging to the cells. Naturally, it is also possible to read this information into QlikView.
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Tags always enclose the additional information. A tag has a name and may have attributes, which
sometimes have values. The context of a cell may look like this:

Example:

<A href=www.myurl.com/mypage.html name="MyName”>
My link text
</A>

The visible text of the cell is My link text. The context contains a start tag and an end tag. The
tags specify a hypertext link. The start tag has two attributes, href and name.

The Context page can be used to read the attribute of tags instead of the main string. Other kinds
of operations are also possible. Right-click the cells in the wizard and choose View context to look
at the context of the cell.

Context buttons

Button Description

Expand... Opens the Context cell expansion dialog in which you can define an expansion
of the contents of one cell into several cells. Note that both a column and a row
must be marked in order for this button to be enabled. However, all the cells in the
column will be expanded.

Interpret... Opens the Context interpretation dialog in which an interpretation of the
contents of the cells can be defined. Note that both a column and a row must be
marked in order for this button to be enabled. However, all the cells in the column
will be interpreted.

Unwrap

On the Unwrap tab it is possible to straighten out a wrapped table. Wrapped here means that a
second part of the table continues, not below as it should, but beside the first part of the table. In
the example above, the right half will thus be moved and put below the left half.

Unwrap buttons
Button Description

Unwrap Unwraps the table. The border between the two halves must be set with the
cursor first. It is possible to split the table either vertically or horizontally.

Conditional Defines the condition for a vertical split of the table. Opens the Specify Row
Unwrap... Condition dialog.
Rotate

Web designers often rotate tables to give them a nicer look. The main intention of the rotation
feature is to make it possible to turn tables "back to normal", i.e. to get fields as columns, field
names on the first row etc.
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Rotate buttons

Button Description
Left Rotates the table counterclockwise.
Right Rotates the table clockwise.

Transpose Transposes the table, i.e. mirrors the table along a diagonal axis, so that the top
right cell becomes the bottom left cell and vice versa. The top left and bottom
right cells, however, stay in place.

Fill Cells
Fill Cells fields
Field Description
Specification In the Specification group it is possible to specify in what cases the cell should

be filled.
Target Column = Sets the column number on which the condition should be applied.
Cell Condition  Opens the Cell Condition dialog where it is possible to set the cell condition.

Fill Type Sets the strategy for how cells should be filled. Use one of the values Above,
Left, Right or Below.

Cell Condition

The Cell Condition dialog opens from the Fill Cells dialog and offers a possibility to specify a
logical condition that refers to the contents of a cell.

e Cell Value: There are several logical options in the drop-down menu. To compare strings,
enter a string to be compared in the field after. To compare the length of the cell contents,
enter the comparison length (a numeric value) to the far right.

« Not: Activate this option if the condition should be reversed using a logical NOT.
» Case Sensitive: Activate this option if the value comparison should be case sensitive.

Specify cells for new column

The Specify cells for new column dialog is used for specifying the conditions for automatically
generating a new column from an existing one. It is accessed from the Column page in the File
Wizard : Transform dialog.

e Cells and Columns:
» Source Column: Sets the column number from which cell values should be copied.

» Cells from these rows: Opens the Specify Row Condition dialog where it is possible
to set the row condition.

e Target Column: Specifies the number of the target columns.
» Advanced Options:

« Replace Null Value with Previous Value: Fills empty cells with the value in the cell
above.
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» Delete Source Row: Deletes the source row after copying its content.

Specify Row Condition

The Specify Row Condition dialog can be opened via the File Wizard : Transform dialog's
Garbage page (the Conditional Delete button), the Column page (the New... button) or the
Unwrap page (the Conditional Unwrap button). Here it is possible to define a logical condition for
selection of one or several rows. Depending on the context the rows that are defined are either
deleted, copied to a new column and split the table in several parts.

In the Condition group it is possible to specify a condition where a column equals a specific value or
another column, a range of records or all records. Several conditions can be applied together. After
defining a condition press the Add button to include it in the transformation.

« Compare with value: Matches the cell with a cell condition that can evaluate to true or false.
« Compare with column: Matches the cell with the corresponding cell in another column.

* Range: Selects x rows, then skips y rows. Starting and ending positions for this may be
specified with indexes.

» All Rows: Use this condition if all rows should be selected.
¢ Column: Sets the column number on which the condition should be applied.

« From: Only visible in Range mode. Sets the row number from which rows should be deleted
or a second condition should be applied.

e To: Only visible in Range mode. Sets the row number to which rows should be deleted or a
second condition should be applied.

» Select: Only visible in Range mode. Here it is possible to set whether rows should be
selected or skipped cyclically, e.qg. cyclically select two rows, then skip one. If all rows should
be used, Select should be set to 1 and Skip should be set to 0.

» Options: In this subgroup it is possible to specify modifiers for the selection.
o Case Sensitive: Enable this option if comparisons should be case sensitive.
° Not: Enable this option if the selection criteria should be inverted.

» Conditions (AND): In this group the conditions specified and included in the transformation
are seen. A logical AND is applied between conditions.

o Add: Adds the current condition to the list.
° Remove: Removes a selected condition from the list.

File Wizard: Options

File Parameters
File parameter settings
Setting Description
Labels If the field names (column headers) are stored in the first line of the table, this
control should be set to Embedded. The DIF format also allows field names to be

explicitly specified, and if that is the case, this control should be set to Explicit. If the
table contains no field names, the None alternative should be used.
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Clauses
Clauses settings

Setting Description

Where... Opens the Where Clause dialog, with which is possible to create a where clause for
the load statement.

Clear Revokes the transformation and/or the where clause of a cross table.

Prefixes
Prefix settings
Setting Description

Crosstable Opens the Crosstable dialog where it is possible to set the parameters for a
transformation of a cross table into a three- (or more) column table.

Hierarchy... Opens the Hierarchy Parameters dialog, where it is possible to set the
parameters for a hierarchy table (parameters as they appear in the script in
parentheses).

Clear Revokes the transformation of a cross table or a hierarchy table.

Note that if both a cross table transformation and a where clause are used, the where clause is
evaluated first. It is thus not possible to first transform from a cross table and then apply a where
clause. However, if there is a need to apply a where clause on an already transformed table, a
construction with a temporary table will solve the problem:

TempTable: Crosstable (.) Load .. from ..;
RealTable: Load .. resident TempTable where ..;
Drop Table TempTable;

Context cell expansion

With this dialog it is possible to expand the contents of one cell into several cells. In some situations
several rows in a column are stored within one cell of the HTML table, i.e. between the <TD> and the
</TD> tags. This cell can then be expanded into a column. Just mark the tag that is used as
delimiter between the different rows within the column. Usually this is the <BR> symbol.

* Cells to Insert: Number of cells to insert. Normally this should be set to 1, but if extra rows
are needed, this control can be set to a higher number.

* Row Condition: Condition for what rows to expand.

Context interpretation

With the Context interpretation dialog it is possible to exchange the value of a cell with a piece of
hidden information found in the cell.

The cell can contain several other tags, each with one, sometimes several, attributes. By selecting
the appropriate tag and attribute and then pressing OK, the cell content is replaced with that of the
value of the attribute.
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» Tag: Alist of the tags found in the cell.
« Attribute: The attribute of the marked tag.
 Attribute: The value of the attribute.

Crosstable Wizard

The crosstable wizard is dialog driven method of creating the Crosstable statement. This dialog is
opened by clicking the Crosstable button in the Options page of the File Wizard.

The crosstable wizard holds the following options:

» Qualifier Fields: The number of qualifier fields that precede the fields to be transformed.

« Attribute Field: The name of the new field that will contain all the fields (attribute values) to
be transformed.

« Data Field: The name of the new field that will contain the data of the attribute values.

Where Clause

» Simple: Choose what Field(s) should be part of the where clause and what
Operator/Function should be used. It is also possible to enter a Constant based on existing
field values. The second and third rows become active when selecting AND or OR in the
drop-down list to the left of each row.

» Advanced: Mark Advanced to type the clause from scratch.

« Empty Template: This option will insert Where (1=1) into the script and it is possible to edit
it further there.

Hierarchy Parameters

Source Parameters
« ID Field (NodelD): The name of the field that contains the node id.

» Parent ID Field (Parent/D): The name of the field that contains the node id of the parent
node.

+« Name Field (NodeName): The name of the field that contains the name of the node.

Hierarchy Parameters

+ Parent Name (ParentName): The name of the new ParentName field. Optional parameter.

+ Path Name(PathName): The name of the new Path field, which contains the path from the
root to the node. Optional parameter.

« Depth Name (Depth): The string used to name the new Depth field, which contains the
depth of the node in the hierarchy. Optional parameter.

« Path Source (PathSource): The name of the field that contains the name of the node used
to build the node path. Optional parameter. If omitted NodeName will be used.

» Path Delimiter (PathDelimiter): The string used as delimiter in the new Path field, e.g. \.
Optional parameter. If omitted ‘/’ will be used.

Working with QlikView - QlikView, May 2024 113



5 Navigate the user interface

Belongs To Parameters
» Ancestor ID (AncestoriD): The name of the new ancestor id field, which contains the id of
the ancestor node.

* Ancestor Name (AncestorName): The name of the new ancestor field, which contains the
name of the ancestor node.

» Depth Diff Name (DepthDiff): The name of the new DepthDiff field, which contains the
depth of the node in the hierarchy relative the ancestor node. Optional parameter.

File Wizard: Script

Max Line Length

1 = Load All (*)
LOAD Ruthor,

Title,

Genre
FROM
{ooxml, embedded labels, table is Sheetl);

[
< Back Mext = | Einish | | Cancel | | Help |

The Script page makes it possible to set how the script should be presented in the Edit Script
dialog. Here it is also possible to set a Max Line Lengh to make the script easier to interpret.

Load All (*) loads all fields in the table.

The Finish button generates the load statement and closes the wizard.

Debugger

Running the script in the debugger can make it a lot easier to identify script errors. The debugger
makes it possible to monitor every script statement and examine the variable values while the script
is executed.

You launch the debugger by clicking the Debug button in the top menu of the Edit Script window.

The script is displayed in the window in the upper half of the debugger. The progress of the script
execution is marked with a yellow bar. Break points can be inserted by clicking on the row numbers
and removed by clicking a second time. Remove all breakpoints by clicking the Clear button. When
a breakpoint is encountered, script execution is halted until instructed to proceed.

The statement being currently executed is displayed in the window in the middle.

Status codes and any script errors are displayed in the window to the bottom, left. This is
essentially the same information that is displayed in the Script Execution Progress window when
the script is run outside the debugger.
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The right bottom window displays all script variables and their respective values. Variables that
have changed are colored red.

Debugger options
Option Description

Breakpoints Breakpoints that have been set in the script window to the right can be cleared.
A breakpoint is shown as a red circle.

¢ Clear: Clears all the breakpoints.

Debug This group contains settings that determine how the script is run in the
Debugger.

* Run: This is the normal script execution. The script will progress to the
end or until a breakpoint is encountered.

* Animate: The script runs as above, but with a short pause after each
statement. This way it is possible to monitor the script execution more
closely.

» Step: This executes one script statement at a time.

Limited Load Enter a number in the spinner box below. The number entered is the maximum

number of accepted records at each load and select statement. This is a very
useful way to limit the execution time when the script is tested with live data.

Help Opens the QlikView help.

End Here Closes the Debugger, but keeps the data loaded so far.

Cancel Aborts the script execution and discards all data loaded.

Buffers Opens tabs displaying external script files referenced via $(include).

* Open: Displays a dialog from which a script file can be opened. The
contents of the file will be displayed under a separate tab and can be
used for debugging.

* Close: Closes the current debugger script tab. The main tab cannot be
closed.

5.5 Variable Overview Dialog

The Variable Overview dialog displays all non-hidden variables and their values in a single list.
Together with the dollar-sign expansions feature in QlikView expressions, the variable overview
may be used as a crude expression repository.

» Variables: In this four-column list the names of all non-hidden variables and their respective
values are displayed. Select the check-box in the + column to include variables in
bookmarks.
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» Definition: Highlight a variable in the list above to display its definition. The text may be
freely edited. The changes willimmediately be reflected in the Value column of the list
above. Click on the ... button to open the Edit Expression dialog.

+ Comment: A commentary field where the creator of a variable can describe the purpose and
function of a variable.

» Add: Opens the New Variable dialog, where a new variable can be defined.

+ Remove: Highlight a variable in the list and click this button to delete a variable.

e Search: Search the available variables by name.

5.6 Edit Expression Dialog

The Edit Expression dialog is opened by selecting the Add button below the expressions list in
Chart Properties: Expressions or by right-clicking an existing expression and selecting Add
Expression or Edit Expression.

Though itis primarily used in chart expressions, the same dialog is also utilized for building or
editing other expressions wherever expressions are needed. It is universally accessed by clicking
the button with the three dots symbol that can be found next to text edit boxes throughout the
program.

The main parts of the dialog are made up of the Expression edit area that can be resized to
accommodate large expressions and beneath this, the tab area consisting of the four tabs Fields,
Functions, Variables and Images.

Writing expressions

You can type in the whole expression in the edit area for the selected expression, but it is often
convenient to do most of the expression building in the tab area described below. The expression
needs to start with =.

The label Expression OK is only displayed as long as the expression syntax is accepted by the
program, i.e. while the expression is valid. Otherwise the label will display one of several error
messages (Bad fieldname(s), Error in expression, Garbage after expression). There is little point
in leaving the dialog by clicking the OK button, unless the expression is valid.

Expression tab options

The Edit Expression dialog tabs contain the following options for building expressions.

Fields

The Fields tab holds controls that are used for creating statistical aggregation functions based on
field data.
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Option
Aggregation

Table

Field

Show System
Fields

Distinct

Paste

Functions

Fields options

Description

The first drop down contains a list of available statistical aggregation functions.
(The functions First String and Last String can e.g. be used for showing text in
a pivot table.)

This drop-down list allows you to limit the fields displayed in the Field list below
to one specific internal table.

This drop down contains a list of available field names.

MEASURE fields can only be used with basic aggregation functions Sum, Avg,
Count, Min, and Max.

Check this alternative in order to include the system fields in the Field list.

Statistical functions are by default calculated on number of occurrences. By
checking the Distinct option, the expression will be calculated without
duplicate values.

Click this button in order to enter your selections as a component of the
expression.

The Functions tab holds controls that are used for entering general QlikView-functions into the

expression.

Option

Function
Category

Function
Name

Paste

Variables

Functions options

Description

This drop-down list allows you to limit the functions displayed in the Function
Name list below to a single category at a time.

This drop down contains a list of all available QlikView-functions (except a limited
number of dedicated script functions).

The pane at the bottom of the functions tab displays the argument syntax of the
selected function.

Click this button in order to enter your selections as a component of the
expression.

The Variables tab holds controls that are used for entering QlikView-variables into the expression.
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Variables options

Option Description

Variables This drop down contains a list of all variables currently defined for the
document.

Show System Check this alternative in order to include the system variables in the

Variables Variables list.

Paste Click this button in order to enter your selections as a component of the
expression.

At the bottom of the Variables tab is a pane displaying the current value of any variable selected in
the Variables list.

Images

The Images tab holds controls that are used for accessing the internal files that are available in
QlikView. It is also possible to access other associated image files. Note that this functionality is
limited to certain parts of the layout. To the right in the Images tab is a pane displaying the currently
selected image.

Images options

Option Description

Image Folder  This drop down contains a list of available image folders.

Image This drop down contains a list of available images in the selected folder.

Advanced... Click this button to select directly from the pictures in the Image Selector
dialog.

Paste Click this button in order to enter your selections as a component of the
expression.

Edit Expression menu options

In addition, the Edit Expression dialog contains the following menu commands and buttons.

File Menu
File Menu options
Option Description
Export to It is possible to save the contents of the Expression edit box as a table file by

Expression means of the Export to Expressions File command. The file is saved with the
File... extension .qve.

Insert File... A previously created expression file can be inserted into the script by means of
the Insert File... command.
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Option Description

Colormix A color mix expression can be created using the Colormix wizard.
Wizard...

Print Opens Windows standard Print dialog for printing the expressions. This

command can also be invoked by the following keyboard shortcut: Ctrl+P.

Edit Menu
Edit Menu options

Option Description

Undo Undoes the latest change. This command can also be invoked by the
following keyboard shortcut: Ctri+Z.

Redo Redoes the latest Undo. This command can also be invoked by the following
keyboard shortcut: Ctrl+Y.

Cut Exports the highlighted text to the clipboard. This command can also be
invoked by the following keyboard shortcut: Ctrl+X.

Copy Copies the highlighted text to the clipboard. This command can also be
invoked by the following keyboard shortcut: Ctrl+C.

Paste Pastes the contents of the clipboard into the dialog at the position of the
cursor. This command can also be invoked by the following keyboard
shortcut: Ctrl+V.

Clear Clears the entire expression.

Select All Selects the entire expression.

Find/Replace... Opens a dialog where it's possible to find and replace numbers or characters

in the expression. This command can also be invoked by the following
keyboard shortcut: Ctrl+F.

Settings Menu
Settings Menu options

Option Description

Configure... Opens User Preferences: Editor.

Colormix Wizard

With the Colormix Wizard, opened from the File menu in the Edit Expression dialog, it is possible
to create a colormix expression, i.e. an expression that calculates a dynamic color from a given
measure.

It could e.g. be a calculated index with a value around 100 displayed in a pivot table. The higher
index, the better. If a specific dimension value had an index that vastly exceeded 100, one would
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probably want to mark this pivot table line green, whereas red probably would be the appropriate
color if the index value was much lower than 100. And one would want the color change to be
gradual with yellow denoting 100. In other words — you want a dynamic color.

Such a gradual color calculation can be done with the Colormix functions in QlikView, but it can be
cumbersome to create the appropriate expression inside the Colormix function. Here, the Colormix
wizard can help.

First, it is important to clarify that the color functions, hence also the Colormix Wizard, are only
relevant to use in place where QlikView expects a color function, i.e. not in the chart expression
itself, but rather in the Background Color expression or in the Text Color expression.

When you open the Colormix Wizard from the File menu in the Edit Expression dialog, you will first
see a page describing what is needed to create a dynamic color. If you want to skip the start page
when you use the wizard in the future, mark the Don’t show this page again check box.

Click Next to continue.

Step 1-Enter a Value Expression

This is the expression that will control what color QlikView will show. Typical expressions could be
e Sum(Sales) / Sum(total Sales)
e Sum(Sales) / Sum(Quota)

e Avg (Age)

Note that it is usually a value that has the same order of magnitude no matter how many or how few
records that you have selected. An average, a percentage or an index is usually a good measure to
use.

Click Next to continue.

Step 2 - Set Upper and Lower Limits

In this page you need to define the upper and lower limits of the value expressions and the
corresponding colors. "Limit” meaning not the maximum possible value, but the limit where the
maximum color is reached. Typical expressions could e.g. be:

Example expression properties
Value Expression Upper Limit Lower Limit
Sum(Sales) / Sum(total Sales) Sum(total Sales) O
Sum(Sales) / Sum(Quota) 2 (=200%) 0
Avg(Age) Max(total Age) Min(total Age)

But other limits are possible.
If you use the color wizard within a chart, then the following two expressions are always a good
choice:

e RangeMax (top(total <ValueExpression>,1,NoOfRows (total)))

¢ RangeMin (top(total <ValueExpression>,1,NoOfRows (total)))

These expressions will calculate the largest and the smallest row value of <ValueExpression>
within the chart.
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Auto Normalize:If this check box is marked, QlikView will try to find proper upper and lower
limits. In such a case, expressions for the upper and lower levels cannot be entered manually.

Upper Limit: Here an expression for an upper limit must be entered, unless the Auto
Normalize option is checked.

Intermediate: Here it is possible to enter an expression for an intermediate level, linked to a
third color.

Lower Limit:Here an expression for a lower limit must be entered, unless the Auto Normalize
option is checked.

Reverse: This button reverses the colors for the upper and lower limits.

Click Next to continue.

Step 3 - Finalize

In this page you finalize the color mix expression.

5.7

Enhanced Colors:If this check box is marked, a hysteresis transformation is applied on top of
the value expression. This will increase the sensitivity in the mid-range so that the color is
pushed towards the Upper and Lower colors.

Value Saturation: Here it is possible to control the behavior if the value expression exceeds
the upper or lower limit. If Use Upper (Lower) Color is marked, QlikView will use the color for
the maximum or the minimum. If Use Standard Color is marked, QlikView will instead revert
to the standard colors as defined on the Colors page.

Expression Overview

This dialog shows all document, sheet and sheet object expressions in a single list. From this list
you may edit single expressions or do Find/Replace on multiple expressions. Select one or more
expressions from the list. A selected line appears in black. Click below the last expression to
deselect it.

In the top left hand corner of the dialog you can select more than one check box.

Chart Expressions
Chart Attributes
Color Expressions
Show Conditions
Other Expressions

Expression commands

Command Description

Columns... Opens the Columns dialog where you may customize which columns should

appear in the Expression Overview dialog. The Expression column cannot
be turned off.
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Command

Find/Replace...

Export...

Apply

Edit...

Description

Opens the Find/Replace dialog where you may search for and replace
specific text within the current list of expressions. It is also possible to make
multiple or bulk changes to the expressions.

Use this button to export the table below to a text file.

Applies changes made in the list back to the properties of the document,
sheets and sheet objects, without leaving the dialog. After using this
command changes made so far will remain even if you use Cancel to leave
the dialog.

After selecting a single expression in the list you may use this button to open
the Edit Expression dialog for the selected expression.

The expression list in the lower part of the dialog may contain the following columns, based on
settings in the Columns dialog (see below) :

Column

Sheet ID

Sheet Name

Object ID

Object Name

Location
Label
Location

(Full)

Expression

Expression columns

Description

The sheet ID of the sheet where the expression occurs. Empty for document
expressions.

The name (tab title) of the sheet where the expression occurs. Empty for
document expressions.

The sheet object ID of the sheet object where the expression occurs. Empty for
document and sheet expressions.

The name of the object where the expression occurs.

The location of the expression within properties with 'friendly name', i.e. a simple
explanation of the type of expression.

The label of the main expression of the object.

The exact location of the expression within the properties structure. The notation
corresponds to the object property hierarchies of the QlikView Automation
interface, which is explained in detail in the QlikView API Guide.

The expression definition.

Changes made from this dialog can be undone by the regular Undo command.

5.8

Server Objects Pane

The Server Objects Pane offers an easy way for end-users to manage their own server sheet
objects and access other users' shared objects.

Working with QlikView - QlikView, May 2024

122



5 Navigate the user interface

Configuring the Pane

The Server Objects Pane can be toggled on and off via the Server Objects command on the View
menu or by pressing F2. The pane can be moved and docked to any side of the QlikView application
window. It can also be left free-floating next to the QlikView window.

The Server Objects Pane can be left on when working with local documents (non server-based)
but then has no function.

The Server Objects Pane contains two areas. The My Objects area lists your own personal server
objects for the active server document. The Shared Objects area lists all shared sheet objects
(including your own shared objects) linked to the current server document.

To hide an object in the QlikView application window, right-click the object and choose Remove. In
order to show the object in the layout again, you must drag the object from the Server Objects
pane.

When hovering over an object, a pop-up is shown containing information about the name of the
object, the object type, owner and latest modification date.

Shared Objects

Here the shared objects are shown. They can be grouped differently according to Type, Owner and
Date. Change the grouping by clicking on the arrowhead next to Shared Objects. The list can be
expanded to show more information about each object or compressed to save space. Click on the
arrowhead next to the object to expand, click again to compress.

Those objects shown in the layout are marked by a check in the My Objects and Shared Objects
areas.

To use someone else's shared object you must drag it to the application window.

Adding and Sharing Objects

When you create a new server sheet object it will automatically be added to the My Objects list.

To share one of your own server objects to other users, right-click the object in the My Objects
area and choose Share with Everyone or Share Permissions.... This opens the Sharing dialog.

Sharing

In the Sharing dialog you can configure how the object should be shared. To share an object
choose one of the options in the Share Permissions drop-down menu.

« Do not share: The object is not shared with any users.
» Share with everybody: The object is shared with all users.
» Share by username: The object is shared with the users that are listed below.

The object will appear in the Shared Objects area but also remain in the My Objects area, now
marked with a small hand to indicate its shared status.
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To unshare an object which you have previously shared, right-click the object in the My Objects
area, choose Unshare or Share Permissions again to open the Sharing dialog and then choose Do
not share in the drop-down Share Permissions. The object will disappear from the Shared
Objects list and no longer be available for other users. Note that it will however not disappear from
other users' active sessions.

5.9 Exporting and Printing

Print: General

On the General tab you may specify settings relating to the printer and paper. Additional printout
settings can be made on the other tabs.

In the Printer group available printers are listed in a drop-down list. You can access the printer
Properties by clicking this button.

In the Paper group selections of paper Size and Source (tray) are made.

Other options in this property page allow you to change the paper Orientation, specify the Page
Range to be printed and specify the Number of Copies and if you want to Collate Copies.

The Size group offers three different scaling options:

e Scale to _ %: Check this option and enter a percentage number to increase or decrease the
scale of the printout.

< Fit to 1x1 Pages: Check this option to have the printout scaled to the paper size. You may get
a better result if you change the Orientation.

» Fitto_x _Pages: Check this option to have the printout scaled to the specified number of
pages.

If you arrived at the Print dialog by using the command File: Print Sheet, the Size group
will not be available, but be replaced by the Sheet options group where you can
determine if you want to print just This Sheet or All Sheets, and if you want the printout
to Draw Background (wallpaper).

The following buttons are also available:
Print General buttons
Button Description

Save Click this button to save your settings for header and footer while you continue
Settings working with this dialog.

Print This button opens a window showing a detailed preview of the current, printable
Preview object.
Print Click this button to effect the print command and close this dialog.
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Print: Layout

On the Layout tab settings for Print Selection Stamp and Margins can be made. Additional
printout settings can be made on the other tabs.

» Print Selection Stamp: In the Print Selection Stamp group, the option to include the

relevant current selections (i.e. current selections that affect the current object) in the
printout is possible. The text "Selection status" will be displayed in the printout, followed by a
list of fields and field values. The following options determine on what pages the Current
Selections will be included: On First Page, On All Pages - Top of Pages, On All Pages -
Bottom of Pages and On Last Page.

Heading Text: In the edit box specify a text to be printed before the printed sheet object.
This text may be a calculated expression. By clicking on the ... button the Edit Expression
dialog opens for easier editing of long formulas. The Font button next to the edit box allows
the selection of a separate font for the text. This is not supported when using the AJAX
client.

Trailing Text: In the edit box specify a text to be printed after the printed sheet object. This
text may be a calculated expression. By clicking on the ... button the Edit Expression dialog
opens for easier editing of long formulas. The Font button next to the edit box allows the
selection of a separate font for the text. This is not supported when using the AJAX client.
Margins: In the Margins group you can define the margins around the printed object.
Changes can be seen in the preview pane at the right of the Print dialog. Measurements are
inmm, cm or ". The default unit is set in the User Preferences: Design page.
» Top: Specifies the distance between the top of the paper and the upper border of the
printed object.
» Header: The Header value is the distance between the header text and the top of the
paper. For the header text to appear this value must be smaller than Top.

» Left: Specifies the distance between the left edge of the paper and the left border of
the printed object.

» Right: Specifies the distance between the right edge of the paper and the right border
of the printed object.

» Bottom: Specifies the distance between the bottom of the paper and the lower border
of the printed object.

+ Footer: The Footer value is the distance between the footer text and the bottom of
the paper. For the footer text to appear this value must be smaller than Bottom

The following buttons are also available:

Save Settings: Click this button to save your layout settings while you continue working with
this dialog.

Print Preview: This button opens a window showing a detailed preview of the current,
printable object.

Print: Click this button to effect the print command and close this dialog.
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Print: Header/Footer

On the Header/Footer tab you may specify settings for Header and Footer. Additional printout
settings can be made on the other tabs.

The following buttons are used for inserting control codes for specific system information into any
of the text panes. Control codes may also be typed directly:

Button
Page

Pages

Date

Time

File
Sheet

Title

Picture

Report

Header/Footer buttons/codes

Description
Click this button or enter the code &[Page] to insert the page number.

Click this button or enter the code &[Pages] to insert the total number of
pages. The use of this option in reports with banding may cause long
delays for calculation before printing can commence. You will therefore be
warned when this situation occurs.

Click this button or enter the code &[Date] to insert the current date. Date
format can be set in the Date & Time dialog.

Click this button or enter the code &[Time] to insert the current time. Time
format can be set in the Date & Time dialog.

Click this button or enter the code &[File] to insert the filename.

Click this button or enter the code &[Sheet] to insert the name of the
sheet. This option is not available when printing reports.

Click this button or enter the code &[Title] to insert the caption title of the
printed object. This option is not available when printing reports.

Click this button to import a picture from the Select Image dialog. The
picture will be printed as graphics in the header or footer pane. You may
also manually enter the code &[Picture=filename] where filename is the
complete filename and path of the file containing the graphics.

Pressing this button or entering the code &[Report] causes the title of the
report to be printed. This option is only available when printing reports.

The Header and Footer groups allow the above settings to three panes: Left section, Center
section and Right section. Simply click in the desired pane to position the cursor and then click a
button or type in the code.

The following buttons are also available:

Button

Font

More header/footer buttons

Description

This button opens the Font dialog.
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Button Description

Date & This button opens the Date & Time dialog.

Time

Default Click this button to reset the default settings for header and footer.

Save Click this button to save your settings for header and footer while you continue

Settings working with this dialog.

Print This button opens a window showing a detailed preview of the current, printable
Preview object.
Print Click this button to effect the print command and close this dialog.

Print Options: Date and Time

Here the preferred display of date and time can be set.

Option

Use System
Default

Current Settings
Date
Date Separator

Time

Print Sheet

Date and time options

Description

Enable this option to apply the system (e.g. Windows) time and date
formats.

A view of the current date and time format.
The date format can be set here. Select format from the drop down list.
Choose the character to be used as date separator.

In the Time group settings for the time format can be set.
24h

Enable this option to show time in the 24 hour notation.
12h

Enable this option to show time in the 12 hour notation.
Time Separator

Choose the character to be used as time separator.
Show Seconds

Enable this option to show seconds in the time format.

To open this dialog, choose Print Sheet from the File menu. This dialog is identical to the general
Print dialog with one exception: the Size group on the General page which is here replaced by
another group, Sheet Options.

Sheet Options

The Sheet Options group contains the following settings:
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Sheet settings

Setting Description

This Sheet By selecting this option only the current sheet will be printed.

All Sheets By selecting this option all sheets in the document will be printed.
Draw Mark this check box to include the sheet background (wallpaper) when
Background printing.

Print Preview

Use the preview feature when you want a detailed print preview to see how a printable sheet object
will appear in the printout. The magnifying glass toggles the display between the preview size
where you see the whole page and the actual 100% size.

Print Preview options
Option Description

Print Transfers control to the Print: General dialog, from where you can print the
active object.

#pages drop- This drop-down menu offers a quick way to change which pages to display in
down the preview.

Previous If the preview contains several pages, you can click this button to view the
previously shown page.

Next If the preview contains several pages, you can click this button to view the next
page.

Add Page Extends the preview to include another page if the active object does not fit in
one page.

Remove Page  Removes the current preview page.

Close Closes this dialog.
Help Opens QlikView help.
Copy Mode

Switches from logic mode to copy mode. In copy mode the clicked values are copied to the
Clipboard without changing the logical state of the running QlikView document. When copy mode is
on, the Clipboard Copy List dialog opens. In this dialog you build a list of values to be copied.

Clipboard Copy List

The Clipboard Copy List dialog opens from Copy Mode) in the Edit menu. This dialog simplifies
copying to the clipboard. As long as it is open, QlikView will be in copy mode and values clicked will
automatically be copied to the Clipboard Copy List. The QlikView logic is disabled while the
document is in copy mode.
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Clipboard Format

In this group, the format of the copy list is set. Column, Comma Delimited Line and Tab Delimited
Line are the available options.

Quoting
In this group, the quoting for the selected elements can be set.

* Quote with ' will enclose all elements with single quotes. This is useful if the elements copied
are to be pasted into the script as field values.

* Quote with " will enclose all elements with double quotes. This is useful if the elements
copied are to be pasted into the script as field names or into a Visual Basic script, e.g. a
QlikView macro.

« None will leave the elements unquoted.

OK
Closes the Clipboard Copy List dialog and transfers its content to the Windows Clipboard.

Cancel
Closes the Clipboard Copy List dialog without transferring its content to the Windows Clipboard.

Send to Excel

Exports the table to Microsoft Excel, which is automatically launched if not already running. The
table will appear in a new Excel worksheet. For this functionality to work Microsoft Excel 2007 or
later must be installed on the computer.

Default limitations in number of rows and columns

The default maximum number of rows and columns in the Excel export file is:

« 1048566 rows per sheet. For pivot tables: 1048566 column dimensions. 10 rows can be
added after the export.

» 16384 columns per sheet. If the number of columns exceeds the limit, the exported file is
truncated and a warning message is sent.

Export/Export Contents...

Opens the Save As dialog. Here a name, path and file type for the exported data can be specified.

The file can be saved as any of the following formats: Comma Delimited, Semicolon Delimited, Tab
Delimited, Hypertext (HTML), XML and Excel (xIs or xIsx). The default format is *.qvo
(QlikViewOQutput), a tab separated file.

When exporting to a qvo file, the data is exported as it appears in the QlikView
document. When exporting to Excel, the underlying data is exported, but displayed
formatted in Excel.
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5.10 Custom Error Messages

QlikView offers the possibility of customizing error messages in charts and table boxes. The
Custom Error Message dialog is opened via the Error Messages button, which is found on the
General page of the Chart Properties dialog, as well as on the General page of the Table Box
Properties dialog.
« Standard Messages: List of the standard error messages. To customize a message, select it
and type a text of your choice in the Custom Message text box.
« Custom Messages: Here you enter the text to be shown instead of the standard message
selected above. The text may be a calculated formula.
This feature makes it possible to e.g. change a rather cryptic error message (like: Local
heap space exhausted) into a helpful hint for tackling the problem (in this case: Please
make a selection... or: Please increase the allocation of memory / cells by...).
» Apply to All: Click this button to apply the custom messages to all the calculated objects of
the document.

¢ Clear All: Click this button to clear all the custom error messages.
5.11 Keyboard Command Shortcuts
In this chapter you will find a list of the different keyboard command shortcuts available in QlikView.

File Menu Command Shortcuts

File menu command shortcuts

Shortcut Function Icon
Ctrl+N Equivalent to New on the File menu. B
Ctrl+0 Equivalent to Open... on the File menu. =
Ctrl+Shift+O Equivalent to Open in Server... on the File menu. -
Ctrl+S Equivalent to Save on the File menu. =
F12 Equivalent to Save As... on the File menu. -
Ctrl+P Equivalent to Print... on the File menu. =4
Ctrl+Shift+P Equivalent to Print As PDF... on the File menu. T
Ctrl+E Equivalent to Edit Script... on the File menu. &
Ctrl+R Equivalent to Reload on the File menu. B
Ctrl+Shift+R Equivalent to Partial Reload on the File menu. -
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Shortcut Function Icon

Ctrl+T Equivalent to Table Viewer... on the File menu. 23

Edit Menu Command Shortcuts

Edit menu command shortcuts

Shortcut Function Icon
Ctrl+Z Equivalent to Undo Layout Change on the Edit menu. )
Ctrl+Y Equivalent to Redo Layout Change on the Edit menu. s
Ctrl+X Equivalent to Cut on the Edit menu. &%
Ctri+C Equivalent to Copy on the Edit menu. EEY
Ctrl+V Equivalent to Paste on the Edit menu. Fe?
Del Equivalent to Remove on the Edit menu. -
Ctrl+A Equivalent to Activate All on the Edit menu. -
Ctrl+F Equivalent to Search on the Edit menu. @

Ctrl+Shift+F Equivalent to Advanced Search on the Edit menu. -

View Menu Command Shortcuts

View menu command shortcuts

Shortcut Function Icon
Ctrl+Q Equivalent to Current Selections... on the View menu. ¥
Ctrl+G Toggles layout design grid on or off. -

Selections Menu Command Shortcuts

Selections menu command shortcuts

Shortcut Function Icon

Shift+Left arrow  Equivalent to Back on the Selections menu. -

Shift+Right Equivalent to Forward on the Selections menu. -
arrow
Ctrl+Shift+L Equivalent to Lock on the Selections menu (locks all selections). K3
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Shortcut Function Icon

Ctrl+Shift+U Equivalent to Unlock on the Selections menu (unlocks all =
selections).

Ctrl+Shift+D Equivalent to Clear on the Selections menu (clears all selections). K

Settings Menu Command Shortcuts

Settings menu command shortcuts

Shortcut Function Icon
Ctrl+Alt+U Equivalent to User Preferences... on the Settings menu. ﬁ*
Ctrl+Alt+D Equivalent to Document Properties... on the Settings menu. ¢
Ctrl+Alt+S Equivalent to Sheet Properties... on the Settings menu. e
Ctrl+Alt+V Equivalent to Variable Overview... on the Settings menu. =
Ctrl+Alt+E Equivalent to Expression Overview... on the Settings menu -

Bookmarks Menu Command Shortcuts

Bookmarks menu command shortcuts

Shortcut Function Icon
Ctrl+B Equivalent to Add Bookmark... on the Bookmarks menu. =
Ctrl+Shift+B Equivalent to More... on the Bookmarks menu. <%

Tools Menu Command Shortcuts

Tools menu command shortcuts

Shortcut Function Icon
Ctrl+M Equivalent to Edit Module... on the Tools menu. &
Ctrl+Alt+A Equivalent to Alerts... on the Tools menu. ﬁ
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Object Menu Command Shortcuts (List box, Statistics box and
Open Multi Box)

Object menu command shortcuts

Shortcut Function

Ctrl+Shift+L Equivalent to Lock on the Object menu (locks selections in active object).
Ctrl+Shift+U Equivalent to Unlock on the Object menu (unlocks selections in active object).
Ctrl+Shift+D Equivalent to Clear on the Object menu (clears selections in active object).
Alt+Enter Equivalent to Properties... on the Object menu (opens the Properties dialog of

an active object).

Script Keyboard Shortcuts

To see a list of the available keyboard shortcuts in the Script type Ctrl+gsc in the script pane.

Script keyboard shortcuts

Shortcut Function

Ctrl+G Go to line number in the script.
Ctrl+K,C Comment lines in script.
Ctrl+K,U Uncomment lines in script.
Ctrl+Q,T,A Add tab in script.

Ctrl+Q,T,P Promote active tab.

Ctrl+Q,T,D Demote active tab.

Ctrl+Q,T,N Rename active tab.

Ctrl+Q,T,R Remove active tab.

Ctrl+Q,Q Creates an autogenerated script.
Ctrl+Q,U,I Opens Unicode input utility.
Ctrl+Q,J,P,G Creates a script for reading attributes from jpeg files.

Ctrl+Q,M,P,3 Creates a script for reading attributes from mp3 files.

Ctrl+Q,W,M,A Creates a script for reading attributes from wma files.

F Key Keyboard Shortcuts

F key keyboard shortcuts
Shortcut Function

F1 Activates context sensitive help.
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Shortcut
F3

F6

F7

F12
Ctrl+F6
Ctrl+F7

Function

Enters search mode if a searchable object is activated.

Activates the immediate left sheet tab of the currently active tab.
Activates the immediate right sheet tab of the currently active tab.
Equivalent to Save As... on the File menu.

Activates the leftmost sheet tab.

Activates the rightmost sheet tab.
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6 Introduction to loading data

This is a brief introduction on how to load data into QlikView. It provides a background for the topics
in this section, presenting how to perform basic data loading and transformation.

QlikView uses a load script, which is managed in the script editor, to connect to and retrieve data
from various data sources. In the script, the fields and tables to load are specified. It is also possible
to manipulate or transform the data structure by using script statements and expressions.

When the script is executed, QlikView identifies common fields from different tables (key fields) to
associate the data. The resulting data structure of the data in the document can be seenin the
table viewer. Changes to the data structure can be made by renaming fields to obtain different
associations between tables.

You execute the script by clicking the Reload button. After the script execution, the Select fields
dialog opens, where you can choose the fields to display in list boxes on the sheet in QlikView.

After the data has been loaded into QlikView, it is stored in the document. The document is the
heart of the program's functionality and it is characterized by several factors: the unrestricted
manner in which data is associated, its large number of possible dimensions, its speed of analysis
and its compact size. When the document is open, it is held in RAM.

Analysis in QlikView always happens while the document is not directly connected to its data
sources. So, to refresh the data, you need to reload the script.

6.1 Understanding data structures

Data loading statements

Data is loaded by LOAD or SELECT statements. Each of these statements generates an internal
table. A table can always be seen as a list of something, each record (row) then being a new
instance of the object type and each field (column) being a specific attribute or property of the
object.

Rules

The following rules apply when loading data into QlikView:

« QlikView does not make any difference between tables generated by a LOAD or a SELECT
statement. This means that if several tables are loaded, it does not matter whether the tables
are loaded by LOAD or SELECT statements or by a mix of the two.

» The order of the fields in the statement or in the original table in the database is arbitrary to
the QlikView logic.

» Field names are used in the further process to identify fields and making associations. These
are case sensitive, which often makes it necessary to rename fields in the script.

Execution of the script
For a typical LOAD or SELECT statement the order of events is roughly as follows:
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Evaluation of expressions

Renaming of fields by as

Renaming of fields by alias
Qualification of field names

Mapping of data if field name matches

o gk W N -

Storing data in an internal table

Fields

Fields are the primary data-carrying entities in QlikView. A field typically contains a number of
values, called field values. In database terminology we say that the data processed by QlikView
comes from data files. A file is composed of several fields where each data entry is a record. The
terms file, field and record are equivalent to table, column and row respectively. The QlikView AQL
logic works only on the fields and their field values.

Field data is retrieved by script via LOAD, SELECT or Binary statements. The only way of changing
datain a field is by re-executing the script. The actual field values can not be manipulated by the
user from the layout or by means of automation. Once read into QlikView they can only be viewed
and used for logical selections and calculations.

Field values consist of numeric or alphanumeric (text) data. Numeric values actually have dual
values, the numeric value and its current, formatted text representation. Only the latter is displayed
in sheet objects etc.

The content of a field can be represented in a list box.

Field tags

Field tags provide the possibility of adding metadata to the fields in your data model. There are two
different types of field tags:

» System field tags
System field tags are generated automatically when the script is executed and data is
loaded. Some of the tags can be manipulated in the script. System tags are always preceded
by a $ sign.

» Custom field tags
You can add custom tags to fields in the load script, using the Tag statement. Custom tags
may not use the same name as any system tag.

System field tags
The following system field tags are generated at the end of script execution.
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System field tags

Can be
Tag Description manipulated in
the script
$system System field that is generated by QlikView during script No
execution.
$key Key field providing a link between two or more tables. No
$keypart The field is part of one or more synthetic keys. No
$syn Synthetic key No
$hidden Hidden field, that is, it is not displayed in any field selection Yes
list when creating charts, dimensions or measures. You can
still use hidden fields in expressions, but you need to type the
field name.
You can use the HidePrefix and HideSuffix system variables
to set which fields to hide.
$numeric All (non-NULL) values in the field are numeric Yes
$integer All (non-NULL) values in the field are integers. Yes
$text No values in the field are numeric. Yes
$ascii Field values contain only standard ASCII characters. Yes
$date All (non-NULL) values in the field can be interpreted as dates  Yes

(integers).

$timestamp All (non-NULL) values in the field can be interpreted as time Yes
stamps.

The following tags are set in the Document Properties: Tables (page 242) dialog and can be
enabled and disabled by the user:

» $dimension - denotes a field recommended for use in chart dimensions, list boxes, etc.
» $measure - denotes a field recommended for use in expressions.

System fields

In addition to the fields extracted from the data source, system fields are also produced by
QlikView. These all begin with "$" and can be displayed in list boxes much like ordinary fields.
System fields are typically created during script execution, are primarily used as an aid in document
design.

Displaying System Fields

Perform the following steps:
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1. Right-click on the sheet and select System Fields.
2. Check the Show System Fields box.

The system fields are now available as any other fields.

Available System Fields

The following system fields can be displayed:
System fields
Field Description

$Table Displays all internal tables loaded by the script. When a single table is selected, an
information symbol will activate in the caption area of the list box. By clicking
here, itis possible to view the table, if it comes from a file.

$Field Displays the fields that are read from the tables. By setting this list box to Show
Frequency in the List Box Properties: General page, it is simple to detect key
fields that occur in several internal tables.

$Fields The numbers in this list box represent the number of fields in different tables.

$FieldNo This list box shows the position of the fields in the tables.

$Rows This list box shows the number of rows in the tables.
$info If info tables have been included in the document, their names will be displayed
here.

System Table

QlikView can automatically create a pivot table that makes use of the system fields.The table is
called System Table and contains the two dimensions $Field and $Table and the expression
only([$Field]). The system table is sorted according to frequency by default. The system table
object is not available for the QlikView Server clients (AJAX and Plugin clients).

Creating a System Table

Perform the following steps:
1. Right-click on the sheet and select New Sheet Object.
2. Select System Table.

Input fields

QlikView supports a special type of field which can be changed without script execution, the input
field.

An input field is just like any other field in QlikView, with the difference that its values, as read in the
script, can later be changed without running the script again. Input fields can be used like any other
fields in all types of sheet objects.

When using input fields, the script creates placeholders for each field value, which can later be
edited to contain new data. Any field can be turned into an input field by listing it in an inputfield
statement in the script before it appears in a LOAD or SELECT statement.
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Values of an input field can be changed in list box cells, table box cells and in table chart expression
cells. Only list boxes and table columns which contain input fields are editable. By hovering over an
editable cell it is possible to see an input icon. Clicking on the icon sets the cell in input edit mode. It
is possible to use up/down arrow keys to move between cells while staying in input edit mode. The
entire QlikView document will automatically recalculate whenever new values are entered.

A table chart expression cell may contain a special input field aggregation function and still be open
for input. The change will then be distributed back to the underlying field values, based on
predefined algorithms, such as "spread equally" or "spread proportionally".

It is possible to specify relative change.

Relative change works when using the distribution mode as part of the expression.

The following syntax applies (n is a number):
Input syntax

Syntax Description
%+n increases the current value by n%
%-n decreases the current value by n%
+=n increases the current value by n
-=n decreases the current value by n
*=n multiplies the current value with n
/=n divides the current value with n
Example:

%+10 increases the current value with 10%.
+=56 increases the current value with 56.
*=2 multiplies the value with 2.

/=2 divides the value with 2.

/=0 no change.

There are also Automation APIs for extracting and setting values programmatically.

Limitations
» A calculated field and key fields cannot be used as input fields. The input field functionality
will automatically be disabled.
» Input fields are not meant for large amounts of data, as they store data significantly less
efficiently than regular fields.
» The key between the input field and the logical field must be unique, it cannot contain any
duplicate values.
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Input field example

This example adds an input field to the data and shows how you can update the values
interactively.

1. Load the following data in the load script.
Inputfield value;

Tablel:

LOAD * INLINE
[

Key, Attribute, value
Bob, Jan, 100
Bob, Feb, 200
Bob, Mar, 300
Kate, Jan, 400
Kate, Feb, 500
Kate, Mar, 600
1;

2. When you have loaded the data, create a Table Box and add all three fields.

3. Create a Straight Table chart and add Key as dimension. Add the following expressions:
e sum(value)
e InputSum(value)

Both expressions will show the same value, but you can only update 1nputsum(value) in the
straight table, not sum(value).

You can now change Value in the table box interactively. The aggregated values of the expressions
in the straight table will update accordingly.

You can also update the values of the Inputsum(value) expression in the straight table. The
underlying values will be updated in the table box. The change is distributed equally to all values,
but you can change the distribution mode in the znputsum() function.

Field Groups

One main difference between QlikView and many other database viewers, OLAP tools etc. is thatin
QlikView there is no need to predefine any hierarchies in the input data. The unique internal logic of
QlikView gives you the complete freedom to access any field as a full dimension in any order you
like. For most purposes this freedom is extremely powerful.

However, there are occasions when a predefined hierarchy could actually help you to display data
more efficiently. QlikView therefore offers the possibility to define groups of fields. The groups can
be hierarchic (drill-down) or non-hierarchic (cyclic).

Groups are created in the Groups page of the Document Properties dialog. They can be used in
charts, where they appear together with the available fields in the dimension drop-down boxes on
the Dimension.

Any fields can be grouped together.

Drill-down groups are marked with an _"t] icon,
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while cyclic groups are displayed with an ¥ icon.
Hierarchic Groups (Drill-Down)

When several fields form a natural hierarchy, it makes sense to create a drill-down group. Typical
examples of hierarchic groups could be:

Time:Year, Quarter, Month
or
Geography: Continent, Country, State, City

When a drill-down group is used as a dimension in a chart, the chart will use the first field in the
group's list of fields that has more than one possible value. If selections are made that cause the
field to have only one possible value, the next field in the list will be used instead, provided that it
has more than one possible value. If no field in the list has more than one possible value, the last
field will be used anyway.

In the first example above, Year will be used as chart dimension until a single year is selected. The
chart will then show Quarter. If a single quarter is selected, the chart will switch to Month.

As selections disappear, so that more than one value becomes possible in the upper fields of the
group's field list, the chart will automatically be drilled back up. Forced drill-up can be achieved by
clicking on the drill-up icon in the chart.

Hierarchic groups (drill-down)

When several fields form a natural hierarchy, it makes sense to create a drill-down group. Typical
examples of hierarchic groups are:

Time: Year, Quarter, Month
or:
Geography: Continent, Country, State, City

When a drill-down group is used as a dimension in a chart, the chart will use the first fields in the

group's list of fields that has more than one possible value. If selections are made that cause the

field to have only one possible value, the next field in the list will be used instead, provided that it
has more than one possible value. If no field in the list has more than one possible value, the last

field will be used anyway.

In the first example above, Year will be used as chart dimension until a single year is selected. The
chart will then show Quarter. If a single quarter is selected, the chart will switch to Month.

As selections disappear, so that more than one field becomes available in the upper fields of the
group's field list, the chart will automatically be drilled back up. Forced drill-up can be achieved by
clicking on the drill-up icon in the chart.

Working with QlikView - QlikView, May 2024 141



6 Introduction to loading data

A special feature appears when the same drill-down group is used in more than one dimension in
the chart specification. The second time the group occurs, the field used will automatically be taken
from one step down the group's field list. For example, if you create a two-dimensional chart with
the group Geography above used as both Main dimension and 2nd dimension, Continent and
Country will initially be used. As soon as one single continent is selected, Country and State will
be used instead.

o Although it is convenient to use this feature with natural hierarchies, there is nothing
preventing its use in other situations as well.

0 If you use a dimension expression that results in a data island it is not possible to drill
down, as a valid hierarchy is required. In this case you need to adapt the expression to
incorporate the values in the hierarchy.

Non-hierarchic groups (cyclic)

Sales
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Sometimes you may find it useful to group fields which do not form a natural hierarchy. The reason
would be to enable the user to make quick changes to the data to be displayed in the chart or list
box.

Any fields can be grouped together in a cyclic group. When a cyclic group is used as a chart
dimension, the chart will initially use the first field in the list. The user may then switch to another
field by clicking the cycle icon in the chart. The fields are displayed in the order in which they
appear in the group's field list. When the last field in the list has been used, the turn goes back to
the first field again. In this way the chart may cycle through the fields indefinitely.
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Do not confuse cyclic groups with Cyclic Group in chart expressions. Cyclic dimension
groups are made up of a number of fields, whereas the cyclic display in chart
expressions cycles through a number of chart expressions.

Logical tables

Each LOAD or SELECT statement generates a table. Normally, QlikView treats the result of each
one of these as one logical table. However, there are a couple of exceptions from this rule:

» If two or more statements result in tables with identical field names, the tables are
concatenated and treated as one logical table.

» If aLOAD or SELECT statement is preceded by any of the following qualifiers, data is altered
or treated differently:

Qualifier

concatenate

crosstable
generic

info

intervalmatch

join

keep

mapping

semantic

Logical table qualifiers

Description

This table is concatenated with (added to) another named table or with the
last previously created logical table.

This table is converted from crosstable format to column format.
This table is split into several other logical tables.

This table is loaded not as a logical table, but as an information table
containing links to external info such as files, sounds, URLSs, etc.

The table (which must contain exactly two columns) is interpreted as numeric
intervals, which are associated with discrete numbers in a specified field.

This table is joined by QlikView with another named table or with the last
previously created logical table, over the fields in common.

This table is reduced to the fields in common with another named table or with
the last previously created logical table.

This table (which must contain exactly two columns) is read as a mapping
table, which is never associated with other tables.

This table is loaded not as a logical table, but as a semantic table containing
relationships that should not be joined, e.g. predecessor, successor and other
references to other objects of the same type.

When the data has been loaded, the logical tables are associated.

Table names

QlikView tables are named when they are stored in the QlikView database. The table names can be
used, for example, for LOAD statements with a resident clause or with expressions containing the
peek function, and can be seen in the $Table system field in the layout.

Tables are named in accordance with the following rules:
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1. If alabel immediately precedes a LOAD or SELECT statement the label is used as table
name. The label must be followed by a colon.

Example:

Tablel:
LOAD a,b from c.csv;

2. If nolabelis given, the file name or table name immediately following the keyword FROM in
the LOAD or SELECT statement is used.

If a file name is defined as a wildcard such as *. csv, the name becomes

tablename-1.

3. Tables loaded inline are named INLINExx, where xx is a number. The first inline table will be
given the name INLINEO1.

4. Automatically generated tables are named AUTOGENERATEXx, where xx is a number. The
first autogenerated table is given the name AUTOGENERATEO]1.

5. If atable name generated according to the rules above should be in conflict with a previous
table name, the name is extended with -x , where x is a number. The number is increased
until no conflict remains. For example, three tables could be named Budget, Budget-1and
Budget-2.

There are three separate domains for table names: section access, section application and
mapping tables. Table names generated in section access and section application are treated
separately. If a table name referenced is not found within the section, QlikView searches the other
section as well. Mapping tables are treated separately and have no connection whatsoever to the
other two domains of table names.

Table labels

A table can be labeled for later reference, for example by a LOAD statement with a resident clause
or with expressions containing the peek function. The label, which can be an arbitrary string of
numbers or characters, should precede the first LOAD or SELECT statement that creates the table.
The label must be followed by a colon ":".

Labels containing blanks must be quoted using single or double quotation marks or square
brackets.

Example 1:

Tablel:
LOAD a,b from c.csv;
LOAD x,y from d.csv where x=peek('a',y,'Tablel');

Example 2: Table label containing a blank

[A11 Transactions]:
SELECT * from Transtable;
LOAD Month, sum(Sales) resident [Al1 Transactions] group by Month;
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Associations between logical tables

A database can have many tables. Each table can be considered as a list of something; each record
in the list represents an instance of an object of some type.

Example:

If two tables are lists of different things, for example if one is a list of customers and the other a list
of invoices, and the two tables have a field such as the customer number in common, this is usually
a sign that there is a relationship between the two tables. In standard SQL query tools the two
tables should almost always be joined.

The tables defined in the QlikView script are called logical tables. QlikView makes associations
between the tables based on the field names, and performs the joins when a selection is made, for
example selecting a field value in a list box.

This means that an association is almost the same thing as a join. The only difference is that the join
is performed when the script is executed - the logical table is usually the result of the join. The
association is made after the logical table is created - associations are always made between the
logical tables.

Loy, Iransac:
Country Customer 10
Capital SIETOTITET] J Transaction ID
Area km sq Custormer 1D Yaar
Population mi Country Month
Pop Growth Customer Day
Currency Address Salesman ID
Inflation City Product 1D
’ Zip Serial Mo
I List Price
MEMDET; Sales
Couniry Gross Margin |
Mermbership

QlikView association compared to SQL natural outer join

A QlikView association resembles a SQL natural outer join. The association is however more
general: an outer join in SQL is usually a one-way projection of one table on another. An association
always results in a full (bidirectional) natural outer join.

Frequency information in associating fields

There are some limitations in the use of most associating fields, that is, fields that are common
between two or more tables. When a field occurs in more than one table, QlikView has a problem
knowing which of the tables it should use for calculating data frequencies.
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QlikView analyzes the data to see if there is a non-ambiguous way to identify a main table to count
in (sometimes there is), but in most cases the program can only make a guess. Since an incorrect
guess could be fatal (QlikView would appear to make a calculation error) the program has been
designed not to allow certain operations when the data interpretation is ambiguous for associating
fields.

Limitations for associating fields

1. Itis not possible to display frequency information in a list box showing the field.

2. Statistics boxes for the field show n/a for most statistical entities.

3. Incharts, itis not possible to create expressions containing functions that depend on
frequency information (such as Sum, Count functions, and Average) on the field, unless the
Distinct modifier is activated. After each reload, QlikView will scan all chart expressions to
see if any ambiguities have occurred as a result of changes in data structures. If ambiguous
expressions are found, a warning dialog will be shown and the expression will be disabled. It
will not be possible to enable the expression until the problem has been corrected. If a log file
is enabled, all ambiguous expressions will be listed in the log.

Workaround

There is a simple way to overcome these limitations. Load the field an extra time under a new name
from the table where frequency counts should be made. Then use the new field for a list box with
frequency, for a statistics box or for calculations in the charts.

Synthetic keys

When two or more internal tables have two or more fields in common, this implies a composite key
relationship. QlikView handles this by creating synthetic keys automatically. These keys are
anonymous fields that represent all occurring combinations of the composite key.

If you receive a warning about synthetic keys when loading data, it is recommended that you review
the data structure in the table viewer. You should ask yourself whether the data model is correct or
not. Sometimes it is, but often enough the synthetic key is there due to an error in the script.

Multiple synthetic keys are often a symptom of an incorrect data model, but not necessarily.
However, a sure sign of an incorrect data model is if you have synthetic keys based on other
synthetic keys.

When the number of synthetic keys increases, depending on data amounts, table
structure and other factors, QlikView may or may not handle them gracefully, and may
end up using excessive amount of time and/or memory. In such a case you need to re-
work your script by removing all synthetic keys.
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IntervalMatchLength LengthRange
—a Length $Syn 1
$5yn 1 Start
Start End
End Length Range
$Syn 1 Table
$5yn 1
Start
End

—

Handling synthetic keys

If you need to avoid synthetic keys, there are a number of ways for solving this in the load script:

» Check that only fields that logically link two tables are used as keys.

» Fields like “Comment”, “Remark” and “Description” may exist in several tables without
being related, and should therefore not be used as keys.

» Fields like “Date”, “Company” and “Name” may exist in several tables and have
identical values, but still have different roles (Order Date/Shipping Date, Customer
Company/Supplier Company). In such cases they should not be used as keys.

» Make sure that redundant fields aren’t used - that only the necessary fields connect. If for
example a date is used as a key, make sure not to load year, month or day_of_month of the
same date from more than one internal table.

 If necessary, form your own non-composite keys, typically using string concatenation inside
an AutoNumber script function.

Data types in QlikView

QlikView can handle text strings, numbers, dates, times, timestamps, and currencies correctly.
They can be sorted, displayed in a number of different formats, and they can be used in
calculations. This means, for example, that dates, times, and timestamps can be added to or
subtracted from each other.

Data representation inside QlikView

In order to understand data interpretation and number formatting in QlikView, it is necessary to
know how data is stored internally by the program. All of the data loaded into QlikView is available in
two representations: as a string and as a number.

1. The string representation is always available and is what is shown in the list boxes and the
other sheet objects. Formatting of data in list boxes (hnumber format) only affects the string
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representation.

2. The number representation is only available when the data can be interpreted as a valid
number. The number representation is used for all numeric calculations and for numeric
sorting.

If several data items read into one field have the same number representation, they will all be
treated as the same value and will all share the first string representation encountered. Example:
The numbers 1.0, 1 and 1.000 read in that order will all have the number representation 1 and the
initial string representation 1.0.

Number interpretation

When you load data containing numbers, currency, or dates, it will be interpreted differently
depending on whether the data type is defined or not. This section describes how data is
interpreted in the two different cases.

Data with type information

Fields containing numbers with a defined data type in a database loaded using ODBC will be
handled by QlikView according to their respective formats. Their string representation will be the
number with an appropriate formatting applied.

QlikView will remember the original number format of the field even if the number format is changed
in the number formatting dialogs of the application. The original format can always be restored by
clicking on the Default from Input button in the number format dialogs

The default formats for the different data types are:

* integer, floating point numbers: the default setting for number
« currency: the default setting for currency
» time, date, timestamp: ISO standard formatting

The default settings for number and currency are defined using the script number interpretation
variables or the operating system settings (Control Panel).

Data without type information

For data without specific formatting information from the source (for example, data from text files
or ODBC data with a general format) the situation becomes more complicated. The final result will
depend on at least six different factors:

The way data is written in the source database

The operating system settings for number, time, date and so on. (Control Panel)
The use of optional number-interpreting variables in the script

The use of optional interpretation functions in the script

The use of optional formatting functions in the script

2

The number formatting controls in the document
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QlikView tries to interpret input data as a number, date, time, and so on. As long as the system
default settings are used in the data, the interpretation and the display formatting is done
automatically by QlikView, and the user does not need to alter the script or any setting in QlikView.
There is an easy way to find out if the input data has been correctly interpreted: numeric values are
right-aligned in list boxes, whereas text strings are left-aligned.

By default, the following scheme is used until a complete match is found. (The default format is the
format such as the decimal separator, the order between year, month and day, and so on, specified
in the operating system, that is, in the Control Panel, or in some cases from the special number
interpretation variables in the script.

QlikView will interpret the data as one of the following, in sequential order:

A number in accordance with the default format for numbers.

A date according to the default format for date.

A timestamp according to the default format for time and date.

A time according to the default format for time.

A date according to the following format: yyyy-MM-dd.

A time-stamp according to the following format: YYYY-MM-DD hh:mm[:ss[.fff]].
A time according to the following format: hh:mm[:ss[.fff]].

Money according to the default format for currency.

© ©® N O oA WD -

A number with '." as decimal separator and ', as thousands separator, provided that neither
the decimal separator nor the thousands separator are setto',".

10. A number with'," as decimal separator and . as thousands separator, provided that neither
the decimal separator nor the thousands separator are setto ..

11. Atext string. This last test never fails: if it is possible to read the data, it is always possible to
interpret it as a string.

When loading numbers from text files, some interpretation problems may occur, for example, an
incorrect thousands separator or decimal separator may cause QlikView to interpret the number
incorrectly. The first thing to do is to check that the number-interpretation variables in the script are
correctly defined and that the system settings in the Control Panel are correct.

When QlikView has interpreted data as a date or time, it is possible to change to another date or
time format in the chart properties.

Since there is no predefined format for the data, different records may, of course, contain
differently formatted data in the same field. It is possible for example, to find valid dates, integers,
and text in one field. The data will therefore, not be formatted, but shown in its original form.

Date and time interpretation

QlikView stores each date, time, and timestamp found in data as a date serial number. The date
serial number is used for dates, times and timestamps and in arithmetic calculations based on date
and time entities. Dates and times can thus be added and subtracted, intervals can be compared,
and soon.
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The date serial number is the (real valued) number of days passed since December 30, 1899, that
is, the QlikView format is identical to the 1900 date system used by Microsoft Excel and other
programs, in the range between March 1, 1900 and February 28, 2100. For example, 33857
corresponds to September 10, 1992. Outside this range, QlikView uses the same date system
extended to the Gregorian calendar.

The serial number for times is a number between 0 and 1. The serial number 0.00000 corresponds
t0 00:00:00, whereas 0.99999 corresponds to 23:59:59. Mixed numbers indicate the date and time:
the serial number 2.5 represents January 1, 1900 at 12:00 noon.

The data is, however, displayed according to the format of the string. By default, the settings made
in the Control Panel are used. It is also possible to set the format of the data by using the number
interpretation variables in the script or with the help of a formatting function. Lastly,it is also
possible to reformat the data in the properties sheet of the sheet object.

Example 1:

Dates and serial numbers

Date string Date serial number
1997-08-06 35648
09:00 0.375

1997-08-06 09:00 35648.375

and the other way around.

Serial numbers and dates

Specified number

Date serial number Date string
format

35648 'D/IM/YY! 6/8/97

0.375 ‘hh.mm’ 09.00

QlikView follows a set of rules to try to interpret dates, times, and other data types. The final result,
however, will be affected by a number of factors as described here.

Example 2:

These examples assume the following default settings:

* Number decimal separator: .
* Short date format: YY-MM-DD
¢ Time format: hh:mm

The following table shows the different representations when data is read into QlikView without the
special interpretation function in the script:
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Source
data

0.375

33857

97-08-06

970806

8/6/97

QlikView default

interpretation

0.375

33857

97-08-06

970806

8/6/97

Date representations

'YYYY-
MM-DD'
date
format

1899-12-
30

1992-09-
10

1997-08-
06

4557-12-
21

8/6/97

‘MM/DD/YYYY'

date format

12/30/1899

09/10/1992

08/06/1997

12/21/4557

8/6/97

'hh:mm'
time
format

09:00

00:00

00:00

00:00

8/6/97

'# ##0.00'
number
format

0.38

33 857.00

35648.00

970 806.00

8/6/97

The following table shows the different representations when data is read into QlikView using the
date#( A, 'M/D/YY') interpretation function in the script:

Source
data

0.375
33857
97-08-06
970806
8/6/97

QlikView default

interpretation

0.375
33857
97-08-06
970806
8/6/97

Date representations

'YYYY-
MM-DD'
date
format

0.375
33857
97-08-06
970806

1997-08-
06

'MM/DD/YYYY'

date format

0.375
33857
97-08-06
970806
08/06/1997

6.2 Guidelines for data and fields

There are certain conventions and limitations you need to be aware of when working with QlikView.
For example: the upper limit for data tables and fields as well as maximum amount of loaded data in

QlikView.

Guidelines for amount of loaded data

The amount of data that can be loaded into QlikView is primarily limited by the amount of primary
memory of the computer.

'hh:mm'
time
format
0.375
33857
97-08-06
970806
00:00

'# ##0.00'
number
format
0.375
33857
97-08-06
970806
35648.00
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Upper limits for data tables and fields

Be aware when building very large documents that a QlikView document cannot have more than
2,147,483,648 distinct values in one field.

The number of fields and data tables as well as the number of table cells and table rows that can be
loaded, is limited only by RAM.

Recommended limit for load script sections

The recommended maximum number of characters to be used per load script section is 50,000
characters.

Conventions for number and time formats

In many interpretation and formatting functions it is possible to set the format for numbers and
dates by using a format code. This topic describes the conventions used to format a number, date,
time or time stamp. These conventions apply both to script and chart functions.

Number formats

» To denote a specific number of digits, use the symbol "0" for each digit.

» Todenote a possible digit, use the symbol "#". If the format contains only # symbols to the left of
the decimal point and the numbers is less than 1, the zeros are trimmed and it will begin with a
decimal point. If the format contains # symbols to the right of the decimal point, all values will be
displayed.

» To mark the position of the thousands separator or the decimal separator, use the applicable
thousands separator and the decimal separator.

The format code is used for defining the positions of the separators. It is not possible to set the
separator in the format code. Use the DecimalSep and ThousandSep variables for this in the script.
It is possible to use the thousand separator to group digits by any number of positions, for example,
a format string of "0000-0000-0000" (thousand separator="-") could be used to display a twelve-
digit part number as "0012-4567-8912".

Examples:

# ##0: describes the number as an integer with a thousands separator.

###0: describes the number as an integer without a thousands separator.

0000: describes the number as an integer with at least four digits. For example, the number
123 will be shown as 0123.

0.000: describes the number with three decimals.
» 0.0##: describes the number with three decimals. Some might be displayed as zeros.

Special number formats

QlikView can interpret and format numbers in any radix between 2 and 36 including binary, octal
and hexadecimal. It can also handle roman formats.
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Format
Binary format
Octal format

Hexadecimal
format

Decimal format

Custom radix
format

Roman format

Examples:

19

Number formats

Description
To indicate binary format the format code should start with (bin) or (BIN).
To indicate octal format the format code should start with (oct) or (OCT).

To indicate hexadecimal format the format code should start with (hex) or
(HEX). If the capitalized version is used A-F will be used for formatting (for
example 14FA). The non-capitalized version will result in formatting with a-f
(for example 14fa). Interpretation will work for both variants regardless of the
capitalization of the format code.

The use of (dec) or (DEC) to indicate decimal format is permitted but
unnecessary.

To indicate a format in any radix between 2 and 36 the format code should
start with (rxx) or (Rxx) where xx is the two-digit number denoting the radix to
be used. If the capitalized R is used letters in radices above 10 will be
capitalized when QlikView is formatting (for example 14FA). The non-
capitalized r will result in formatting with non-capital letters (for example 14fa).
Interpretation will work for both variants regardless of the capitalization of the
format code. Note that (r02) is the equivalent of (bin), (R16) is the equivalent of
(HEX), and so on.

To indicate roman numbers the format code should start with (rom) or (ROM). If
the capitalized version is used capital letters will be used for formatting (for
example MMXVI). The non-capitalized version will result in formatting with
lower cap letters (mmxvi). Interpretation will work for both variants regardless
of the capitalization of the format code. Roman numbers are generalized with
minus sign for negative numbers and O for zero. Decimals are ignored with
roman formatting.

9, '(bin)') returns 11000111

« num(199, '(oct)') returns 307

« num(199, '(hex)') returns c7
« num(199, '(HEX)') returns C7

,'(r02)") returns 11000111

e num(199, '(r16)') returns c7
« num(199, '(R16)") returns C7

* num(199, '(R36)")
9, '(rom)') r
199, '(ROM)") returns CXCIX

« num(19

m(
(
(
(
. m(1
(
(
(
(
m(

Dates

returns 5J
eturns cxcix

You can use the following symbols to format a date. Arbitrary separators can be used.

Working with QlikView - QlikView, May 2024 153



6 Introduction to loading data

Date formatting symbols

Symbol Description
D To describe the day, use the symbol "D" for each digit.
M To describe the month number, use the symbol "M".

» Use "M" or "MM" for one or two digits.

« "MMM" denotes short month name in letters as defined by the operating
system or by the override system variable MonthNames in the script.

« "MMMM" denotes long month name in letters as defined by the operating
system or by the override system variable LongMonthNames in the script.

=<

To describe the year, use the symbol "Y" for each digit.

W To describe the weekday, use the symbol "W".

o "W" will return the number of the day (for example 0 for Monday) as a single
digit.
o "WW?" will return the number with two digits (e.g. 02 for Wednesday).

o "WWW" will show the short version of the weekday name (for example Mon)
as defined by the operating system or by the override system variable
DayNames in the script.

« "WWWW" will show the long version of the weekday name (for example
Monday) as defined by the operating system or by the override system
variable LongDayNames in the script.

Examples: (with 31st March 2013 as example date)

¢ YY-MM-DD describes the date as 13-03-31.

* YYYY-MM-DD describes the date as 2013-03-31.

¢ YYYY-MMM-DD describes the date as 2013-Mar-31.

« DD MMMM YYYY describes the date as 31 March 2013.

» M/D/YY describes the date as 3/31/13.

« WYY-MM-DD describes the date as 6 13-03-31.

« WWW YY-MM-DD describes the date as Sat 13-03-31.

« WWWW YY-MM-DD describes the date as Saturday 13-03-31.

Times

You can use the following symbols to format a time. Arbitrary separators can be used.

Time format symbols

Symbol Description
h To describe the hours, use the symbol "h" for each digit.
m To describe the minutes, use the symbol "m" for each digit.

Working with QlikView - QlikView, May 2024 154



6 Introduction to loading data

Symbol Description

s To describe the seconds, use the symbol "s" for each digit.

f To describe the fractions of a second, use the symbol "f" for each digit.
tt To describe the time in AM/PM format, use the symbol "tt" after the time.

Examples: (with 18.30 as example time):

* hh:mm: describes the time as 18:30
* hh.mm.ss.ff: describes the time as 18.30.00.00
e hh:mm:tt: describes the time as 06:30:pm

Time stamps

The same notation as that of dates and times above is used in time stamps.

Examples: (with 31th March 2013 18.30 as example time stamp):

* YY-MM-DD hh:mm: describes the time stamp as 13-03-3118:30
* M/D/Y hh.mm.ss.ffff: describes the time stamp as 3/31/13 18.30.00.0000

6.3 Loading data from files

QlikView can read data from files representing a table, in which the fields are separated by a
delimiter like commas, tabs or semicolons. Other possible formats are dif files (Data Interchange
Format), fix files (fixed record length), HTML tables, Excel files, xml files and the native QVD and
QVX files. In most cases, the first line in the file holds the field names.

Files are loaded by means of a load statement in the script.

Instead of typing the statements manually in the script editor, you can use the Table file wizard to
generate the statements automatically.

In load statements, the full set of script expressions may be used.

To read data from another QlikView document, you may use a binary statement.

Table file

In QlikView Table file means a file representing a table, in which the fields are separated e.g. by
commas, tabs or semicolons (also referred to as a text file) or have fixed length etc. The contents of
the first row usually represents the names of the fields. Other table files are dif files (Data
Interchange Format), fix files (fixed record length), HTML-tables and Excel-files.

How to prepare Excel files for loading with QlikView

If you want to load Microsoft Excel files into QlikView, there are many functions you can use to
transform and clean your data in the load script, but it may be more convenient to prepare the
source data directly in the Microsoft Excel spreadsheet file. This section provides a few tips to help
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you prepare your spreadsheet for loading it into QlikView with minimal script coding required.

Use column headings

If you use column headings in Excel, they will automatically be used as field names if you select
Embedded field names when selecting data in QlikView. It is also recommended that you avoid line
breaks in the labels, and put the header as the first line of the sheet.

Formatting your data

Itis easier to load an Excel file into QlikView if the content is arranged as raw data in a table. It is
preferable to avoid the following:

» Aggregates, such as sums or counts. Aggregates can be defined and calculated in QlikView.
e Duplicate headers.

« Extrainformation that is not part of the data, such as comments. The best way is to have a
column for comments, that you can easily skip when loading the file in QlikView.

» Cross-table data layout. If, for instance, you have one column per month, you should,
instead, have a column called “Month” and write the same data in 12 rows, one row per
month. Then you can always view it in cross-table format in QlikView.

« Intermediate headers, for example, a line saying “Department A” followed by the lines
pertaining to Department A. Instead, you should create a column called “Department” and fill
it with the appropriate department names.

« Merged cells. List the cell value in every cell, instead.

» Blank cells where the value is implied by the previous value above. You need to fill in blanks
where there is a repeated value, to make every cell contain a data value.

Use named areas

If you only want to read a part of a sheet, you can select an area of columns and rows and define it
as a named area in Excel. QlikView can load data from named areas, as well as from sheets.

Typically, you can define the raw data as a named area, and keeping all extra commentary and
legends outside the named area. This will make it easier to load the data into QlikView.

Remove password protection

Itis recommended to remove password protection of the Excel file prior to loading the data.

Enable editing

If the Microsoft Excel file was downloaded from the Internet, you should enable editing prior to
loading the data into QlikView.

6.4 Loading data from databases

Data from commercial database systems is loaded into QlikView via the Microsoft OLE DB/ ODBC
interface. To do so, you must install a driver to support your DBMS and you must configure the
database as ODBC data source.
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When this is done, you can set up a connection to the database in the Edit Script dialog by clicking
the Connect button. This generates a Connect statement in the script.

After that, you define the fields and tables to be loaded in a Select statement. To create this
statement, click the Select button.

Logic in databases

Several tables from a database application can be included simultaneously in the QlikView logic.
When a field exists in more than one table, the tables are logically linked through this key field.

When a value is selected, all values compatible with the selection(s) are displayed as optional. All
other values are displayed as excluded.

If values from several fields are selected, a logical AND is assumed.
If several values of the same field are selected, a logical OR is assumed.
In some cases, selections within a field can be set to logical AND.

If Info display of a field is desired, a two-column table must be included in the script. The first
column of the table must contain values of the field, the second the information associated with the
field value.. The first column must have the field name as heading. A special script syntax of the
LOAD/SELECT statement tells QlikView to treat this table as an Information table.

6.5 Loading data from inline tables

Type data manually into a script to define an inline table.

You create inline tables by typing data manually into the script, rather than by connecting to files
and databases. Use the required syntax to indicate that the script text is to be interpreted as inline
data.

A basic inline load creates a table, and inserts the data fields and records.

Why use inline loads?

Inline loads can be helpful in a number of use cases:

» Administering and editing data without needing to connect to external sources.

« Supplementing existing data in the data model. For example, you could add an additional
table to a data model that mostly comes from database sources.

« Adding data that you would like to avoid continuously loading from external sources. This
can save time if you know the data source might change in the future, but the data values will
remain the same.

» Ease-of-use for copying and pasting content into the script from other files. For example,
.csv files or tables from word processor documents.

» Creating test scripts that can be copied and pasted quickly.
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Basic syntax example

The following script contains a simple inline load.

MyTable:

Load * Inline [Country, Year, Sales

Argentina, 2014, 66295.03

Argentina, 2015, 140037.89

Austria, 2014, 54166.09

Austria, 2015, 182739.87

1;

The following syntax is used for the above inline load:
e Load * Inline instructs QlikView to load all fields from the inline table that follows.
* MpyTable: defines the name of the table.
» Square brackets enclose the data.
» Thefirst line of the load statement defines the data fields.
» Commas separate data fields and records.

* A semi-colon closes the load statement.

Syntax overview

Naming the table
You can add a name for the inline table, as you would for other loaded tables. Defining the table

name is optional.

After the name of the table, insert a colon.

LOAD and inline statements

Aninline table is loaded with the inline clause when you use the LOAD script statement. The inline
clause indicates that the subsequent text in the table will contain data that is manually typed into
the editor. Unless you indicate otherwise, an inline table uses the txt format, which follows the
structure of a delimited text file.

For more information about the LOAD statement, see Load (page 983).

Enclosures and data entry

Data entered through an inline clause must be enclosed by specific characters. The following are
accepted character combinations for enclosing the data:

e Square brackets: [ and ]

» Double quotation marks: "and "
e Single quotation marks: ' and '
e Backticks: “and -
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The character you choose as an enclosure can help you load inline data that contains conflicting
characters. For example, if your data contains records with square brackets, you can enclose it with
quotation marks or back ticks instead.

For an example of alternative enclosures, see Example - Alternative data enclosures (page 160).

Unless you specify an alternative table format (default is txt), text between the enclosures is
interpreted in the same way as the content of a file. Hence, where you would insert a new line in a
text file, you should also do it in the text of an inline clause: by pressing the Enter key when typing
the script.

Ending the inline load

The end of the inline load statement is denoted with a semi-colon.

Data transformations

In a simple inline load with no transformations, the number of columns are defined by the first line.
There are three columns in the table loaded by the following example: product_1D, SuppTlier_Name,
and Product_category.

Products:

Load * InTline [

Product_ID, Supplier_Name, Product_Category

1, paracel, Home Decor

2, Pagewave, Electronics

3, Talarian, Software

4, Userland, Appliances

1;

You can also perform transformations and create new columns within the same inline table. You can
use preceding loads, and more than one LOAD statement can be used to load the same table.

For specific examples, see Examples - Inline loads with transformations (page 166).

Configuring the format specification in an inline load

Like with other loaded tables, you can modify the format specification of the inline table using
format specification items. The format specification is added in brackets. It should be added after
the data enclosures, but before the semi-colon ending the LOAD statement. Some of the
customizations you can add include:

* Changing the delimiter from a comma to another character. For examples, see Examples -
Alternative delimiters (page 161).
See: For delimited table files, an arbitrary delimiter can be specified through the delimiter is
specifier. This specifier is relevant only for delimited .txt files. (page 994)

« Omitting table column headers. For an example, see Example - Omitting column headers
(page 163).
See: LabelsLabels is a file specifier for the LOAD statement that defines where in a file the
field names can be found. embedded labels|explicit labels/no labels The field names can be
found in different places of the file. If the first record contains the field names, embedded
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labels should be used. If there are no field names to be found, no labels should be used. In dif
files, a separate header section with explicit field names is sometimes used. In such a case,
explicit labels should be used. If nothing is specified, embedded labels is assumed, also for
dif files. LOAD * from a.txt (unicode, txt, delimiteris'', embedded labels LOAD * from a.txt
(codePage is 1252, txt, delimiteris',', no labels) (page 1)

» Using another data format (for example, fixed record format). For an example, see Example -

Loading another data type (page 164).
See: Table format (page 993)

Not all Table format options are supported for inline loads.

» Allowing multi-line content. For an example, see Example - Multi-line content (page 165).
See: QuotesQuotes is a file specifier for the LOAD statement that defines whether quotes
can be used and the precedence between quotes and separators. For text files only. no
quotesmsq If the specifier is omitted, standard quoting is used, that is, the quotes " "or ''can
be used, but only if they are the first and last non blank character of a field value. Quotes
argumentsArgumentDescriptionno quotesUsed if quotation marks are not to be accepted in
a text file.msqUsed to specify modern style quoting, allowing multi-line content in fields.
Fields containing end-of-line characters must be enclosed within double quotes.One
limitation of the msq option is that single double-quote (") characters appearing as first or
last character in field content will be interpreted as start or end of multi-line content, which
may lead to unpredicted results in the data set loaded. In this case you should use standard
guoting instead, omitting the specifier. (page 1)

To use multiple format specification items in the same table, separate them with commas. For
example: (pelimiter is '|', no labels)

For full details about the format specification, see Format specification items (page 992).

Operators and other clauses

Additionally, since an inline load is a LOAD statement, you can combine other arguments for the
LOAD statement into the inline load. For example, use the where or while clause to define whether
to load a specific row or not, based on the text within it.

Similarly, you can also use operators outside of the text content itself. With operators, you can
customize how you transform the inline data, and also define when to load certain data or not.

For a specific example, see Example - Operators for transformations and clauses (page 170).

Example - Alternative data enclosures

You can use square brackets, quotation marks, or back ticks to enclose an inline load. This section
illustrates this with an example. For more information, see Enclosures and data entry (page 158).
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Load script and results

Overview

This example demonstrates how you can use back ticks to enclose the inline data. The data in the
example contains square bracket characters, which makes square brackets incompatible as
enclosures for the LOAD statement.

Load script
DataTable:
Load * inTine

custom_property, date, amount
[11402], 1/1/2024, 92.99
[11403], 1/2/2024, 102.34
[11404], 1/3/2024, 50.26
[11405], 1/4/2024, 153.69
[11406], 1/5/2024, 75.62

Results

e custom_property

o date
o amount
Results table

custom_property date amount
[11402] 1/1/2024 92.99
[11403] 1/2/2024 102.34
[11404] 1/3/2024 50.26
[11405] 1/4/2024 153.69
[11406] 1/5/2024 75.62

Examples - Alternative delimiters

You can use a character other than a comma to delimit column values in the table. For more
information, see Configuring the format specification in an inline load (page 159).
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Load script and results

Overview

Exchanging the delimiter is useful when data in the table contains commas, which would otherwise
signal the switch to the next column in the table.

This example contains four tables to be loaded. They are as follows:

» Four tables to be loaded. They are as follows:

* Tablel: Delimiter is a vertical bar (pipe). The data in the phrase column contains
commas.

¢ Table2: Delimiter is a colon.
¢ Table3: Delimiteris a back slash.

e Table4: The table is delimited by pressing the Tab key on the keyboard. This option is
useful when you are copying a table from a word processor and pasting it into the
script.

Tablel shows a practical use case for using an alternative delimiter. The other tables show
more delimiter options.

Load script

Tablel:

LOAD * INLINE [

ID|Phrase

1 | 'The transaction was complete, but the order has not yet shipped.'

2 | 'we need to confirm the following details: sales rep number, order status, and shipping
priority."'

] (pelimiter is '"[");

Table2:

LOAD * INLINE [
Numl:Chrl

1:A

2:B ] (Delimiter is ':');

Table3:

LOAD * INLINE [
Num2\Chr2

1\A

2\B ] (pelimiter is \\);

Table4:

LOAD * INLINE [

Num3 chr3

1 A

2 B ] (Delimiter is '"\t');
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Results
Results table: Tablel
ID Phrase
1 The transaction was complete, but the order has not yet shipped.
2 We need to confirm the following details: sales rep number, order status, and shipping
priority.
Results table: Table2
Num1 Chr1
1 A
2 B
Results table: Table3
Num2 Chr2
1 A
2 B
Results table: Table4
Num3 Chr3
1 A
2 B

Example - Omitting column headers

Edit the format specification to load an inline table without defining column headers. This is done
with the labels specification (setting it to a value of no 1abels). For more information, see
Configuring the format specification in an inline load (page 159).

When you load a table without defining column names, system-defined column names are
automatically used.

Load script and results

Overview

This example demonstrates how you can load an inline table without defining column names.
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Load script

Expenses:

Load * inTine

[
1,Categoryl,40566.49
2,Category2,3504.54
3,Category3,593206.30
1 (no Tabels);

Results
Results table
@1 @2 @3
1 Category1 40566.49
2 Category2 3504.54
3 Category3 593206.30

Example - Loading another data type

This example demonstrates how you can load an inline table in fixed record format. See Configuring
the format specification in an inline load (page 159).

Load script and results

Overview

This example script contains the following:

e Aninline load statement defining the table pataTable.

» The use of fix (as part of the Table format specification) to indicate that the data to load is in
fixed record format.

Load script

DataTable:
LOAD

"@l:4",
"@5:8",
"@9:12",
"@13:16"
INLINE [

a b C d
1 2 3 4
X 'y z w
] (fix, utf8, embedded 1abels);
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Results
Results table
a b c d
1 2 3 4
X y z w

Example - Multi-line content

This example demonstrates how you can enter multi-line field content into an inline table. See
Configuring the format specification in an inline load (page 159).

Load script and results

Overview

This example script contains the following:

» A simple inline load to define the table T1.

» Use of the Quotes specifier (with the value msq) to support multi-line content.

» Length values specified in feet and inches.

» The double quotation mark symbol (") indicates the end of a multi-line entry. In this example,
the same symbol is also used to denote the inch values. This is done to show the syntax and
resulting behavior if you need to use both in the same LOAD statement. Essentially, entering
the " symbol for two consecutive characters (") indicates the code is to be interpreted as a
single text instance of the symbol.

Load script

T1:

Load *, recno() as ID inline [
Length

npr pun

22' 10"""

14" 8" ] (msq);

Results

To view multi-line content as intended, you will need to adjust Multi-Line Settings for the chartin
the Properties... configuration.
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Results table

ID Length
1 12"

22'10"
2 14'8"

In the above table, the record with an 1p value of 1 contains multi-line content.

Examples - Inline loads with transformations

These examples show how you can perform calculations on fields loaded inline to create new fields
in the data model.

For more information, see Data transformations (page 159).

Example: Simple renaming of a field
Load script
ORDERS:

Load original as Updated,

* InTine

[

original

ProductA

ProductB

ProductcC

1;

Results

Results table

Original Updated
ProductA ProductA
ProductB ProductB
ProductC ProductC

Example: Simple insertion of an ID field

Overview

This example shows how you can define a calculated field to indicate the ID of each data row,
without manually typing each ID value.
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Load script
ORDERS:

Load RowNo() as 1ID,

* InTine
[
ProductName
A
B
C
D
E
1;
Results
Results table
ID ProductName
1 A
2 B
3 C
4 D
5 E

Example: Configuring LOAD statements to handle transformations

Overview

This example shows several ways in which a simple transformation can be applied to inline data.
You can use one or multiple LOAD statements, and configure the syntax in different ways, to define
whether or not a transformation replaces the original field or if both original and new fields are
loaded.

In particular, note the variations in the following and how they affect the output:

* Number of LOAD statements within the table.
» Presence or absence of = symbol (loads all subsequent fields).
» Presence or absence of commas (, symbol).

This example script contains the following:

» Four tables, all of which reference the same data. The field names are different.

¢ perivedyearsl: Uses two LOAD statements to load an inline column and a column
containing a transformation of the inline column.
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e Derivedyears2: Uses two LOAD statements. The script loads an inline column, then
loads a calculated field transformed from the original column. With the second LOAD
statement, the original column is not loaded into the table, effectively making the new

field a replacement of the original field.

» Dperivedyears3: Uses a single LOAD statement to load both the original inline column

and a transformed column.

e Dperivedyears4: Uses a single LOAD statement to define an inline field and a
transformation of that original field. Only the transformed field is loaded into the table.

Load script
Derivedyearsl:

Load *,
Year(initial_datel) as derived_yearl

Load

* qinTine [
initial_datel
'1/1/2022'
'1/1/2023"
'1/1/2024'

1;

DerivedYears2:

Load
Year(initial_date2) as derived_year?2

Load

* qinTine [
initial_date2
'1/1/2022'
'1/1/2023"
'1/1/2024'

1;

DerivedYears3:

Load Year(initial_date3) as derived_year3,
* qinTine [

initial_date3

'1/1/2022'

'1/1/2023"

'1/1/2024'

1;

DerivedYears4:

Load Year(initial_date4) as derived_year4
inline [
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initial_date4

'1/1/2022"
'1/1/2023"
'1/1/2024"
1;
Results
Results table: perivedyearsl
initial_date1 derived_year1
1/1/2022 2022
1/1/2023 2023
1/1/2024 2024

Results table: perivedyears?2

derived_year2

2022
2023
2024
Results table: perivedyears3
initial_date3 derived_year3
1/1/2022 2022
1/1/2023 2023
1/1/2024 2024

Results table: perivedyears4

derived_year4
2022
2023
2024

Example: Modifying field content

Overview

Suppose you are pasting information from a large text file into the script editor, but want to perform
additional processing on the records in the dataset. For example, you want to remove certain
characters and prefixes, and capitalize each word.

This example script contains the following:
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» Aninline table, Transformations, in which a transformation is defined to change text content
of a field. The text being transformed is added after this.

» Two LOAD statements. With the configuration in the example, only the derived field
ProductName_Trimmed is loaded into the table.

Load script

Transformations:

Load
Capitalize(TextBetween(OrigColumn, '{','}')) as ProductName_Trimmed;

Load * inTline [

origColumn

Product: {soft drinks and other beverages}
Product: {snack food}

Product: {electronics and video games}

1;

Results

Results table

ProductName_Trimmed
Soft Drinks And Other Beverages
Snack Food

Electronics And Video Games

Example - Operators for transformations and clauses

You can use operators to define transformations and specific clauses in the LOAD statement. For
more information, see Operators and other clauses (page 160).

Operators (page 1073)
Load script and results

Overview

This example script contains the following:

* Asimpleinline load to define the table purchases.

* The insertion of a calculated field, ordersize. This field is a transformation of the amount field
from the inline dataset. It categorizes purchases as small or large, depending on whether or
not the amount surpasses $2000.00.

» A where clause that prevent records from being loaded when the amount is less than $0.05.
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Load script
Purchases:

Load

If(amount<2000, 'small Purchase', 'Large Purchase') as oOrdersize,

* inline

[

ID, amount

1,2660.39

2,100.01

3,500.42

4,5023.99

5,0.04

6,2002.39

7,31034.53

8,1643.58

9,3993.65

10,614.34

11,675.93

]

WHERE

amount>1

Results
ID amount
1 2660.39
2 100.01
3 500.42
4 5023.99
6 2002.39
7 31034.53
8 1643.58
9 3993.65
10 614.34
" 675.93

Results table
OrderSize

Large Purchase
Small Purchase
Small Purchase
Large Purchase
Large Purchase
Large Purchase
Small Purchase
Large Purchase
Small Purchase

Small Purchase

In the above table, the transaction with an 1p of 5 was not loaded into the table. This is because the

amount value is less than $0.05.
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Example - Creating null values in an inline table

This example demonstrates how you can use the Nulllnterpret variable to create null values in your
inline data.

Nullinterpret (page 1032)
Load script and results

Overview

This example script contains the following:

» Asimpleinline load to define the table T2.

e The Nullinterpret variable defined as two single quotation marks. When the script is loaded,
records containing this value are processed as null values.

Load script

set nullinterpret = ;
T2:

Load * inline [

Test

x 1;

Results

Results table
Test

In the above table, the first record is a null value. Therefore, it is not included in the visualization.
Null values existing in tables with additional dimensions would be denoted with a - symbol.

More examples

For additional examples, see Load (page 983).

6.6 Understanding circular references

If there are circular references ("loops") in a data structure, the tables are associated in such a way
that there is more than one path of associations between two fields.

This type of data structure should be avoided as much as possible, since it might lead to
ambiguities in the interpretation of data.
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QlikView solves the problem of circular references by breaking the loop with a loosely coupled
table. When QlikView finds circular data structures while executing the load script, a warning dialog
will be shown and one or more tables will be set as loosely coupled. QlikView will typically attempt
to loosen the longest table in the loop, as this is often a transaction table, which normally should be
the one to loosen. In the table viewer, loosely-coupled tables are indicated by the red dotted links
to other tables.

Example:

Data is loaded from three tables that include the following:

+ Names of some national soccer teams
e Soccer clubs in some cities
» Cities of some European countries

i Cities - = X
Country Team City Team Country City
Germany Die Mannschaft Barcelona Barcelona Germany Hamburg
ltaly Azzurri Hamburg Altona Germany Munich
Spain La Roja Madrid  Real Madrid Italy Milano
4 4 b M| Sheetl Sheet | Milano  Milan Italy Rome
Munich  Bayern Minchen Italy Turin
Rome Lazio Spain Barcelona
Turin Juventus Spain Madrid -
M 4+ M| Sheetl ~ Sheet2 4 4+ v | Shel NI RY

View of the source data tables

This data structure is not very good, since the field name Teamis used for two different purposes:
national teams and local clubs. The data in the tables creates an impossible logical situation.

When loading the tables into QlikView, QlikView determines which of the data connections that is
least important, and loosens this table.

Open the table viewer to see how QlikView interprets the relevance of the data connections:
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STEETHES
SHEETH = —a City
Team al Team
Caoumntry

-

SHEEH S
L | Country
City <

The table with cities and the countries they belong to is now loosely coupled to the table with
national teams of different countries and to the table with local clubs of different cities.

Solving circular references

When circular references occur, you need to edit the load script by assigning a unique name to one
of the fields with identical names.

Do the following:

1. Open the script editor.

2. Edit the LOAD statement for one of the duplicate field names.
In this example, the LOAD statement of the table that holds the local teams and their cities

would include with a new name for Team, for example LocalClub. The updated LOAD
statement reads:
LOAD City, Team as LocalClub

3. Reload the script.

You now have logic that works throughout all the tables. In this example, when /taly is selected, the
national team, the German cities and the local clubs of each city are associated:

Country & Team +£ City # LocalClub P
GEEFMAny Az Barcelona Alkona
_ Die Mannschaft Harmbirg Barcelona
Spain La Roja Madrid Bavern Minchen

Milaro Juventus

Munich Lazio

R.orme Milan

Turin Real Madrid

When you open the table viewer, you see that the loosely coupled connections are replaced with
regular connections:
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SHEETIEE
S HEE T —a| City
Country LocalClub

Team

SEELI S
Country
City

Loosely coupled tables

When data that includes circular references is loaded into QlikView, loosely coupled tables are
created automatically. This prevents that the circular references create a loop in the internal logic.
The loosely coupled tables need to be handled in order to visualize data in a way that is expected
and understandable.

Intentionally Creating Loosely Coupled Tables

In some special situations, you might want to disconnect some data from the normal QlikView logic.
You can use loosely coupled tables to restrict selections in one field to propagate through to the
other fields in the table.

To set a table to be loosely coupled, open the Document Properties dialog and select the Tables
tab.

This chapter includes some examples of how loosely coupled tables alter the QlikView logic.

Each of the following three table boxes represents a table read into QlikView:

Tablel Table2 Table3
B 1 1 C C D
1 ® 4 & & a
z W W 7 7 b
] z z o] o] C

If the value 2 is selected in field B the following will happen:

Tablel Table2 Table3
B @ . A A C C D
2 y ¥ 7 7 b

The selection ripples through all tables, and excludes values that are not associated.

Now, let's keep this selection but make Table2 loosely coupled. This means that the logic will be cut
between the fields A and C in Table2. The result will look this:
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Tablel Table2 Table3
B @& A 1] C C D
2 W W =] =] a

W 7 7 b
W o] o] C

Note that Table2 shown here is a table box and not the table itself. The table box will show all
possible combinations between the fields of its columns. Since there is no logic between fields A
and C all combinations of their respective possible values are shown.

Example:

The three tables below are found in a rather typical structure: one transaction table and two
dimension tables associating to it via one field each.

You can visualize sales per year and product group using a pivot table. Next to the pivot table, two
list boxes show the dimension fields:

sum{Amount) = O Year ProdGrp

Year ProdGrp  sumiAmount) 2011 0%
" a6 201z %
2011 2 14 Z

50

" 45

2012 % 13

58

Total 108

Even though this is a correct pivot table, the effects of QlikView's logic could now potentially lead to
undesired results. If the year 2012 is selected, you get the following result:

sum{Amount) = O Year ProdGrp
Year @ ProdGrp  sumiAmount) 2011 %
" 45 201 |
2012 % 13 i
58
Total L1:

Product group Z is no longer visible in pivot table. This is natural, since the value Z in the field
ProdGrp has been excluded by the selection of the value 2012 in the field Year. However, when you
analyze sales of year 2012, you probably want to see Z in the chart with a 0 in the sum(Amount)
column, so that it is clear to everyone that product group Z exists and that nothing has been sold in

2012.

In some sense, the two fields Year and ProdGrp have nothing to do with each other, and therefore
should not interact just because they happen to be associated via the Trans table. This can be dealt
with by declaring the Trans table as loosely coupled, which changes the layout of the pivot table:
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sum{Amount) = O Year ProdGrp
Year @ ProdGrp sumiAmount) 2011 %
= (= 45 2012 %
i 13 z
20§z 7 0
Total 58
Total 58

Note that the selection in the Year list box does not render any value in the ProdGrp list box
anymore.

Make sure that Suppress Zero-Values is not selected for dimensions on the
Presentation tab of the Chart Properties dialog.

6.7 Renaming fields

Sometimes it is necessary to rename fields in order to obtain the desired associations. The three
main reasons for renaming fields are:

1. Two fields are named differently although they denote the same thing:
e The field IDin the Customers table
* The field CustomerlIDin the Orders table

The two fields denote a specific customer identification code and should both be named the
same, for example CustomeriD.

2. Two fields are named the same but actually denote different things:
» The field Datein the Invoices table
e The field Datein the Orders table
The two fields should preferably be renamed, to for example InvoiceDate and OrderDate.

3. There may be errors such as misspellings in the database or different conventions on upper-
and lowercase letters.

Since fields can be renamed in the script, there is no need to change the original data. There are
two different ways to rename fields as shown in the examples.

Example 1: Using the alias statement

The LOAD or SELECT statement can be preceded by an alias statement.

Alias ID as CustomeriD;
LOAD * from Customer.csv;

Example 2: Using the as specifier

The LOAD or SELECT statement can contain the as specifier.

LOAD ID as CustomerID, Name, Address, Zip, City, State from Customer.csv;
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6.8 Concatenating tables

Automatic concatenation

If the field names and the number of fields of two or more loaded tables are exactly the same,
QlikView will automatically concatenate the content of the different statements into one table.

Example:

LOAD a, b, c from tablel.csv;
LOAD a, c, b from table2.csv;

The resulting internal table has the fields a, b and c. The number of records is the sum of the
numbers of records in table 1 and table 2.

The number and names of the fields must be exactly the same. The order of the two
statements is arbitrary.

Forced concatenation

Even if two or more tables do not have exactly the same set of fields, it is still possible to force
QlikView to concatenate the two tables. This is done with the concatenate prefix in the script,
which concatenates a table with another named table or with the last previously created table.

Example:

LOAD a, b, c from tablel.csv;
concatenate LOAD a, c from table2,csv;

The resulting internal table has the fields a, b and c. The number of records in the resulting table is
the sum of the numbers of records in table 1 and table 2. The value of field b in the records coming
from table 2 is NULL.

The number and names of the fields must be exactly the same. Unless a table name of a
previously loaded table is specified in the concatenate statement the concatenate
prefix uses the last previously created table. The order of the two statements is thus not
arbitrary.

Preventing concatenation

If the field names and the number of fields of two or more loaded tables are exactly the same,
QlikView will automatically concatenate the content of the different statements into one table. This
is possible to prevent with a noconcatenate statement. The table loaded with the associated LOAD
or SELECT statement will then not be concatenated with the existing table.
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Example:

LOAD a, b, c from tablel.csv;
noconcatenate LOAD a, b, c from table2.csv;

6.9 Loading data from a previously loaded table

You can use the Resident predicate in a LOAD statement to load data from a previously loaded
table. This is useful when you want to perform calculations on data loaded with a SELECT
statement where you do not have the option to use QlikView functions, such as date or numeric
value handling.

Example:

In this example, the date interpretation is performed in the Resident load as it can't be done in the
initial Crosstable LOAD.

PreBudget:
Crosstable (Month, Amount, 1)
LOAD Account,

Jan,

Feb,

mar,

From Budget;

Budget:

Noconcatenate

LOAD
Account,
Month(Date#(Month, 'MMM')) as Month,
Amount

Resident PreBudget;

Drop Table PreBudget;

A common case for using Resident is where you want to use a temporary table for
calculations or filtering. Once you have achieved the purpose of the temporary table, it
should be dropped using the Drop table statement.

Resident or preceding LOAD?

In most cases, the same result can be achieved by using a preceding LOAD instead, that is, a LOAD
statement that loads from the LOAD or SELECT statement below, without specifying a source
qualifier such as From or Resident that you would normally do. A preceding LOAD is generally the
faster option, but there are some cases where you need to use a ResidentLOAD instead:

 If you want to use the Order_by clause to sort the records before processing the LOAD
statement.
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 If you want to use any of the following prefixes, in which cases preceding LOAD is not
supported:

+ Crosstable
+ Join
¢ Intervalmatch

Preceding LOAD

The preceding LOAD feature allows you to load a table in one pass, but still define several
successive transformations. Basically, it is a LOAD statement that loads from the LOAD or SELECT
statement below, without specifying a source qualifier such as From or Resident that you would
normally do. You can stack any number of LOAD statements this way. The statement at the bottom
will be evaluated first, then the statement above, and so on until the top statement has been
evaluated.

You can achieve the same result using Resident, but in most cases a preceding LOAD will be faster.

Another advantage of preceding load is that you can keep a calculation in one place, and reuse it in
LOAD statements placed above.

The following prefixes cannot be used in conjunction with preceding LOAD:Join,
Crosstable and Intervalmatch.

Example 1: Transforming data loaded by a SELECT statement

If you load data from a database using a SELECT statement, you cannot use QlikView functions to
interpret data in the SELECT statement. The solution is to add a LOAD statement, where you
perform data transformation, above the SELECT statement.

In this example we interpret a date stored as a string using the QlikView function Date# in a LOAD
statement, using the previous SELECT statement as source.

LOAD Date#(OrderDate, 'YYYYMMDD') as OrderDate;
SQL SELECT OrderDate FROM .. ;

Example 2: Simplifying your script by reusing calculations

In this example we use a calculation more than once in the script:

LOAD ...,
Age( Frombate + IterNo() - 1, Birthbate ) as Age,
Date( FromDate + IterNo() - 1 ) as ReferenceDate
Resident Policies
while IterNo() <= ToDate - FromDate + 1 ;
By introducing the calculation in a first pass, we can reuse it in the Age function in a preceding

LOAD:

LOAD ..., ReferenceDate,
Age( ReferenceDate, BirthDate ) as Age;
LOAD *,
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Date( Frombate + IterNo() - 1 ) as ReferenceDate
Resident Policies
while IterNo() <= ToDate - FromDate + 1 ;

6.10 Partial Reload

This command executes only Load and Select statements preceded by a Replace or Add prefix.
Other data tables remain unaffected by the command.

6.11 Dollar-sign expansions

Dollar-sign expansions are definitions of text replacements used in the script or in expressions. This
process is known as expansion - even if the new text is shorter. The replacement is made just
before the script statement or the expression is evaluated. Technically it is a macro expansion.

The expansion always begins with '$(' and ends with ') ' and the content between brackets defines
how the text replacement will be done. To avoid confusion with script macros we will henceforth
refer to macro expansions as dollar-sign expansions.

Dollar-sign expansions can be used with any of:

e variables
* parameters

e expressions

A dollar-sign expansion is limited in how many expansions it can calculate. Any
expansion over 1000 will not be calculated.

Dollar-sign expansion using a variable

When using a variable for text replacement in the script or in an expression, the following syntax is
used:

S (variablename)
$ (variablename) expands to the value in the variable. If variablename does not exist, the expansion
will result in an empty string.

For numeric variable expansions, the following syntax is used:

$ (#variablename)

It always yields a valid decimal-point representation of the numeric value of the variable, possibly
with exponential notation (for very large/small numbers). If variablename does not exist or does not
contain a numeric value, it will be expanded to Oinstead.

Example:
SET DecimalsSep="',"';

LET X = 7/2;
The dollar-sign expansion $(X) will expand to 3,5 while $(#X) will expand to 3.5.
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Example:

Set Mypath=C:\MyDocs\Files\;

LOAD * from $(MyPath)abc.csv;
Data will be loaded from C:|MyDocs|Fileslabc.csv.

Example:

Set CurrentYear=1992;

SQL SELECT * FROM tablel WHERE Year=$(CurrentYear);
Rows with Year=1992 will be selected.

Example:

Set vConcatenate = ;
For each vFile in FileList('.\*.txt'")
Data:
$(vConcatenate)
LOAD * FROM [$(vFile)];
Set vConcatenate = Concatenate ;
Next VvFile

In this example, all .txt files in the directory are loaded using the Concatenate prefix. This may be
required if the fields differ slightly, in which case auto-concatenation does not work. The
vConcatenate variable is initially set to an empty string, as the Concatenate prefix cannot be used
on the first load. If the directory contains three files named file1.txt, file2.txt and file3.txt, the LOAD
statement will during the three iterations expand to:

LOAD * FROM[.\filel.txt];
Concatenate LOAD * FROM[.\file2.txt];
Concatenate LOAD * FROM[.\file3.txt];

Expanding Variables in Alternate States

The variable has only one value, and this is used in all alternate states. When you expand a variable
the value is also the same, independent of where it is made, and the state of the object.

If the variable is a calculated variable, that is, the definition starts with an equals sign, the
calculation is made in the default state, unless you specify an alternate state in the variable
definition.

Example:

If you have a state named mystate, and a variable named vmyvar:

vMyvar: =only({MyState} MyField)
The variable definition content, with an explicit reference to the alternate state name, determines in
which state the variable content will be evaluated.
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Dollar-sign expansion using parameters

Parameters can be used in dollar-sign expansions. The variable must then contain formal
parameters, such as $1, $2, $3 etc. When expanding the variable, the parameters should be stated
in a comma separated list.

Example:

Set MUL="$1*$2";
Set X=$(MUL(3,7)); //returns'3*7'in X

Let Xx=$(MUL(3,7)); //returns 21in X

If the number of formal parameters exceeds the number of actual parameters only the formal
parameters corresponding to actual parameters will be expanded. If the number of actual
parameters exceeds the number of formal parameters the superfluous actual parameters will be
ignored.

Example:

Set MUL="$1%%2";
set x=$(MUL); //returns'$1*$2'in X

set x=$(MUL(10)); //returns '"10*$2'in X
Let X=$(MUL(5,7,8)); //returns 35in X
The parameter $0 returns the number of parameters actually passed by a call.

Example:

set MUL="$1%$2 $0 par';
set X=$(MUL(3,7)); //returns'3*7 2 par'in X

Dollar-sign expansion using an expression

Expressions can be used in dollar-sign expansions. The content between the brackets must then
start with an equal sign:

$ (=expression )
The expression will be evaluated and the value will be used in the expansion.

Example:

$(=Year(Today())); //returns a string with the current year.
$(=only(vear)-1); //returns the year before the selected one.

File inclusion

File inclusions are made using dollar-sign expansions. The syntax is:

S (include=filename )
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The above text will be replaced by the content of the file specified after the equal sign. This feature
is very useful when storing scripts or parts of scripts in text files.

Example:
$(include=C:\Documents\MyScript.qvs);

Dollar expansions and alternate states

A dollar expansion is normally not sensitive to alternate states. There is one exception, if the dollar
expansion has an expression, this is evaluated in the state relevant to the object where the dollar
expansion is made.

Example:

You have a dollar expansion like the following:

$ (=sum(Amount))
The calculation will return the sum of amount based on the selection in the state of the object.

6.12 Using quotation marks in the script

You can use quotation marks in script statements in a number of different ways.

Inside LOAD statements

In a LOAD statement the following marks should be used as quotation marks for field names and
table names:

LOAD statement quotation marks

Symbol description Symbol Code point Example

double quotation marks " " 34 "string"
square brackets [ 91,93 [string]
grave accents o 96 ‘string’

And the following marks should be used as quotation marks for string literals:

String literal quotation marks

Symbol description Symbol Code point Example

single quotation marks '’ 39 "string'

In SELECT statements

For a SELECT statement interpreted by the ODBC driver, it may be slightly different. Usually, you
should use the straight double quotation marks (Alt + 0034) for field and table names, and the
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straight single quotation marks (Alt + 0039) for literals, and avoid using grave accents. However,
some ODBC drivers not only accept grave accents as quotation marks, but also prefer them. In such
a case, the generated SELECT statements contain grave accent quotation marks.

Microsoft Access quotation marks example

Microsoft Access ODBC Driver 3.4 (included in Microsoft Access 7.0) accepts the following
quotation marks when analyzing the SELECT statement:

SELECT statement quotation marks
Symbol description Symbols

Field names and table names: [Jor""or "

String literals:

Other databases may have different conventions.

Outside LOAD statements

Outside a LOAD statement, in places where QlikView expects an expression, double quotation
marks denote a variable reference and not a field reference. If you use double quotation marks, the
enclosed string will be interpreted as a variable and the value of the variable will be used.

Out-of-context field references and table references

Some script functions refer to fields that have already been created, or are in the output of a LOAD
statement, for example Exists() and Peek(). These field references are called out-of-context field
references, as opposed to source field references that refer to fields that are in context, that is, in
the input table of the LOAD statement.

Out-of-context field references and table references should be regarded as literals and therefore
need single quotation marks.

Difference between names and literals

The difference between names and literals becomes clearer comparing the following examples:
Example:

'Sweden' as Country
When this expression is used as a part of the field listin a LOAD or SELECT statement, the text
string "Sweden" will be loaded as field value into the QlikView field "Country".

Example:

"land" as Country

When this expression is used as a part of the field listin a LOAD or SELECT statement, the content
of the database field or table column named "/and" will be loaded as field values into the QlikView
field "Country”. This means. that land will be treated as a field reference.
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Difference between numbers and string literals

The difference between numbers and string literals becomes clearer comparing the following
examples.

Example:

'12/31/96"

When this string is used as a part of an expression, it will in a first step be interpreted as the text
string "12/31/96", which in turn may be interpreted as a date if the date format is 'MM/DD/YY". In
that case it will be stored as a dual value with both a numeric and a textual representation.

Example:

12/31/96
When this string is used as a part of an expression, it will be interpreted numerically as 12 divided by
31divided by 96.

Using quotation marks in a string

When a string contains characters that can be used as quotation marks, it is important to clearly
indicate where a string begins and where it ends when quoting the string. If the string is not
properly quoted, the script will fail or it will load data incorrectly.

There are two methods for quoting a string that contains quotation marks.

Use a specific quotation mark to quote the string

Choose a quotation mark that is not used inside the string, and use it to quote the entire string.
QlikView will use that specific quotation mark to determine where the string begins and ends.

Any of the following quotation marks can be used to quote the entire string:

« Double quotation marks
» Square brackets []

» Grave accents " °

» Single quotation marks "'

Example:
[Table '1 "2"]
Square brackets are used to quote the string. The string loads as: Table '1 "2"

'string "Namel  '"Name2'
Single quotation marks are used to quote the string. The string loads as: string ‘Name1" "Name2

Use escape characters

Escape characters are an additional instance of the quotation mark that is used to quote the string.
They must be added beside every instance of the quotation mark that appears within the string.
When all quotation marks are used inside a string, you need to add escape characters beside the
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same type of quotation mark used to quote the string. Escape characters can also be used if you
want to use a quotation mark that is already in use in a string.

Only the following marks can be used as escape characters:

» Double quotation marks
» Square brackets []
e Single quotation marks "'

Example:

"Michael said ""It's a beautiful day
If you quote the string using the double quotation marks " ", then you must add an extra double
quotation mark beside every double quotation mark used inside the string.

This string is loaded as Michael said "It's a beautiful day". By using the escape character "", the
QlikView script editor understands which double quotation marks are part of the string and which
quotation mark indicates the end of the string. The single quotation mark ' used in the abbreviation
It's does not need an escape because it is not the mark used to quote the string.

Example:

'Michael said: "It''s a beautiful day".'
If you quote this string using single quotation marks, then you must add an extra single quotation
mark beside each single quotation mark used inside the string.

This string is loaded as Michael said "It's a beautiful day". The double quotation mark " used for
quoting what Michael said does not need to be escaped because it is not the mark used to quote
the string.

Example:

[Michael said [It's a "beautiful day]].]

Square brackets [ ] behave differently from the other two quotation marks. If you want to use
brackets as an escape character, you must add an extra bracket beside the right square bracket ]
only, and not beside the left square bracket [.

This string is loaded as Michael said [It's a "beautiful day]. Only the right square bracket] is
escaped. The single quotation mark ' and the double quotation mark " used in the string do not need
to be escaped as they are not used to quote the string.

6.13 Wild cards in the data

Itis also possible to use wild cards in the data. Two different wild cards exist: the star symbol,
interpreted as all values of this field, and an optional symbol, interpreted as all remaining values of
this field.
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The star symbol

The star symbol is interpreted as all (listed) values of this field, that is, a value listed elsewhere in
this table. If used in one of the system fields (USERID, PASSWORD, NTNAME or SERIAL) in a table
loaded in the access section of the script, it is interpreted as all (also not listed) possible values of
this field.

The star symbol is not allowed in information files. Also, it cannot be used in key fields, that is, fields
used to join tables.

There is no star symbol available unless explicitly specified.

OtherSymbol

In many cases a way to represent all other values in a table is needed, that is, all values that were
not explicitly found in the loaded data. This is done with a special variable called OtherSymbol. To
define the OtherSymbol to be treated as "all other values", use the following syntax:

SET OTHERSYMBOL=<sym>;
before a LOAD or SELECT statement. <sym> may be any string.

The appearance of the defined symbol in an internal table will cause QlikView to define it as all
values not previously loaded in the field where it is found. Values found in the field after the
appearance of the OtherSymbol will thus be disregarded.

In order to reset this functionality use:

SET OTHERSYMBOL=;

Example:

Table Customers

Table Customers example data

CustomeriD Name

1 ABC Inc.

2 XYZ Inc.

3 ACME INC

+ Undefined
Table Orders

Table Orders example data

CustomeriD Name
1 1234
3 1243
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CustomeriD Name
5 1248
7 1299

Insert the following statement in the script before the point where the first table above is loaded:

SET OTHERSYMBOL=+;
Any reference to a CustomerID other than 1, 2 or 3, e.g. as when clicking on OrderID 1299 will result
in Undefined under Name.

OtherSymbol is not intended to be used for creating outer joins between tables.

6.14 NULL value handling

When no data can be produced for a certain field as a result of a database query and/or a join
between tables, the result is normally a NULL value.

The QlikView logic treats the following as real NULL values:

e NULL values returned from an ODBC connection
» NULL values created as a result of a forced concatenation of tables in the load script
» NULL values created as a result of a join made in the load script

» NULL values created as a result of the generation of field value combinations to be displayed
in a table

It is generally impossible to use these NULL values for associations and selections,
except when the NullAsValue statement is being employed.

Text files per definition cannot contain NULL values.

Associating/selecting NULL values from ODBC

It is possible to associate and/or select NULL values from an ODBC data source. For this purpose a
script variable has been defined. The following syntax can be used:

SET NULLDISPLAY=<sym>;
The symbol <sym> will substitute all NULL values from the ODBC data source on the lowest level of
data input. <sym> may be any string.

In order to reset this functionality to the default interpretation, use the following syntax:

SET NULLDISPLAY=;

The use of NULLDISPLAY only affects data from an ODBC data source.
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If you wish to have the QlikView logic interpret NULL values returned from an ODBC connection as
an empty string, add the following to your script before any SELECT statement:

SET NULLDISPLAY=";

Here "is actually two single quotation marks without anything in between.

Creating NULL values from text files

Itis possible to define a symbol, which when it occurs in a text file or an inline clause will be
interpreted as a real NULL value. Use the following statement:

SET NULLINTERPRET=<sym>;
The symbol <sym> is to be interpreted as NULL. <sym> may be any string.

In order to reset this functionality to the default interpretation, use:

SET NULLINTERPRET=;

The use of NULLINTERPRET only affects data from text files and inline clauses.

Propagation of NULL values in expressions

NULL values will propagate through an expression according to a few logical and quite reasonable
rules.

Functions

The general rule is that functions return NULL when the parameters fall outside the range for which
the function is defined.

Example:

e asin(2) returns NULL
e log(-5) returns NULL
e round (A, 0) returns NULL

As a result of the above follows that functions generally return NULL when any of the parameters
necessary for the evaluation are NULL.

Example:

e sin (NULL) returns NULL

e chr (NULL) returns NULL

e if (NULL, A, B) returnsB

e if (True, NULL, A) returnsNULL
e if(True, A, NULL) returnsa

The exception to the second rule are logical functions testing for type.
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Example:

e isnull (NULL) returns True (-1)
e isnum (NULL) returns False (0)

Arithmetic and string operators

If NULL is encountered on any side of these operators NULL is returned.

Example:

+ NULL returns NULL
- NULL returns NULL
/ NULL returns NULL

L]
b

* NULL returns NULL
e NULL / Areturns NULL
e 0 / NULL returns NULL
e 0 * NULLreturns NULL
e A & NULLreturnsa

Relational operators

If NULL is encountered on any side of relational operators special rules apply.

Example:

e NULL rel.op NULL returns NULL
e A <> NULLreturns True (-1)

e A < NULL returns False (0)

<= NULL returns False (0)

A
e A = NULL returns False (0)
A >=returns False (0)

A

> NULL returns False (0)

6.15 QVD files

A QVD (QlikView Data) file is a file containing a table of data exported from Qlik Sense or QlikView.
QVD is a native Qlik format and can only be written to and read by Qlik Sense or QlikView. The file

format is optimized for speed when reading data from a QlikView script but it is still very compact.
Reading data from a QVD file is typically 10-100 times faster than reading from other data sources.

QVD files can be read in two modes: standard (fast) and optimized (faster). The selected mode is
determined automatically by the QlikView script engine. Optimized mode can be utilized only when
all loaded fields are read without any transformations (formulas acting upon the fields), though the
renaming of fields is allowed. A WHERE clause causing QlikView to unpack the records will also
disable the optimized load. An optimized .qvd is extracted and handled according to standard
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Extract-Transform-Load (ETL ) when a field transformation is performed, this results in a
degradation of performance. The specified format will not be maintained and the underlying raw
number format will be used instead and recognized. Transformations of the field in a .qvd is
allowed, the former "Optimized" .qvd then becomes a standard non-optimized .qvd.

A QVD file holds exactly one data table and consists of three parts:

1. A well formed XML header (in UTF-8 char set) describing the fields in the table, the
layout of the subsequent information and some other meta-data.

2. Symbol tables in a byte stuffed format.
3. Actual table data in a bit-stuffed format.

Purpose of QVD Files

QVD files can be used for many purposes. At least four major uses can be easily identified. More
than one may apply in any given situation:

Increasing Load Speed

By buffering non-changing or slowly changing blocks of input data in QVD files, script execution
becomes considerably faster for large data sets.

Decreasing Load on Database Servers

The amount of data fetched from external data sources can also be greatly reduced. This reduces
work load on external databases and network traffic. Furthermore, when several QlikView scripts
share the same data it is only necessary to load it once from the source database into a QVD file.
The other applications can make use of the same data via this QVD file.

Consolidating Data from Multiple QlikView Applications

With the binary script statement it is possible to load data from only one single QlikView application
into another one, but with QVD files a QlikView script can combine data from any number of
QlikView applications. This opens up possibilities e.g. for applications consolidating similar data
from different business units etc.

Incremental Load

In many common cases the QVD functionality can be used for facilitating incremental load, i.e.
exclusively loading new records from a growing database.

Create QVD Files

A QVD file can be created by one of three different methods:

1. Explicit creation and naming using the store command in the QlikView script. Simply
state in the script that a previously read table or part thereof is to be exported to an
explicitly named file at a location of your choice.

2. Automatic creation and maintenance from script. By preceding a load or select
statement with the buffer prefix, QlikView will automatically create a QVD file which
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under certain conditions can be used instead of the original data source when
reloading data.

3. Explicit, manual creation and naming from layout or via the Internal Macro
Interpreter. Data can be exported from the QlikView layout via GUI commands or
Automation macros. In the GUI you will find QVD as one of the possible export formats
under the Export... command, found on the object menu of most sheet objects.

There is no difference between the resulting QVD files, with regard to reading speed.

Reading Data from QVD Files

A QVD file can be read into or accessed by QlikView by the following methods:

1. Loading a QVD file as an explicit data source. QVD files can be referenced by a load
statement in the QlikView script just like any other type of text files (csv, fix, dif, biff
etc). The File Wizard: Type handles QVD files by the same principles.

Examples:

Toad * from xyz.qvd (qvd);
Toad Name, RegNo from xyz.qvd (qvd);
Toad Name as a, RegNo as b from xyz.qvd (qvd);

2. Automatic loading of buffered QVD files. When using the buffer prefix on load or
select statements, no explicit statements for reading are necessary. QlikView will
determine the extent to which it will use data from the QVD file as opposed to
acquiring data via the original load or select statement.

3. Accessing QVD files via the script. A number of script functions (all beginning with
qvd) can be used for retrieving various information on the data found in the XML
header of a QVD file.

Importing QVD with asterisks are not supported.

QVD encryption

You can encrypt sensitive data in QVD files with customer supplied key pairs which allows you to
control who gets access to your data.

The encryption is configured in the settings.inifile where encryption is enabled and the certificate
thumbprint is added. QVD encryption is not enabled by default.

Older versions of Qlik Sense and QlikView returns an error when reading encrypted QVD files.

6.16 Direct Discovery

Direct Discovery is deprecated as of QlikView May 2023. If you want to use Direct Discovery with
QlikView, you must contact Qlik Support for instructions how to activate it. For instruction in using
Direct Discovery, refer to the QlikView May 2022 help.
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6.17 Best practices for data modeling

This section describes a number of different ways you can load your data into the QlikView
document, depending on how the data is structured and which data model you want to achieve.

In general, the way you load data into the document can be explained by the Extract, Transform and
Load process:

1.

Extract
The first step is to extract data from the data source system. In the script, you use SELECT or
LOAD statements to define this. The differences between these statements are:

* SELECT is used to select data from an ODBC data source or OLE DB provider. The
SELECT SQL statement is evaluated by the data provider, not by QlikView.

* LOAD is used to load data from a file, from data defined in the script, from a previously
loaded table, from a web page, from the result of a subsequent SELECT statement or
by generating data automatically

Transform
The transformation stage involves manipulating the data using script functions and rules to
derive the desired data model structure. Typical operations are:

 Calculating new values

» Translating coded values
« Renaming fields

« Joining tables

« Aggregating values

» Pivoting

« Data validation

Load
In the final step, you run the script to load the data model you have defined into the
document.

Your goal should be to create a data model that enables efficient handling of the data in QlikView.
Usually this means that you should aim for a reasonably normalized star schema or snowflake
schema without any circular references, that is, a model where each entity is kept in a separate
table. In other words a typical data model would look like this:

» acentral fact table containing keys to the dimensions and the numbers used to calculate

measures (such as number of units, sales amounts, and budget amounts).

» surrounding tables containing the dimensions with all their attributes (such as products,

customers, categories, calendar, and suppliers) .

In many cases it is possible to solve a task, for example aggregations, either by building
a richer data model in the load script, or by performing the aggregations in the chart
expressions. As a general rule, you will experience better performance if you keep data
transformations in the load script.
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It's good practice to sketch out your data model on paper. This will help you by providing
structure to what data to extract, and which transformations to perform.

Each table in your data model usually corresponds to either a SELECT or LOAD statement. The
differences between these statements are:

e SELECT is used to select data from an ODBC data source or OLE DB provider. The
SELECT SQL statement is evaluated by the data provider, not by QlikView.

» LOAD is used to load data from a file, from data defined in the script, from a previously
loaded table, from a web page, from the result of a subsequent SELECT statement or by
generating data automatically

Using QVD files for incremental load

Incremental load is a very common task in relation to data bases. It is defined as loading nothing but
new or changed records from the database. All other data should already be available, in one way
or another. With QVD files (page 1917) it is possible to perform incremental load in most cases.

The basic process is described below:

1. Load the new data from Database table (a slow process, but loading a limited number of
records).

2. Load the old data from QVD file (loading many records, but a much faster process).
3. Create a new QVD file.
4. Repeat the procedure for every table loaded.

The complexity of the actual solution depends on the nature of the source database, but the
following basic cases can be identified:

1) Case 1: Append Only (page 195) (typically log files

2) Case 2: Insert Only (No Update or Delete) (page 196)
3) Case 3: Insert and Update (No Delete) (page 196)

4) Case 4: Insert, Update and Delete (page 197)

Below you will find outlined solutions for each of these cases. The reading of QVD files can be done
in either optimized mode or standard mode. (The method employed is automatically selected by the
QlikView script engine depending on the complexity of the operation.) Optimized mode is (very
approximately) about 10x faster than standard mode or about 100x faster than loading the
database in the ordinary fashion.

Case 1: Append Only

The simplest case is the one of log files; files in which records are only appended and never
deleted. The following conditions apply:
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» The database must be a log file (or some other file in which records are appended and not
inserted or deleted) which is contained in a text file (ho ODBC/OLE DB).

» QlikView keeps track of the number of records that have been previously read and loads only
records added at the end of the file.

Example:
Buffer (Incremental) Load * From LogFile.txt (ansi, txt, delimiter 1is '\t', embedded Tabels);

Case 2: Insert Only (No Update or Delete)

If the data resides in a database other than a simple log file the case 1 approach will not work.
However, the problem can still be solved with minimum amount of extra work. The following
conditions apply:

e The data source can be any database.
* QlikView loads records inserted in the database after the last script execution.

» A field ModificationDate (or similar) is required for QlikView to recognize which records are
new.

Example:

QV_Table:

SQL SELECT PrimaryKey, X, Y FROM DB_TABLE

WHERE ModificationTime >= #$(LastExecTime)#

AND ModificationTime < #$(BeginningThisExecTime)#;

concatenate LOAD PrimaryKey, X, Y FROM File.qQvD (qvd);
STORE QV_Table INTO File.QVD;

(The hash signs in the SQL WHERE clause define the beginning and end of a date. Check your
database manual for the correct date syntax for your database.)

Case 3:Insert and Update (No Delete)

The next case is applicable when data in previously loaded records may have changed between
script executions. The following conditions apply:

* The data source can be any database.

« QlikView loads records inserted into the database or updated in the database after the last
script execution

« A field ModificationDate (or similar) is required for QlikView to recognize which records are
new.

» A primary key field is required for QlikView to sort out updated records from the QVD file.

» This solution will force the reading of the QVD file to standard mode (rather than optimized),
which is still considerably faster than loading the entire database.

Example:

QV_Table:
SQL SELECT PrimaryKey, X, Y FROM DB_TABLE
WHERE ModificationTime >= #$(LastExecTime)#;
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Concatenate LOAD PrimaryKey, X, Y FROM File.QvD
WHERE NOT Exists(PrimaryKey);

STORE QV_Table INTO File.QvD;

Case 4: Insert, Update and Delete

The most difficult case to handle is when records are actually deleted from the source database
between script executions. The following conditions apply:

e The data source can be any database.

« QlikView loads records inserted into the database or updated in the database after the last
script execution.

* QlikView removes records deleted from the database after the last script execution.

» A field ModificationDate (or similar) is required for QlikView to recognize which records are
new.

» A primary key field is required for QlikView to sort out updated records from the QVD file.

» This solution will force the reading of the QVD file to standard mode (rather than optimized),
which is still considerably faster than loading the entire database.

Example:

Let ThisExecTime = Now( );

QV_Table:

SQL SELECT PrimaryKey, X, Y FROM DB_TABLE
WHERE ModificationTime >= #$(LastExecTime)#
AND ModificationTime < #$(ThisExecTime)#;

Concatenate LOAD PrimaryKey, X, Y FROM File.QVvD
WHERE NOT EXISTS(PrimaryKey);

Inner Join SQL SELECT PrimaryKey FROM DB_TABLE;

If ScriptErrorCount = 0 then
STORE QV_Table INTO File.QvD;
Let LastExecTime = ThisExecTime;
End If

Combining tables with Join and Keep

Ajoin is an operation that takes two tables and combines them into one. The records of the
resulting table are combinations of records in the original tables, usually in such a way that the two
records contributing to any given combination in the resulting table have a common value for one or
several common fields, a so-called natural join. In QlikView, joins can be made in the script,
producing logical tables.

The QlikView logic will then not see the separate tables, but rather the result of the join, which is a
single internal table. In some situations this is needed, but there are disadvantages:
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» The loaded tables often become larger, and QlikView works slower.

« Some information may be lost: the frequency (number of records) within the original table
may no longer be available.

The Keep functionality, which has the effect of reducing one or both of the two tables to the
intersection of table data before the tables are stored in QlikView, has been designed to reduce the
number of cases where explicit joins needs to be used.

In this documentation, the term join is usually used for joins made before the internal
tables are created. The association, made after the internal tables are created, is
however essentially also a join.

Join
The simplest way to make a join is with the Join prefix in the script, which joins the internal table

with another named table or with the last previously created table. The join will be an outer join,
creating all possible combinations of values from the two tables.

Example:

LOAD a, b, c from tablel.csv;
join LOAD a, d from table2.csv;

The resulting internal table has the fields a, b, c and d. The number of records differs depending on
the field values of the two tables.

The names of the fields to join over must be exactly the same. The number of fields to
join over is arbitrary. Usually the tables should have one or a few fields in common. No
field in common will render the cartesian product of the tables. All fields in common is
also possible, but usually makes no sense. Unless a table name of a previously loaded
table is specified in the Join statement the Join prefix uses the last previously created
table. The order of the two statements is thus not arbitrary.

Keep

One of the main features of QlikView is its ability to make associations between tables instead of
joining them, which reduces space in memory, increases speed and gives enormous flexibility. The
keep functionality has been designed to reduce the number of cases where explicit joins need to be
used.

The Keep prefix between two LOAD or SELECT statements has the effect of reducing one or both
of the two tables to the intersection of table data before they are stored in QlikView. The Keep
prefix must always be preceded by one of the keywords Inner, Left or Right. The selection of
records from the tables is made in the same way as in a corresponding join. However, the two
tables are not joined and will be stored in QlikView as two separately named tables.

Inner

The Join and Keep prefixes in the QlikView script language can be preceded by the prefix Inner.

Working with QlikView - QlikView, May 2024 198



6 Introduction to loading data

If used before Join, it specifies that the join between the two tables should be an inner join. The
resulting table contains only combinations between the two tables with a full data set from both
sides.

If used before Keep, it specifies that the two tables should be reduced to their common intersection
before being stored in QlikView.

Example:

In these examples we use the source tables Table1 and Table2:

Tablel Table2
A B A C
aa 1 MK
ot 4 VY
ee

Inner examples source tables

First, we perform an Inner Join on the tables, resulting in VTable, containing only one row, the only
record existing in both tables, with data combined from both tables.

VTable:
SELECT * from Tablel;
inner join SELECT * from Table2;

VTable
A B C
| 1 | aa | i

Inner Join example

If we perform an Inner Keep instead, you will still have two tables. The two tables are of course
associated via the common field A.

VTabl:

SELECT * from Tablel;

VTab2:

inner keep SELECT * from Table2;
VTabl VTab2
A B A C

] e | [t ] =

Inner Keep example

Left

The Join and Keep prefixes in the QlikView script language can be preceded by the prefix left.
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If used before Join, it specifies that the join between the two tables should be a left join. The
resulting table only contains combinations between the two tables with a full data set from the first
table.

If used before Keep, it specifies that the second table should be reduced to its common
intersection with the first table before being stored in QlikView.

Example:

In these examples we use the source tables Table1 and Table2:

Tablel Table2
A B A C
aa 1 MK
ot 4 VY
ee

Left examples source tables

First, we perform a Left Join on the tables, resulting in VTable, containing all rows from Table1,
combined with fields from matching rows in Table2.

VTable:
SELECT * from Tablel;
Teft join SELECT * from Table2;

VTable
A B C
1 aa KX
2 cC -
3 e -

Left Join example

If we perform an Left Keep instead, you will still have two tables. The two tables are of course
associated via the common field A.

VTabl:
SELECT * from Tablel;
VTab2:
Teft keep SELECT * from Table2;
VTabl VTah2
A B A C
1 = =
2 ce
3 2

Left Keep example
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Right
The Join and Keep prefixes in the QlikView script language can be preceded by the prefix right.

If used before Join, it specifies that the join between the two tables should be a right join. The
resulting table only contains combinations between the two tables with a full data set from the
second table.

If used before Keep, it specifies that the first table should be reduced to its common intersection
with the second table before being stored in QlikView.

Example:

In these examples we use the source tables Table1 and Table2:

Tablel Table2
A B A C
aa 1 MK
ot 4 VY
ee

Right examples source tables

First, we perform a Right Join on the tables, resulting in VTable, containing all rows from Table2,
combined with fields from matching rows in Table1.

VTable:
SELECT * from Tablel;
right join SELECT * from Table2;

VTable
A B C
1 aa | XX
4 - vy
Right Join example

If we perform an Right Keep instead, you will still have two tables. The two tables are of course
associated via the common field A.

VTabl:
SELECT * from Tablel;
VTab2:
right keep SELECT * from Table2;
VTabl VTab2
A B A C
| 1 | aa | 1 xx
4 ¥y
Right Keep example
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Using mapping as an alternative to joining

The Join prefix in QlikView is a powerful way of combining several data tables in the data model.
One disadvantage is that the combined tables can become large and create performance problems.
An alternative to Join in situations where you need to look up a single value from another table is to
use mapping instead. This can save you from loading unnecessary data that slows down
calculations and potentially can create calculation errors, as joins can change the number of
records in the tables.

A mapping table consists of two columns; a comparison field (input) and a mapping value field
(output).

In this example we have an table of orders (Orders), and need to know the country of the customer,
which is stored in the customer table (Customers).

Orders data table
OrderID OrderDate ShipperiD Freight CustomerlID
12987 2007-12-01 1 27 3
12988 2007-12-01 1 65 4
12989 2007-12-02 2 32 2
12990 2007-12-03 1 76 3

Customers data table

CustomeriD Name Country
1 DataSales Spain

2 BusinessCorp Italy

3 TechCo Germany
4 Mobecho France

In order to look up the country (Country) of a customer, we need a mapping table that looks like
this:

Country mapping table
CustomeriD Country

1 Spain

2 Italy

3 Germany
4 France

The mapping table, which we name MapCustomerIDtoCountry, is defined in the script as follows:
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MapCustomerIDtoCountry:
Mappi ng LOAD CustomerID, Country From Customers ;

The next step is to apply the mapping, using the ApplyMap function, when loading the order table:

orders:
S :':’
ApplyMap('MapCustomerIDtoCountry', CustomerID, null()) as Country
From Orders ;

The third parameter of the ApplyMap function is used to define what to return when the value is not
found in the mapping table, in this case Null().

The resulting table will look like this:

Result mapping table
OrderID OrderDate ShipperID Freight CustomeriD Country

12987 2007-12-01 1 27 3 Germany
12988 2007-12-01 1 65 4 France
12989 2007-12-02 2 32 2 Italy
12990 2007-12-03 1 76 3 Germany

Working with cross tables

A cross table is a common type of table featuring a matrix of values between two orthogonal lists of
header data. It could look like the table below.

Example 1:

Example cross table 1
Year Jan Feb Mar Apr May Jun

2008 45 65 78 12 78 22
2009 1 23 22 22 45 85
2010 65 56 22 79 12 56
20M 45 24 32 78 55 15
2012 45 56 35 78 68 82

If this table is simply loaded into QlikView, the result will be one field for Year and one field for each
of the months. This is generally not what you would like to have. You would probably prefer to have
three fields generated: one for each header category (Yearand Month) and one for the data values
inside the matrix.

This can be achieved by adding the crosstable prefix to the LOAD or SELECT statement, for
example:

crosstable (Month, Sales) LOAD * from exl.xl1sx;
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This creates the following result in QlikView:

Bl o [
Year_. Month Sales
2003 Apr 12
2008 Feb 65
20058 Jan 45
2005 Jun 22
2005 Mar 7
2005 May 70
2009 Apr 22
2009 Feb 23
2009 Jan 11
2009 Jun a5
2009 Mar 22
20N MAw 45

The cross table is often preceded by a number of qualifying columns, which should be read in a
straightforward way. In this case there is one qualifying column, Year:

Example 2:
Example cross table 2
Salesman Year Jan Feb Mar Apr May Jun
A 2008 45 65 78 12 78 22
A 2009 1 23 22 22 45 85
A 2010 65 56 22 79 12 56
A 20M 45 24 32 78 55 15
A 2012 45 56 35 78 68 82
B 2008 57 77 90 24 90 34
B 2009 23 35 34 34 57 97
B 2010 77 68 34 91 24 68
B 20M 57 36 44 90 67 27
B 2012 57 68 47 90 80 94

In this case there are two qualifying columns to the left, followed by the matrix columns. The
number of qualifying columns can be stated as a third parameter to the crosstable prefix as
follows:

crosstable (Month, Ssales, 2) LOAD * from ex2.x1sx;
This creates the following result in QlikView:
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Bl B
Salesman_. Year Month Sales
A 2008 Apr 12
A 2005|Feb 65
A 2008 Jan 45
A 2005 Jun 22
A 2005 Mar 7a
A 2003 May 7a
A 2009 Apr 22
A 2009|Feb 23
A 2009 Jan 11
A 2009 Jun a5
A 2009 Mar 22
A 2009 May 45
A 2010 Apr 79

Generic databases

A generic database is a table in which the field names are stored as field values in one column, while
the field values are stored in a second. Generic databases are usually used for attributes of
different objects.

Look at the example GenericTable below. It is a generic database containing two objects, a ball and
a box. Obviously some of the attributes, like color and weight, are common to both the objects,
while others, like diameter, height, length and width are not.

Generic example table

object attribute value

ball color red

ball diameter 10 cm
ball weight 10049
box color black
box height 16 cm
box length 20cm
box weight 50049
box width 10 cm

On one hand it would be awkward to store the data in a way giving each attribute a column of its
own, since many of the attributes are not relevant for a specific object.

On the other hand, it would look messy displaying it in a way that mixed lengths, colors and weights.

If this database is loaded into QlikView using the standard way and display the data in a table it
looks like this:
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object +&  attribute + value e
ball colar 10cm
b diarmeter 16 cm

hieight Z0cm

lenath 10049

weight SO0 g

widkh black.

red

However, if the table is loaded as a generic database, column two and three will be split up into
different tables, one for each unique value of the second column:

object » color #  weight »
baill black. 100 g
b red 500 g length £
. 20cm
diameter 2 width #  height
10 crm 10 em 16 cm

The syntax for doing this is simple:
Example:

Generic SELECT* from GenericTable;
It does not matter whether a LOAD or SELECT statement is used to load the generic database.

Matching intervals to discrete data

The intervalmatch prefix to a LOAD or SELECT statement is used to link discrete numeric values to
one or more numeric intervals. This is a very powerful feature which can be used, for example, in
production environments as shown in the example below.

Example:

Look at the two tables below. The first table shows the start and end of production of different
orders. The second table shows some discrete events. How can we associate the discrete events
with the orders, so that we know, for example, which orders were affected by the disturbances and
which orders were processed by which shifts?

Table OrderLog
Start End Order
01:00 03:35 A
02:30 07:58 B
03:04 10:27 C
07:23 11:43 D
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Table EventLog

Time Event Comment

00:00 0 Start of shift 1
01:18 1 Line stop

02:23 2 Line restart 50%
04:15 3 Line speed 100%
08:00 4 Start of shift 2
11:43 5 End of production

First, load the two tables as usual and then link the field Time to the intervals defined by the fields

Starta

SELECT
SELECT

nd End.

* from orderLog;
* from EventLog;

Intervalmatch (Time) SELECT Start,End from OrderLog;
You can now create a table in QlikView as below:

Time
.00
1:18
2123
4:15
4:15
.00
.00

11:43

-
Event Comment Order Start End

0 Skark af shift 1 - - -
1 Line stop o, oo &35
2 Line restark S0% A oo 335
3 Line speed 100%: B 230 758
3 Line speed 100%: C a04 127
4 Skark of shift 2 304 1027
4 Stark of shift 2 D 723 1143
5 End of production T 7231143

We can now easily see that mainly order A was affected by the line stop but that the reduced line

speed

affected also orders Band C. Only the orders C and D were partly handled by Shift 2.

Note the following points when using intervalmatch:

Before the intervalmatch statement, the field containing the discrete data points (Timein
the example above) must already have been read into QlikView. The intervalmatch
statement does not read this field from the database table!

The table read in the intervalmatch LOAD or SELECT statement must always contain exactly
two fields (Start and Endin the example above). In order to establish a link to other fields you
must read the interval fields together with additional fields in a separate LOAD or SELECT
statement (the first SELECT statement in the example above).

The intervals are always closed, that is, the end points are included in the interval. Non-
numeric limits render the interval to be disregarded (undefined) while NULL limits extend the
interval indefinitely (unlimited).

The intervals may be overlapping and the discrete values will be linked to all matching
intervals.
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Using the extended intervalmatch syntax to resolve slowly changing
dimension problems

The extended intervalmatch syntax can be used for handling of the well-known problem of slowly
changing dimensions in source data.

Sample script:
SET NullInterpret='";

IntervalTable:
LOAD Key, VvalidFrom, Team from IntervalTable.xls;
NuTlTAsvalue FirstDate,LastDate;

Key:

LOAD

Key,

validFrom as FirstDate,

date(if(Key=previous(Key),

previous(validFrom) - 1)) as LastDate,

Team

RESIDENT IntervalTable order by Key, validFrom desc;

drop table IntervalTable;

Transact:
LOAD Key, Name, Date, Sales from Transact.xls;

INNER JOIN intervalmatch (Date,Key) LOAD FirstDate, LastDate, Key RESIDENT Key;
The nullinterpret statement is only required when reading data from a table file since missing
values are defined as empty strings instead of NULL values.

Loading the data from IntervalTable would result in the following table:

Example table 1

Key FirstDate Team
000110 2011-01-21 Southwest
000110 - Northwest
000120 - Northwest
000120 2013-03-05 Southwest
000120 2013-03-05 Northwest
000120 2013-01-06 Southwest

The nullasvalue statement allows NULL values to map to the listed fields.

Create Key, FirstDate, LastDate, (attribute fields) by using previous and order by and thereafter

the IntervalTable is dropped having been replaced by this key table.

Loading the data from Transact would result in the following table:
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Example table 2

Name Date Sales

Key

000110
000110
000110
000110
000120
000120
000120
000120
000120

Spengler Aaron
Spengler Aaron
Spengler Aaron
Spengler Aaron
Ballard John
Ballard John
Ballard John
Ballard John
Ballard John

2009-08-18
2009-12-25
2011-02-03
2011-05-05
2011-06-04
2013-01-20
2013-03-10
2013-03-13
2013-09-21

100
200
300
400
500
600
700
800
900

The intervalmatch statement preceded by the inner join replaces the key above with a synthetic
key that connects to the Transact table resulting in the following table:

Example table 3

Key Team Name FirstDate LastDate Date Sales
000110 Northwest Spengler - 2011-01-20  2009-08- 100
Aaron 18
000110 Northwest Spengler - 2011-01-20  2009-12- 200
Aaron 25
000110 Southwest Spengler 2011-01-21 - 2011-02-03 300
Aaron
000110 Southwest Spengler 2011-01-21 - 2011-05-05 400
Aaron
000120 Northwest Ballard John - 2013-01-05 2011-06-04 500
000120 Southwest Ballard John 2013-01-06 2013-03- 2013-01-20 600
04
000120 Southwest Ballard John 2013-03- - 2013-03- 700
05 10
000120 Southwest Ballard John 2013-03- - 2013-03- 800
05 13
000120 Southwest Ballard John 2013-03- - 2013-09-21 900
05
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Creating a date interval from a single date

Sometimes time intervals are not stored explicitly with a beginning and an end. Instead they are
implied by only one field — the change timestamp.

It could be as in the table below where you have currency rates for multiple currencies. Each
currency rate change is on its own row; each with a new conversion rate. Also, the table contains
rows with empty dates corresponding to the initial conversion rate, before the first change was
made.

Currency conversion rates

Currency Change Date Rate

EUR - 8.59
EUR 28/01/2013 8.69
EUR 15/02/2013 8.45
usD - 6.50
usD 10/01/2013 6.56
usD 03/02/2013 6.30

This table defines a set of non-overlapping intervals, where the begin data is called “Change Date”
and the end date is defined by the beginning of the following interval. But since the end date isn’t
explicitly stored in a column of its own, we need to create such a column, so that the new table will
become a list of intervals.

Do the following:

1. Create afile called Rates.xIsx containing the table shown above and store it ready for
loading.
Make sure that the dates in the Change Date column are in the same format as the local date
format.

2. Determine which time range you want to work with. The beginning of the range must be
before the first date in the data and the end of the range must be after the last.

3. Load the source data, but change empty dates to the beginning of the range defined in the
previous bullet. The change date should be loaded as “From Date”.

4. Sort the table first according to Currency, then according to the “From Date” descending so
that you have the latest dates on top.

5. Run a second pass through data where you calculate the “To Date”. If the current record has
a different currency from the previous record, then it is the first record of a new currency
(but its last interval), so you should use the end of the range defined in step 1. If it is the same
Currency, you should take the “From Date” from the previous record, subtract a small amount
of time, and use this value as “To Date” in the current record.

The script listed below will update the source table in the following manner:
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Updated table
Currency Rate FromDate ToDate
EUR 8.45 15/02/2013 vEndTime
EUR 8.69 28/01/2013 14/02/2013 23:59:59
EUR 8.59 vBeginTime 28/01/2013 23:59:59
usD 6.30 03/02/2013 vEndTime
usD 6.56 10/01/2013 2/02/2013 23:59:59
usD 6.50 vBeginTime 9/01/2013 23:59:59

The QlikView script looks like this:

Let vBeginTime = Num('1/1/2013");

Let VEndTime Num('1/3/2013');

Let VvEpsilon Pow(2,-27);

Tmp_Rates:

LOAD Currency, Rate,
Date(If(IsNum([Change Date]),

From 'C:\MyFiles\Rates.xl1sx'

(ooxm1, embedded labels, table is Sheetl);

[Change Date]

Rates:
LOAD Currency, Rate, FromDate,
Date(If( Currency=Peek(Currency),
Peek (Frombate) - $(#vEpsilon),
$ (#vEndTime)
)) as ToDate
Resident Tmp_Rates
order By Currency, FromDate Desc;

Drop Table Tmp_Rates;

When this script is run, you will have a table listing the

, $(#vBeginTime))) as FromDate

intervals correctly.

This table can subsequently be used in a comparison with an existing date using the Intervalmatch

methods.

Hierarchies

Unbalanced n-level hierarchies are often used to represent among other things, geographical or
organizational dimensions in data. These types of hierarchies are usually stored in an adjacent
nodes table, that is, in a table where each record corresponds to a node and has a field that

contains a reference to the parent node.

ModelD ParentModelD Title

- General manager

1 Region manager

2 Branch manager

3 Department manager

a2 pa
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In such a table, the node is stored on one record only but can still have any number of children. The
table may of course contain additional fields describing attributes for the nodes.

An adjacent nodes table is optimal for maintenance, but difficult to use in everyday work. Instead, in
queries and analysis, other representations are used. The expanded nodes table is one common
representation, where each level in the hierarchy is stored in a separate field. The levels in an
expanded nodes table can easily be used e.g. in a tree structure.The hierarchy keyword can be
used in the load script to transform an adjacent nodes table to an expanded nodes table.

Example:

Hierarchy (NodeID, ParentNodeID, Title, 'Manager') LOAD

NodeID,

ParentNodelID,

Title

FROM 'hierarchy.txt' (txt, codepage is 1252, embedded Tabels, delimiter is ',', msq);
Nodelll ParentNodelD Title Titlel Title2 Title3 Titled
1 - General manager General manager
2 1 Region manager General manager Region manager
3 2 Branch manager General manager Region manager Branch manager
3 Degartment manager General manager Region manager Branch manager Department manager

A problem with the expanded nodes table is that it is not easy to use the level fields for searches or
selections, since a prior knowledge is needed about which level to search or selectin. The
ancestors table is a different representation that solves this problem. This representation is also
called a bridge table.

The ancestors table contains one record for every child-ancestor relation found in the data. It
contains keys and names for the children as well as for the ancestors, that is, every record
describes which node a specific node belongs to. The hierarchybelongsto keyword can be used in
the load script to transform an adjacent nodes table to an ancestors table.

Semantic links

Normally selections are made explicitly by clicking on the field values that are interesting. There is,
however, also a way to make selections indirectly through semantic links. These are similar to field
values, but with the difference that they describe the relations between the objects rather than the
objects themselves. They appear as a list of buttons.

When clicking on a semantic link, a selection is made in an other field.

Rules for semantic tables

Semantic tables are not displayed in the table viewer.

Semantic links are created by loading tables containing the relations between the objects.
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» The table must contain exactly three or four columns.

* A semantic table must either contain relations between field values of different fields or
between field values of the same field. A mixture between the two is not accepted.

e The LOAD or SELECT statement loading a semantic table must be preceded by a semantic
qualifier to show that it is not a logical table.

Normally four columns are used, the first one containing the field values that have a relation to
some other field value and the third one containing the related field value. The second column must
contain the names of the relations, and finally, the fourth one must contain the names of the inverse
relations.

If three columns are used, no explicit names for the inverse relations can be given. The names given
in the second column are used both for the relation and the inverse relation. The names are then
preceded or followed by arrows.

If the relations are between field values of the same field, the first and third columns must have the
same name. Also the names of the second and fourth column, that is, the type of the relations, must
be the same. However, if the relations are between field values of different fields, all columns must
have different names.

Extracting a semantic table from data

The semantic table does not always have to exist as a table outside QlikView. It is more flexible to
extract this table from the existing table of objects through a separate LOAD statement.

In the presidents example in the QlikView examples directory, the script to generate the links
Predecessorand Successor could be:

Directory presidents;

LOAD * from presdnts.csv (ansi, txt, delimiter

is ',', embedded labels);

Semantic LOAD

No -1 as No,

'Successor' as Relation,

No,

'Predecessor' as Relation

from presdnts.csv (ansi, txt, delimiter is ',',

embedded Tabels) where No > 1;

The second LOAD statement results in a table that looks like the one to the right, and this table is
loaded as a semantic table. The where clause is used to omit the first record since this would link

the first president to the nonexistent O:th president.

Note also that this LOAD statement contains two fields labeled No and two fields labeled Relation.
Such a LOAD statement would cause a script execution error if used to load an internal table since
the load procedure for one single internal table demands that none of the fields have the same
name. The corresponding SELECT statement is also not possible, since most ODBC drivers also
demand this. Instead, the following structure should be used if the presidents table is in a database:

Connect to DataBase;

SELECT * from presdnts;

Alias No2 as No, Relation2 as Relation;
Semantic SELECT

No -1 as No,
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'Successor' as Relation,

No as No2,

'Predecessor' as Relation2
from presdnts where No > 1;

The presidents example is just one simple example of how to use semantic links. These can also be
used in genealogy, where the semantic links can be e.g. cousin, sibling, grandmother, etc. or for
people in companies where the semantic links can be e.g. superior, reports to, secretary, etc.

Using the related values as relation names

Sometimes it is more descriptive to use the related field value as name of the relation. In the case of
the presidents, you may want all the predecessors in one column and all the successors in another:

To create these links, the following script is needed:

LOAD
No as DuplicateOfNo,
FirstName & ' ' & LastName as Name,

%

from presdnts.csv;
Semantic LOAD

No -1 as No,

FirstName & ' ' & LastName as Successor,
No as DuplicateOfNo,
'Dummy1’

from presdnts.csv where No > 1;
Semantic LOAD
No +1 as No,

FirstName &' ' & LastName as Predecessor,
No as DuplicateofNo,
'Dummy2"'

from presdnts.csv;
When a semantic link is clicked, a selection is made in the field of the third column, DuplicateOfNo,
which in the semantic table is always the number of the president shown on the semantic link.

It may not be obvious at first, but the inverse relations in the above construction are almost useless.
They would show a name of a president and, when clicked, select the predecessor/successor of
the shown president. This is why they are called Dummy1and DummyZ2 and only the first relation
(column two) is used.

Since we do not want the dummy relations to appear in the list boxes, we must treat the second and
fourth columns as different types of relations. This means that the first and third columns must have
different field names. This is the reason why we have two columns containing the number of the
president, No and Duplicate OfNo.

Two different semantic statements are needed since we want two different list boxes with
relations.

This example can also be made with three-column semantic tables, but then the list boxes with the
inverse relations will most likely confuse the user.
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Linking information to field values

Information in the form of text files, images or external application files can be associated to data in
a QlikView document. To use this feature, tables have to be created that describe what information
file is to be linked to which field value, and tell QlikView to treat these tables as information tables.
How this is done is explained below.

Information tables must consist of two columns, the first one headed by a field name and containing
a list of values belonging to the field, the second one headed by an arbitrary name and containing
the information (if text) or references to the files containing the information (images, applications).

The statement for loading this table as an information table would be as follows:

Info LOAD Country, I from Flagsoecd.csv (ansi, txt, delimiter is ',', embedded labels);
When a list box or multi box item linked to information is selected, an information icon appears
beside the field name to show that information is available. Clicking the icon will show the
information or load the application file. It is possible to turn off the information icon on the Layout
page of the List Box Properties dialog.

If a text is entered in the second column, the text is shown in an internal text viewer.

To mark a new line in this text, the carriage return cannot be used. Instead, the symbol "\n" is used
in the info file.

 If aname of an image file (for example, extension bmp) is entered in the second column, the
image is shown in an internal image viewer.

« |f aname of a sound file (extension wav) is entered in the second column, the sound is
played.
» |f aname of an executable file is entered in the second column, the file is executed.

 If aname of any other file is entered in the second column, the associated program is used to
open the file.

» If aURL is entered in the second column, for example, an Internet address, the registered
Internet browser is used to access the address.

An info file cannot contain the star symbol. A symbol defined as OtherSymbol however, is allowed.

Using bundle info load, it is possible to bundle external data into a QlikView document.

Data cleansing

When loading data from different tables, note that field values denoting the same thing are not
always consistently named. Since this lack of consistency is hot only annoying, but also hinders
associations, the problem needs to be solved. This can be done in an elegant way by creating a
mapping table for the comparison of field values.

Mapping tables

Tables loaded via mapping load or mapping select are treated differently from other tables. They
will be stored in a separate area of the memory and used only as mapping tables during script
execution. After the script execution they will be automatically dropped.
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Rules:

» A mapping table must have two columns, the first one containing the comparison values and
the second the desired mapping values.

* The two columns must be named, but the names have no relevance in themselves. The
column names have no connection to field names in regular internal tables.

Using a mapping table

When loading several tables listing countries, you may find that one and the same country has
several different names. In this example, the U.S.A. are listed as US, U.S., and United States.

To avoid the occurrence of three different records denoting the United States in the concatenated
table, create a table similar to that shown and load it as a mapping table.

The entire script should have the following appearance:

countryMap:

Mapping LOAD x,y from MappingTable.txt
(ansi, txt, delimiter is ',', embedded
Tabels);

Map Country using CountryMap;
LOAD Country,City from CountryA.txt

(ansi, txt, delimiter is ',', embedded Tlabels);
LOAD Country, City from CountryB.txt
(ansi, txt, delimiter is ',', embedded labels);

The mapping statement loads the file MappingTable.txt as a mapping table with the label
CountryMap.

The map statement enables mapping of the field Country using the previously loaded mapping
table CountryMap.

The LOAD statements load the tables CountryA and CountryB. These tables, which will be
concatenated due to the fact that they have the same set of fields, include the field Country, whose
field values will be compared with those of the first column of the mapping table. The field values
US, U.S., and United States will be found and replaced by the values of the second column of the
mapping table, i.e. USA.

The automatic mapping is done last in the chain of events that leads up to the field being stored in
the QlikView table. For a typical LOAD or SELECT statement the order of events is roughly as
follows:

Evaluation of expressions

Renaming of fields by as

Renaming of fields by alias

Qualification of table name, if applicable

a b W N =2

Mapping of data if field name matches

This means that the mapping is not done every time a field name is encountered as part of an
expression but rather when the value is stored under the field name in the QlikView table.

To disable mapping, use the unmap statement.
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For mapping on expression level, use the applymap function.

For mapping on substring level, use the mapsubstring function.

6.18 VBScript Function Calls from Script

VBScript or JScript functions defined in the macro module of a QlikView document can be called
from the script. If a function called is not recognized as a standard script function, a check will be
made to see if a custom functions resides in the module. This gives you a large degree of freedom
to define your own functions. Using custom macro functions will of course be somewhat slower
than executing the standard functions.

rem *?*
rem THIS IS VBSCRIPT CODE FROM THE MODULE

rem*? Fedededede el fdde el dehdefdde Nl fddddt 3 Feded
rem ¥x#kwixwik Global variables **

dim flag

rem **¥****fynctions accessible from script
rem kdkddddeddeddek wrap for 1nput box ke dededed
function vBin(prompt)

VBin=inputbox(prompt)

end function

rem Feddedehddhdhdhd C]ear g]oba1 f]ag Fededededededed Tedkdehdhd
function vBclearFlag(Q)

flag=0

end function

rem *****kuwk tast if reference has passed ##*wkkddiis
function VBrelpPos(Ref, Current)

if Ref=Current then

VBRelPos="Reference"

flag=1

elseif flag=0 then

VBRe1Pos="Before "&Ref&" in table"

else

VBRelPos="After "&Ref&" in table"

end if

end function

// Fedededededdefdde SNl de el dde Nl dddefddehde Nl dehddddeddhdefddddtk

***THIS IS THE SCRIPT

FTededede ke fdedehdefddhd

Tet MaxPop=VBin('Max population in millions :');
// Ask T1imit

Tet RefCountry=VBin('Reference country :');
// Ask ref.

Tet dummy=VBclearFlag(); // Clears the global flag

Load

Country,recno(),

Capital,

"AreaCkm.sq)",

"Population(mio)",
VBrelpPos('$(RefCountry)',Country)
as RelativePos
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from countryl.csv
(ansi, txt, delimiter is ',', embedded labels)
where "Population(mio)" <= $(MaxPop);

Transfer of Parameters

The following rules apply for parameter transfer of parameters between the load script and
VBScript:

e Missing parameters are passed as NULL.

« If the actual expression evaluates to a valid number, the number is passed, else if the actual
expression evaluates to a valid string, the string is passed, else NULL is passed.

 NULL is passed as VT_EMPTY.
* Return values are treated in a natural way.

6.19 Application Performance Optimization

Introduction

With small or medium sized QlikView applications you generally don’t have to worry too much about
the design of the application in terms of performance. As the amount of data grows, both time and
memory constraints may become very evident if the application is poorly designed. It is possible
that some simple design alterations improve performance substantially. This appendix points out a
few common pit falls and suggests remedies for them.

In general performance is improved by moving the “problem” from application objects to the script
driven database. This is often a trade off situation. Response time is enhanced and ad hoc
capability is diminished. The recommendations below should not be seen as universally beneficial.
Use them when they improve the general state of the application or when they make that little bit of
difference that makes or breaks.

The following is a list of examples of applied methods for the handling of the problems above. They
are meant to illustrate the problem and point at useful QlikView functionality. It is not possible to
give a general recommendation as to which method is the best, but the order of the examples is an
indication.

If ( Condition(Text),....)

If clauses involving text comparisons is generally expensive. Solutions can be to map text to
numbers, for example by using autonumber (see examples in the previous section) and/or do the
testin the script.

The testing of text strings is slower than numeric testing. Consider the expression:

If (Alfa= ‘ABC’, ‘ABC’, left (Alfa, 2))
The test could be done directly in the script without losing any flexibility.

Load

If (Alfa = ‘ABC’, 1, 0) as Flag
resident table_1;
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The expression becomes:

if ( Flag = 1,’ABC’, left (Alfa, 2))
and the test is much simpler.

Sum ( If (Condition, ‘FieldName'...))

Here the aggregation is independent of the table dimensions and the result is distributed over the
dimensions of the table. The problem can be treated either by doing the test in the script and
aggregating in the table or by doing the whole operation in the script. There are numerous
techniques for this, such as interval match, group by, peek, if....then....else.

This case involves two steps namely the testing of “Condition” and the aggregation of the result. If
we take the previous example and add the aggregation

Sum (If (Alfa= ‘ABC’, Num*1.25, Num) )

Load
If (Alfa = ‘ABC’, 1, 0) as Flag
resident table_1 ;

The expression becomes

sum ( If ( Flag = 1, Num* 1.25 , Num ) )
The aggregation can also be done directly in the script as follows:

table_2:

Load

If (Alfa = ‘ABC’, 1, 0) as Flag

resident table_1 ;

table_3:

Load

Alfa,

If ( Flag = 1, Num* 1.25 , Num ) as NewNum
resident table_2 ;

table_4:

Load

Alfa,

sum( NewNum ) as SumNum
resident table_3

group by Alfa ;

The aggregation is done over Alfa as this is the dimension in the test.

If ( Condition, Sum(‘FieldName’)..)

This construction is included here only to emphasize the difference to the previous case. This
aggregation is completely contextual and generally speaking does not cause performance
problems.
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If ( Condition1, Sum(‘FieldName’), If (Condition2, Sum
(‘FieldName’)........

The logic of nested If...then else... is conceptually easy but can often become troublesome to
administer. We have seen cases with hundreds of nesting levels. This is both memory as well as
CPU intensive. The “Conditions” can often be replaced by transforming them. A typical example is
aggregating quantity*price where price is variable. This can be handled by “extended interval
match”. If two conditions, e.g. “A AND B’ are to be satisfied the test might be replaced by a
condition “C".

Example:

sum((GAC12_STD_COST * GACL5_EXCHANGE_RATE) * GIV24_DISP_QTY)
Replaces

sum(

If((GAC12_EFCT_DT<= GIV23_REJ_DT and
GAC12_EXPIRE_DT>GIV23_REJ_DT) and

(GAC15_EFCT_DT<= GIV23_REJ_DT and GACl5_EXPIRE_DT>GIV23_REJ_DT),
GAC12_STD_COST * GACL5_EXCHANGE_RATE) * GIV24_DISP_QTY,
NulTQ))

and

sum(

If(GAC12_EFCT_DT<= GIV23_REJ_DT,
If(GAC12_EXPIRE_DT>GIV23_REJ_DT,

If(GAC15_EFCT_DT<= GIV23_REJ_DT,
If(GAC15_EXPIRE_DT>GIV23_REJ_DT,

(GAC12_STD_COST * GACL5_EXCHANGE_RATE) * GIV24_DISP_QTY,
Nul1()))))

by reading the fields GAC12_STD_COST and GAC15_EXCHANGE_RATE as slowly changing
dimensions.

Using the extended intervalmatch syntax to resolve slowly changing dimension problems (page
208)

Sorting Text

QlikView automatically evaluates if a Field is to be treated as numeric, text or general. Fields
evaluated as text will be sorted as text which is the slowest sort operation. This can be replaced
manually to sort by load order. If sorting of list boxes etc is not needed, turn it off.

QlikView sorts strings of mixed characters and numbers in alphanumeric order. That is, numbers are
sorted in value order while non-numbers are sorted in ASCIl order, as opposed to tradtional ASCII-
only sort order. Example:

Sorting text example

ASCII sort Alphanumeric sort
A1 A1
A10 A4
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ASCII sort Alphanumeric sort
AN A5

A30 A6

A4 A10

A5 A

A6 A30

Dynamic Captions and Text Objects

Dynamically calculated expressions can be entered almost anywhere where you can enter text. The
resources required for evaluation of an expression is however dependent on its environment.
Expressions in charts and tables that are defined in the expressions dialog are only calculated when
the object is visible and data changes. They are e.g. not calculated when the object is minimized.

On the other hand, if the object title is calculated this calculation is performed every time any
change occurs. There are also numerous ways of defining show conditions, calculation conditions
etc. These tests will also be performed at all times.

Some expressions are more expensive than others and become even more expensive the more
frequently they have to be evaluated. The introduction of asynchronous calculation has shifted the
behavior and maybe these effects have become more noticeable in your applications.

The time functions e.g. Now() and Today() will be evaluated whenever a recalculation is required.
Especially the Now() function can become quite costly since it causes a recalculation of the
application every second.

For example:

If ( ReloadTime()+3>Now(), 'Old Data', 'New Data')
Here one might consider

If ( ReloadTime()+3>Today(), 'oOld Data', 'New Data')
As a simple test, put the expressions into text boxes. Then try sizing the text box with Now() in it.

Macro Triggers (“on change”)

Macros can be set to be triggered by almost any event taking place in the application. Beware of
cascading or recursive events where one event triggers the next which in turn.

6.20 Data Protection Issues

Most of the discussion below assumes that there is an existing database management system
(DBMS) and that QlikView is used as an output tool. The arguments, however, still hold true when
the raw data are in the form of text files.
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Data Security and Integrity

Data protection usually means several different things. It can mean protecting entered data from
being altered or destroyed by mistake, making sure that data is entered in a correct way or
preventing the data from being shared by unauthorized people.

The terms integrity and security are often used in this context and although the two concepts seem
similar at a first glance, they are in fact quite different. Security refers to the protection of data
against unauthorized access, whereas integrity refers to the validity of data, i.e.:

» Security involves assuring that the users are allowed to do what they are trying to do.
 Integrity involves assuring that what the users are trying to do is correct.

We will mostly discuss data security, since the tools for data integrity are provided by the DBMS.

The Right to Alter Data

The first step in security is to make sure that users cannot erase or change data inadvertently. For
multi-user systems this implies using an operating system and a database management system
with adequate protection. Examples of such operating systems for PCs are Windows NT or Novell.
Examples of such database management systems are ORACLE, SQL Server or Informix.

If data are not protected by the operating system, it will always be possible to delete data by
mistake. This is true even if the file is password protected.

The next step is to set up privileges for the authorized users. In a correctly set up system it should
be impossible to do anything with the data unless the correct tools are used, i.e. tools that can
check whether you are authorized to do what you are trying to do.

For the single user most of the security problems do not exist. It is thus often sufficient to make
regular back-ups of the data files.

The Right to View Data

The final issue in data security concerns the security when handling confidential information. If the
security issues above concern the right to alter data, this point rather concerns the right to view
data. Most database management systems have means to prevent people from looking at data
residing in the database. They cannot, however, prevent people from looking at a copy of the data
found in a QlikView file. For this purpose, QlikView has its own means of preventing unauthorized
people from viewing data. One must, however, be aware of the fact that the QlikView access
restriction tool only concerns the right to see data. QlikView can never prevent users from
destroying data with other tools. Only the operating system can.

Data Integrity

Data integrity implies a structured data flow. Data entry procedures must be set up to make sure
that data are entered in a uniform way. A good way to do this is to design forms with the DBMS.
Forms also prevent users from entering non valid values, e.g. nonexistent customer numbers, into a
database.
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When working with single-user databases, one must also be careful not to have more than one
person using the database at a time. Multi-user databases can, as the name implies, handle several
people editing the database simultaneously.

Another aspect related to this issue is the following: One must always know if a file or a database is
the original or a copy. If this is not the case, someone will most certainly start entering datainto a
copy of the database.
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7/ Creating documents and charts

A QlikView document consists of a number of sheets that contain graphical charts and other sheet
objects that allow the user to interact and analyze the data. QlikView enables you to design and
create your own clear, interactive charts and other sheet objects, and position them on the sheets
in the document.

When creating a document you can use a palette of tables and chart types such as bar charts, pie
charts and gauges. The tables and charts are simple to add and customize. Interactivity such as
drill-down and filtering is built in because QlikView automatically highlights items associated with
your selections. You can enhance interactivity further with functionality specific to the different
charts.

While adding tables and charts on sheets, consider some rules of thumb:

« Using color, names, and styles consistently helps the user to navigate and understand the
document.

» Keep the sheet tidy and let the tables and charts play center stage.
» Focus on a few metrics (KPIs) per sheet and present these in priority order.

» Make sure that the user can drill-down in data. For example, create dimensions for time and
date to make it easy to drill down in year, month, week and day.

» Avoid using red and green colors as indicators because these colors can be hard for users
with color-vision deficiency to distinguish.

You can get a lot of good inspiration by checking out the demos.

7.1 Learn more

QlikView Demos

Tutorials

7.2 Document Properties

Here the document specific parameters, such as opening picture and sound, default font, sort order
etc. can be specified for this specific document.

Document Properties: General

General document properties

Property Description

Title Here the title that is to be displayed in the window caption can be entered. As
default the document file name is used. To alter it, enter the selection in the
Title edit box.
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Property
Author

Save Format

Alert Pop-ups

Help Pop-ups

Alternate
States...

Memory
Statistics

Description
In the Author edit box specify the author of the QlikView file.

In this group set the level of compression for the QlikView fil